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Chapter 1. Introducing Workshare Professional
This chapter introduces Workshare Professional, providing an overview of how it works as well as a summary of 
the key features and benefits. It includes the following sections:

 What is Workshare Professional?, below, introduces Workshare Professional.

 Workshare Professional Functionality, page 11, describes the different areas of functionality of 
Workshare Professional including review, compare and protect.

 Terms and Concepts, page 17, introduces the common terms and concepts used in Workshare 
Professional and in this guide.

What is Workshare Professional?
Workshare Professional is a desktop application that automates managing changes to business documents, 
protects against unauthorized content disclosure and delivers the world’s most secure PDF creation, all in one 
integrated solution.

Workshare Professional is designed for the way that you work – within Microsoft Office. Workshare Professional 
integrates with your existing desktop productivity software Microsoft Word, Excel and PowerPoint and your 
email applications such as Microsoft Outlook or IBM Lotus Notes. In addition, many companies use Document 
Management Systems (DMSs) and/or Microsoft SharePoint to track and store key documents and Workshare 
Professional integrates out of the box with these.

Key features of Workshare Professional include:

 Advanced comparison features, including multiple version and category views, available from inside 
Office applications

 Advanced, interactive, in-Outlook metadata cleaning/PDF creation/secure link transformation

 Secure File Transfer from all devices and browsers with metadata removal and end-to-end encryption

 Centralized policy design and enforcement administrator tools

 Advanced document revision and review tools for Windows

 Integrated ECM/DMS and OCR integration with desktop comparison features

 Centralized user account management and control

 Owner-defined folder access and permission setting

 Positional commenting and reviewer communications with presence indicators

 Desktop Sync Apps for Windows and Mac OS

 Mobile apps for iPhones, iPads, and Android Tablets

Note: Workshare Professional can be installed without Microsoft Office integration. In this case, the 
comparison functionality is only available from the Workshare Compare application and the metadata removal 
functionality is only available when sending emails.
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Workshare Professional Functionality
Workshare Professional provides sophisticated functionality that is convenient and accessible, enabling users to 
move smoothly between tasks and work rapidly to manage changes. Workshare Professional assists you 
throughout the complete document lifecycle – from document assembly, review, verification and security. 
Workshare Professional displays a simple and intuitive panel within Microsoft Word, Excel and PowerPoint 
enabling users to take advantage of available Workshare Professional functionality from within the application.

The Workshare Panel is task-oriented, guiding users through their document tasks in a clear, step-by-step 
format. Users may select Workshare Professional functions in any order, or simply use a single function.

Workshare Professional has also made key functionality of the DMS available from the Microsoft Word 
environment. For example, Workshare Professional provides a list of the DMS versions of a document, enabling 
the comparison of document versions.
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Workshare Professional includes the following areas of functionality:

Review

The Review functionality in Workshare Professional enables you to manage changes to business documents 
rapidly and easily. It reduces frustration and delays by finding and incorporating changes in important 
documents. Workshare Professional is for anyone who works with business documents.

Workshare Professional automatically finds changes proposed to a document by other people, preventing the 
need to ‘cut-and-paste’ or manually re-type suggestions into the document. 

Workshare Professional enables you to easily send a document to several people. When a document is sent 
using Workshare Professional, it is ‘tagged’ so that when colleagues return a changed document to you via 
email, Workshare Professional recognizes the revised document as a revision to your original. Whenever any 
attachments that contain suggested changes to your documents are opened from your email application, 
Workshare Professional automatically analyzes the documents for suggested changes. Workshare Professional 
identifies all changes made to the document, regardless of whether the reviewer used track changes or not.

Workshare Professional then provides an intuitive and simple way to review, understand, and incorporate 
changes to a Microsoft Word document. Multiple suggestions from several people are presented in a concise 
consolidated view within Microsoft Word. This consolidated view enables you to act upon each change - to 
apply, reject, or flag for follow-up.

In addition, Workshare Professional preserves the technical integrity and style of the document – preventing 
your document from becoming corrupt or inadvertently incorporating foreign formatting or style. This not only 
benefits you through higher document quality, but also through increased productivity as well as reducing stress 
at deadlines.

Workshare Professional can also utilize the advantages of Microsoft SharePoint so that when sending a 
document for review you can also post it to a SharePoint site. Colleagues can review the document from 
SharePoint and any proposed changes are identified by Workshare Professional when the original document is 
opened.

PDF to DOC Format

The Review functionality in Workshare Professional enables you to quickly and easily convert PDF files into 
Microsoft Word files (PDF to DOC format). This functionality is available from within Microsoft Word and by 
right-clicking closed PDF files on your desktop or DMS. 

PDF Combine

The Review functionality in Workshare Professional also enables you to combine multiple files into a single PDF. 
This is useful, for example, at the close of a project when you want to combine many documents into a single 
file, or when creating a report that involves information in different formats such as documents, spreadsheets 
and graphics.
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Compare

The Compare functionality in Workshare Professional utilizes Workshare Compare to enable you to compare 
documents and instantly see any differences between them. You can compare both Microsoft Word (DOC/DOCX) 
files and PDF files. Within a Microsoft Word file, you can compare all content including images, tables and 
embedded Microsoft Excel tables. You can compare a document against another single document or against 
multiple documents. For users who have a DMS or work with NetDocuments or SharePoint, Workshare Compare
provides access to version information stored in the DMS, NetDocuments or SharePoint. Understanding 
differences between one version of a document and the next is a critical function when editing and reviewing 
documents in multi-user environments. Workshare Compare utilizes Workshare DeltaView - the market-leading 
and most advanced comparison engine in the market today, to perform comparisons accurately and seamlessly. 
Comparison results are displayed within Microsoft Word or in a separate Workshare Compare window.

Workshare Compare’s fast, accurate and reliable document comparison capabilities enable you to quickly 
compare even the most difficult and complex documents.

Alert and Compare is the ability of Workshare Compare to automatically detect that a received attachment is a 
changed version of an original document sent previously. When a user sends a document to a recipient and the 
recipient edits the document and sends it back to the user, Workshare Compare can automatically detect that 
the received attachment is a changed version of the original document. The user can then launch a comparison 
of the two documents from Microsoft Outlook and view the Redline document in Workshare Compare. 

Protect

The Protect functionality in Workshare Professional utilizes Workshare Protect to provide comprehensive content 
risk protection enabling the discovery and removal of hidden sensitive data as well visible sensitive data. Content 
risk is defined in security policies. Hidden sensitive data may include information such as track changes, author’s 
name, server names, keywords, routing slips and authoring trails.

Workshare Protect enables the discovery of content risk in the following ways:

 Content Risk Reports: Workshare Protect integrates with Microsoft Office providing an option to 
display a comprehensive report of all the content risk in a document while it is open in Microsoft Word, 
Excel and PowerPoint. Content risk is displayed according to its risk level (high, medium, low).

 Email Protection: Workshare Protect prevents users from accidentally emailing confidential information 
by alerting users before the email is sent when an email or its attachment breaches security policies. 
Depending on the actions defined for policy breaches, emails may be blocked or sensitive data 
removed. Security policies can specify different actions when a document is sent internally or 
externally. For example, it may not be acceptable for hidden server names and users details to be 
included in documents sent externally, but it may be fine to leave those details in documents sent 
within an organization.

Workshare Protect comes with a pre-defined default security profile (collection of policies).

Interactive Protect

Interactive Protect offers you options to control your documents and secure attachments before sending your 
email. It simplifies metadata cleaning, avoids email pop-ups, and eliminates MS Outlook add-in issues.

Workshare Protect scans documents as soon as they are added as attachments to an email. Users are made 
aware of the risk involved and given the option to make informed decisions to decide what metadata to remove. 
BEFORE clicking Send. Users can then preview processed documents before they are sent.
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Using the Interactive Protect panel displayed on the right of the message window, users can clean metadata 
from attachments, convert attachments to PDF or PDF/A, and compress attachments into one zip file.
Additionally, users can securely transfer attachments to a secure location in Workshare Online and send 
recipients a link to that location.

Interactive Protect is implemented by selecting Interactive Protect for the After an email with attachments is 
sent show parameter in the Workshare Configuration Manager (Protection > Administration category).).

Secure File Transfer

The Secure File Transfer functionality provides the ability to upload attachments to Workshare Online and send 
recipients a link to the documents in Workshare. This means that valuable email storage isn’t taken up with 
multiple versions of large attachments. Additionally, attachments are stored in a single place which enables 
efficient and trouble-free collaboration. Workshare can also clean attachments before uploading them to 
Workshare Online.

Secure File Transfer is initiated from within the familiar environment of Microsoft Outlook. The feature is 
implemented through the use of two additional profiles – Secure File Transfer and Clean & Secure File 
Transfer that are available in the Protect Profile dialog. The various configuration options relating to this 
functionality are found in a new sub-category – Protection> Secure File Transfer in the Workshare 
Configuration Manager and the functionality is enabled/disabled using the Show Secure File Transfer profiles 
in Protect Profile dialog parameter (Protection>Administration category).

Manual Redaction

Workshare Protect provides the functionality to redact/black out selected content in Microsoft Word (DOC and 
DOCX) documents. Redacting text is to black out the text so that it is no longer discernible.

PDF Conversion

Workshare Protect enables you to quickly and easily convert Microsoft Office documents into PDF or PDF/A files. 
This Workshare Protect functionality is available from within Microsoft Word, Excel and PowerPoint 
environments and by right-clicking closed Microsoft Word, Excel and PowerPoint files on your desktop or DMS.
Additionally you can combine multiple files into a single PDF – a useful tool at the close of a project or when 
creating a report that involves documents, spreadsheets and graphics.

Document Classification

Workshare Protect enables you to restrict access to sensitive business documents by classifying documents. 
This classification can prevent documents from being emailed either to any user, or to external users. Workshare 
Protect provides the following default classification levels:

 For Internal Use

 Confidential

 Highly Confidential

 External Restriction

 Full Restriction
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DMS/CRM Integration

Workshare Professional can integrate with your DMS or CRM as well as SharePoint to provide comparison and 
collaboration functionality.

SharePoint

Workshare Professional integrates fully with SharePoint so that users can select documents from SharePoint 
when comparing or sending for review. 

To integrate with SharePoint, Workshare Professional must be installed with the SharePoint integration selected 
and your SharePoint server details must be configured in the Workshare Configuration Manager. Refer to your 
system administrator for further information.

NetDocuments

Workshare Professional integrates with NetDocuments, a cloud-based document storage solution, to enable 
comparison of documents stored in NetDocuments.

You can browse in NetDocuments for documents or versions to compare as well as save comparisons (Redline 
documents) back into NetDocuments. Comparison of documents stored in NetDocuments is performed from 
Workshare Compare or from the Workshare Panel in Microsoft Word. You cannot initiate a comparison from 
NetDocuments.

To integrate with NetDocuments, Workshare Professional must be installed with the NetDocuments integration 
selected and you log in to your NetDocuments account through the Workshare Configuration Manager 
(Integrations > NetDocuments category). Refer to your system administrator for further information.

Autonomy iManage

Workshare Professional integrates fully with Autonomy iManage so that users can select documents from 
Autonomy iManage when comparing or sending for review. Additionally, the integration provides access to all 
the Workshare Professional functionality from Autonomy iManage using right-click options. So for example, 
users can compare, convert to PDF, combine into a single PDF as well as convert PDF files to DOC format.

To integrate with Autonomy iManage, Workshare Professional must be installed with the Autonomy iManage 
integration selected and your Autonomy iManage server details must be configured in the Workshare 
Configuration Manager. Refer to your system administrator for further information.

Open Text

Workshare Professional integrates fully with Open Text so that users can select documents from Open Text 
when comparing or sending for review. Additionally, the integration provides access to all the Workshare 
Professional functionality from Open Text using right-click options. So for example, users can compare, convert 
to PDF, combine into a single PDF as well as convert PDF files to DOC format.

To integrate with Open Text, Workshare Professional must be installed with the Open Text integration selected. 
Refer to your system administrator for further information.
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Worldox

Workshare Professional integrates fully with Worldox so that users can select documents from Worldox when 
comparing or sending for review. Additionally, the integration provides access to all the Workshare Professional 
functionality from Worldox using right-click options. So for example, users can compare, convert to PDF, 
combine into a single PDF as well as convert PDF files to DOC format. When comparing, users can browse in 
Worldox for documents or versions to compare as well as save comparisons (Redline documents) back into 
Worldox. Comparison of Worldox documents is performed from Workshare Compare, from the Workshare Panel 
in Microsoft Word or from within Worldox.

To integrate with Worldox, Workshare Professional must be installed with the Worldox integration selected. 
Refer to your system administrator for further information.

Terms and Concepts
The following terms and concepts are regularly used in Workshare Professional and throughout the 
documentation:

Term Definition

Document 
Management 
System (DMS)

A system that enables companies to centralize the management, storage, retrieval and 
distribution of documents. Furthermore, it enables a user to monitor and control 
modifications to a document while it is worked on by others.

Modified 
Document

The document that is compared against the original document. The modified document 
is usually a copy of the original document that has been altered, perhaps by another 
user.

Original 
Document

The document at the center of activity. This document can be compared against other 
documents or sent for review. The original document always stays in the DMS.

Redline 
Document

The document that results from a comparison of two documents, for example, the 
original document and an earlier version of the original document, or the original 
document and a response. The Redline document indicates the changes/differences 
between the two compared documents.

Rendering Set Rendering sets define how Workshare Compare represents changes in a document. For 
example, inserted text is shown in blue with double underline and deleted text is shown 
in red with strikethrough. These display preferences can be amended by the user.

Response A document that is returned after having been reviewed. This document includes 
proposed changes to the original document.
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Chapter 2. Getting Started
This chapter describes the Workshare Professional working environment and provides an overview of the tools 
available. It includes the following sections:

 Launching Workshare Professional, below, describes how to access Workshare Professional 
functionality.

 Workshare Panel, page 19, describes the Workshare Panel and the options available from it.

 Workshare Tab, page 21, describes the options available in the Workshare tab.

 Enabling Workshare Professional Functionality, page 23, describes how to ensure that Workshare 
Professional functionality is fully enabled.

Launching Workshare Professional
Workshare Professional can integrate with Microsoft Word, Excel, PowerPoint and Outlook. To this end, there is 
no independently accessed user interface for Workshare Professional - the user interface is accessed from 
within Microsoft Word, Excel, PowerPoint or Outlook and is available from all documents.

Notes:
If your Workshare Professional is not integrated with Microsoft Word, Excel, PowerPoint and Outlook, refer to 
your system administrator.

The comparison functionality of Workshare Compare is also available as a standalone application. Refer to 
Overview - Comparing Documents Using Workshare Compare for further information.

The Workshare Professional user interface adopts a task-oriented approach guiding you through each process 
one step at a time and providing clear explanations at each step. This provides a steady flow to your work with 
no need to move between interfaces or waste time deducing functionality.

After you have installed Workshare Professional, the Workshare tab is added to the Ribbon in your Microsoft 
Office applications - Word, Excel and PowerPoint. Click Toggle Panel in the Workshare tab and the Workshare 
Panel is displayed down the left side of the window.

The addition of Workshare Professional does not affect the standard functionality of Microsoft Word, Excel or 
PowerPoint. You can operate these applications as usual and access the Workshare Professional functionality as 
required.

Workshare Professional functionality can also be accessed in the following ways:

 Right-click closed Microsoft Word documents and select Compare with Workshare or Convert to PDF 
with Workshare or Combine files in Workshare or Send to/Workshare for Review or Send 
to/Workshare Batch Clean.

 Right-click closed Microsoft Excel or PowerPoint documents and select Convert to PDF with 
Workshare or Combine files in Workshare or Send to/Workshare Batch Clean.

 Right-click closed PDF documents and select Compare with Workshare or Combine files in 
Workshare or Open in Word with Workshare or Send to/Workshare Batch Clean. 
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 Click the Attachments dropdown in the Workshare tab in the email message window when you 
receive an email that contains an attachment to launch Workshare Compare.

The Workshare Compare standalone application can also be accessed in the following ways:

 Double-click the Workshare Compare icon on the desktop.

 From the Start menu, select Programs, Workshare, Workshare Compare.

Refer to Overview - Comparing Documents Using Workshare Compare for further information.

Note: Workshare Professional can be installed without Microsoft Office integration. In this case, the 
Workshare Panel and Workshare tab/menu are not available. The Workshare comparison functionality is only 
available from the Workshare Compare application and the Workshare metadata removal functionality is only 
available when sending emails.

Start Menu

After you have installed Workshare Professional, the following elements are added to the Start menu under 
Workshare:

 Workshare Batch Clean

 Workshare Compare

 Workshare Configuration

 Workshare Configuration Assistant

 Help

Batch Clean

Workshare Batch Clean is a tool that cleans hidden data, such as versions, templates, comments, hidden text, 
reviewer and author information, from multiple Microsoft Office documents at the same time. Refer to Batch 
Cleaning, for further information.

Workshare Panel
The Workshare Panel, displayed by default down the left side of the Microsoft Word, Excel and PowerPoint 
windows, provides access to Workshare Professional functionality and is your guide, prompting you through 
each step of any given process.

The content of the Workshare Panel varies according to the application and the functionality selected.

You can display/hide the Workshare Panel by clicking Toggle Panel in the Workshare tab, Options group.
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Microsoft Word

In Microsoft Word, the Home page of the Workshare Panel, shown below, provides quick access to the 
functionality of Workshare Professional, as follows:

Send: Enables you to send a draft of the document by email to other people enabling 
them to make comments and changes to the draft. Refer to Sending Documents for 
Review for further information.

Manage Changes: Enables you to import responses and review the changes that have 
been proposed to a document, accepting or rejecting them as required. Refer to 
Overview - Managing Responses for further information.

Compare: Enables you to compare a document with a previous version of the same 
document or with another document. Refer to Overview – Comparing Documents from 
Within Microsoft Word and Overview - Comparing Documents Using Workshare 
Compare for further information.

Content Risk: Enables you to display a report of all the content risk in a document as 
well as remove selected hidden data from the document. Refer to Displaying Content 
Risk in Microsoft Word for further information.

Convert to PDF: Enables you to convert documents to PDF or PDF/A. Refer to 
Overview – Converting to PDF for further information.

Classify: Enables you to classify your documents, which can restrict whether or not 
they can be emailed. Refer to Document Classification for further information.

Tip! The Workshare Panel can float over other windows. Click and drag the title bar 
of the Panel to move it to a different location.

Note: All of these options are configurable. You can configure whether each 
individual option is available from the General > User Interface category in the 
Workshare Configuration Manager. Refer to Workshare Configuration Options for 
further information.

There is a Help button displayed at the top of every page in the Workshare Panel that provides access to 
online help as well as a close button that enables you to close/hide the Workshare Panel. Additionally, at the top 
of all pages of the Workshare Panel except the Home page, the following links are displayed:

Return to the Home page of the Workshare Panel.

Return to the previously displayed page of the Workshare Panel.
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Microsoft Excel and PowerPoint

In Microsoft Excel and PowerPoint, the Workshare Panel, shown below, provides quick access to the 
functionality of Workshare Professional, as follows:

Content Risk: Enables you to display a report of all the content risk in a document. Refer 
to Displaying Content Risk in Microsoft Excel and PowerPoint for further information.

Convert to PDF: Enables you to convert documents to PDF or PDF/A. Refer to Overview –
Converting to PDF for further information.

Classify: Enables you to classify your documents, which can restrict whether or not they 
can be emailed. Refer to Document Classification for further information.

Workshare Tab
Microsoft Word

Microsoft PowerPoint and Excel

Many of these options are configurable from the General > User Interface category in the Workshare 
Configuration Manager. Refer to Workshare Configuration Options for further information.
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The Workshare tab includes the following options:

Group Item Description

Review Send Enables you to send a draft of the document by email to other people enabling 
them to make comments and changes to the draft. Refer to Sending 
Documents for Review for further information.

Manage 
Changes

Enables you to import responses and review the changes that have been 
proposed to a document, accepting or rejecting them as required. Refer to 
Overview - Managing Responses for further information.

Combine 
PDF

Enables you to combine multiple files into a single PDF file. Refer to PDF 
Combine for further information.

Compare Compare Enables you to compare a document with a previous version of the same 
document or with another document. Refer to Overview – Comparing 
Documents from Within Microsoft Word and Overview - Comparing 
Documents Using Workshare Compare for further information.

Protect Content Risk Enables you to display a report of all the content risk in a document as well as 
remove selected hidden data from the document. Refer to Displaying Content 
Risk in Microsoft Word for further information.

Convert to 
PDF

Enables you to convert documents to PDF as well as convert a document to 
PDF and then add the PDF as an attachment to an email. Refer to Overview –
Converting to PDF for further information.

Redact Enables you to redact/black out select text. Refer to Manual Redaction for 
further information.

Classify Enables you to classify your documents, which can restrict whether or not 
they can be emailed. Refer to Document Classification for further information.

Reporting Reports Enables you to produce several different types of report. For example, a 
Document Audit Report, which includes information about the review cycle of 
the document or a Risk Report, which provides a full account of the different 
types of content risk in a document. Refer to Overview – Creating Reports for 
further information.

Options Options Enables you to configure system parameters in the Workshare Configuration 
Manager. Refer to Introducing the Workshare Configuration Manager for 
further information.

Toggle Panel Displays/hides the Workshare Panel down the left side of the Microsoft Word 
window. The Workshare Panel is displayed with its Home page open. Refer to 
Workshare Panel.

Info Help Provides access to version, copyright and license information about 
Workshare Professional.
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When working on a Review Copy – a document that has been sent to you for review, the Review group includes 
the following options:

Group Item Description

Review Return Enables a reviewer to return a document to you after adding their comments. 
This option is only enabled when a reviewer opens a document that has been 
sent to them for review. Refer to Returning a Reviewed Document for further 
information.

Remove 
Sender

Enables a reviewer to remove the “Review Copy” status from the review 
document, in effect saving the document as a new document that it is no 
longer part of a Workshare Professional collaboration. Refer to Returning a 
Reviewed Document for further information.

Enabling Workshare Professional Functionality
To ensure Workshare Professional functionality is fully enabled, you should work with saved documents and on 
the latest version of a document.

Saved Documents

You must be working on a saved Microsoft Word document in order for the Workshare Professional functionality 
to be fully enabled. 

If you are working in Microsoft Office on an unsaved document, Workshare Professional functionality is not fully 
enabled. If you select Send, Manage Changes, Combine PDF, Compare or Classify, the following message is 
displayed:



GETTING STARTED

24

If you open a document directly from an email, it is only a temporary document that is saved in a temporary 
location. In this scenario, the Compare functionality is enabled but if you select Send, Manage Changes or 
Classify, the following message is displayed:

Latest Versions

When you are working on a document in your DMS that is not the latest version, only the create PDF and 
compare functionality are available. When you click Compare, you can compare the document with another 
version or with another document, as described in Chapter 6, Comparing Documents from within Microsoft Word
and Chapter 7, Comparing Documents using Workshare Compare.

When you click Send, Manage Changes, Content Risk or Classify, the following message is displayed:
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Chapter 3. Sending Documents for Review
This chapter describes how to send a Microsoft Word document to other people for review. It includes the 
following sections:

 Overview, below, introduces the “send for review” functionality of Workshare Professional.

 Sending Documents for Review, page 27, describes how to send documents for review, including 
how to compare documents before sending and how to send multiple documents.

Overview - Sending Documents for Review 
Workshare Professional enables multi-user input to a single document, facilitating both the formal review 
process as well as simple document exchange.

You can send any document to multiple recipients in order to receive their input to the document. The process is 
initiated from Microsoft Word so after working on your document, you simply send it out for review. The 
document is sent by email. Microsoft SharePoint users can also upload their document to SharePoint and direct 
reviewers to its location.

When a document is sent for review, Workshare Professional tags the document. When the reviewer returns the 
document, Workshare Professional identifies the tag and recognizes the document as a response to the 
document initially sent for review.

In addition, Workshare Professional provides the following useful functionality:

 You can compare the document before sending it (against an earlier version or against another 
document). You can then include the comparison when you send the document for review. 

 You can send additional documents, for example, appendices, with the original document. These 
documents will also be tagged by Workshare Professional.

Document Audit File

When sending documents for review using Workshare Professional, all data relating to the document (for 
example, responses to a document sent for review) are stored inside a document audit file. This file is created 
automatically. It has the same name as the original file and a .W3 extension. When your document is stored on 
your hard drive, the document audit file is stored at the same location as the original file. When your document is 
stored in a DMS, the document audit file is automatically added as a related file to the original document.

Documents Stored on your Computer

If you store your documents on your computer or on a network rather than a DMS, Workshare Professional 
enables you to re-use documents easily, either continuing to manage changes associated with a document or 
starting a document as a ‘clean slate,’ with no changes associated with it at all.
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When a document has been reviewed and therefore has an associated document audit file, performing a Save 
As causes Workshare Professional to display a message asking whether to save the document as a new version 
keeping the responses associated with it (in which case the document audit file is copied) or to save it as a new 
document without the responses (in which case the document audit file is not copied, and you have a ‘clean-
slate’ document).

Selecting Yes saves the document in the specified location with the specified name and the document audit file 
is also copied to the same location. The document audit file is given the same name as the saved file with a .W3
extension.

Selecting No saves the document but does not copy over the document audit file.

Tip! To assign the control of a document to somebody else, simply email them the document and its 
associated document audit file. This user will gain control over the document when the files are saved to their 
computer or network.
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Moving and Copying Files

Workshare Professional can help you keep track of changes, even if you move your document to a different 
location. If you manually copy or move a Microsoft Word document on your computer, when you next open that 
document, Workshare Professional checks to see if your document used to have changes to it, and if the 
document audit file has also been moved. If it has not, the following message is displayed:

Selecting Yes opens the document and copies the document audit file to the new location. Selecting No opens 
the document but does not copy over the document audit file.

Sending Documents for Review
After working on your document in Microsoft Word, you can send it to multiple recipients for them to review.

Note: You can also send an RTF document for review. In this situation, the RTF document is converted and
sent as a DOC/DOCX file so the recipient receives a document with a .doc/.docx extension. The original 
document is not converted and remains as an RTF document. You can later import responses into the RTF 
document.

When sending a document for review, you may want to include a comparison with a previous version of the 
document or with another document. This can help the recipient to see the changes that you have made to the 
document. Additionally, Workshare Professional enables you to send additional documents at the same time. 
These documents may be related to the original document, for example, appendices, or they might be unrelated.

To send a document for review:

1. Send a document for review in either of the following ways:

 When your document is open in Microsoft Word, click Send, (Review group) in the Workshare tab
or click Send in the Home page of the Workshare Panel.

 From Windows Explorer, right-click the document you want to send for review and select Send To
and then Workshare for Review.
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The Send Draft For Review page is displayed as follows:

Notes:
If you are working with an Autonomy iManage DMS, the Select Email Settings area is also displayed. 
Refer to Filing Emails in Autonomy iManage.

If you are working with SharePoint, the SharePoint area is also displayed and you can upload your 
document to SharePoint for review. Refer to Sending for Review Using SharePoint.

2. If you want to include a comparison with the document when sending it, in the Attach a Comparison 
area, select the document against which you want to compare the current document in one of the 
following ways:

 Select a version of the document from the dropdown list. If the document has previous versions, the 
dropdown list is a list of other versions of the document. Otherwise, the list is a list of previously 
sent out versions of the document. These “versions” are actually revisions, which are created when 
the document is sent for review if the document has changed since the last time it was sent.

 Click Browse and select a document from your DMS, SharePoint or locally.
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The Attach a Comparison area is displayed as follows:

3. Select the format in which you want to send the comparison from the following:

 Word Document: The comparison will be sent as a Microsoft Word file.

 PDF (.pdf): The comparison will be sent as a PDF file. 

 PDF/A (.pdf): The comparison will be sent as a PDF/A file. 

Tip! It is good practice to send a document for review in Microsoft Word format and to include a 
comparison as a PDF file. This way, the recipients clearly know which is the document to review and 
edit and which is the document for information purposes.

4. If you selected PDF in step 3, you can expand the PDF security configuration section to set PDF 
security options.

5. Select one or more of the security options as required:

 Prevent printing: Prevents recipients from printing the PDF document.

 Prevent editing of text: Prevents recipients with Adobe Distiller from editing the PDF document.

 Prevent the copying of text and/or graphics: Prevents recipients from copying graphics or text 
directly from the PDF document.

 Prevent comments being added: Prevents recipients with Adobe Distiller from adding comments 
to the PDF document.
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6. If you selected PDF or PDF/A in step 3, you can expand the Metadata cleaning section and click 
Cleaning options to specify what metadata to remove before converting it to PDF.

7. Select metadata elements as required. For a full description of all the metadata elements, refer to 
Cleaning Hidden Data, for further information.

8. Click OK.

9. If you selected PDF in step 3, you can expand the Password protection section to protect the PDF.
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10. If required, set a password to protect the PDF by entering the password twice in the relevant fields. 
When a password is specified, the recipient can only open the PDF after entering this password.

11. If required, select a rendering set from the dropdown list to determine how the comparison document is 
displayed. For example, deleted text could be shown in red with a strikethrough. For further information 
about rendering sets, refer to Appendix A: Configuring Rendering Sets.

12. If you want to send additional documents with the review documents, in the Attach Additional 
Documents area click Browse and select an additional document from your DMS, SharePoint or 
locally. The selected document is listed in the Attach Additional Documents area as follows:

Note: To delete a document so that it is not sent with the review document, click Remove to the right 
of the document in the Attach Additional Documents area.

13. Repeat step 12 to add further documents to the list of documents in the Attach Additional Documents
area. All the selected documents will be sent with the original document.

14. At the bottom of the Send Draft For Review page, click Create Email. An email is created and the 
selected actions performed. A progress dialog indicates the progress of the activity. For example, when 
additional documents have been selected, each one is displayed by name as Workshare Professional 
deals with them.

Note: If you have made changes to the document and not saved, the document is saved.
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An email message window is displayed with the original document (and any comparison or additional 
documents) as an attachment.

Notes:
It may take a few moments for the email message window to be displayed.

If you work with the From field in your email application, Workshare Professional uses the information 
from the From field as the sender information (for return to sender purposes). This is useful if you are 
sending a document on someone else’s behalf. The email might be from you but you can enter a 
different name in the From field as the sender. If you do not enter anything in the From field, 
Workshare Professional regards the sender of the email as the sender (for return to sender purposes).

If this window is not displayed, you may not have your email application set as the default mail 
program in Internet Explorer. Open the Control Panel > Default Program and select your email 
application as the default.

15. Enter the recipient(s) name and any other text you want to include and click Send. The document is 
sent to the specified recipients.

Notes:
The Home page of the Workshare Panel is redisplayed.

Depending on the configuration of Workshare Professional, an email protection dialog may be 
displayed before the document is sent. Refer to Overview – Protecting Email Attachments for further 
information.
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Sending for Review Using SharePoint

If you work with Microsoft SharePoint, you can send a document for review by uploading it to a SharePoint site. 
The email sent provides the recipient with a link to the site where they can find the document to review. The 
Send Draft For Review page of the Workshare Panel includes a SharePoint section as follows:
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To send for review using SharePoint:

1. In the Send Draft For Review page, select the Link to SharePoint checkbox. The Workshare SharePoint 
Browser dialog is displayed.

2. Browse to a SharePoint site and select a document library or a folder within a document library and 
click Select.

Note: The sites and document libraries available for selection are those that have been configured in 
the Workshare Configuration Manager (Integrations > Microsoft SharePoint category).

The selected document library is displayed in the Target Document Library field. (Click Change to 
change the selected document library.)

Tip! You can click the selected document library name to open it in SharePoint.
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3. If you want to specify user access and permissions to the selected document library, select Manage 
Users.

4. If you want to include the document as an attachment to the email sent to the recipient, select the 
Include attachment(s) in email checkbox.

5. Complete the Attach a Comparison and Attach Additional Documents sections as described in 
Sending Documents for Review.

6. Click Create Email. An email message window is displayed providing a link to the location of the 
document in SharePoint and (if specified) with the document as an attachment.

7. Enter the recipient(s) name and any other text you want to include and click Send. The email is sent to 
the specified recipients.

Note: To ensure SharePoint functions correctly with send for review functionality, make sure that Scripting of 
java applets is enabled in the Security settings in Internet Explorer.



SENDING DOCUMENTS FOR REVIEW

36

Filing Emails in Autonomy iManage

When working with an Autonomy iManage DMS, Workshare Professional can automatically file the email 
generated when sending a document for review in the appropriate Matter workspace. In order for this 
functionality to be available, you must have selected the following parameters in the Integrations > Autonomy 
iManage category of the Workshare Configuration Manager:

 Matter-centric email filing

 Auto-file email

 Show file email checkbox

The Workshare Configuration Manager parameters are described in Workshare Configuration Options.

To file emails: 

In the Select Email Settings area of the Send Draft For Review page, select the File Email on Send checkbox.

After clicking Create Email, an email is created and the BCC field in the email message window is populated 
with the email address of the email folder of the appropriate Matter workspace. Workshare determines the 
appropriate Matter workspace according to the Matter property of the document sent for review.

In order for this functionality to work correctly, ensure the following:

 Matter workspaces must have a Matter property.

 A document folder within a Matter workspace must have an email address specified.

 The document being sent for review must have a Matter property.
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Chapter 4. Receiving Files for Review
This chapter describes the options available when a document is received for review. It includes the following 
sections:

 Overview, below, introduces the review functionality of Workshare Professional.

 Receiving Review Documents, page 38, describes the options available when receiving documents 
sent for review using Workshare Professional.

Overview - Receiving Files for Review
When a document is received for review, it is in Microsoft Word format and you can open and edit the document 
using all standard Microsoft Word functionality. You can then return the reviewed document to the sender.

In addition the following functionality is available:

 Removing the Review Copy Status: Enables you to remove the “Review Copy” status from the review 
document so that it is no longer part of a Workshare Professional collaboration.

 Displaying Content Risk: Enables you to display a report of the content risk in a document.
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Receiving Review Documents
When a reviewer does not have Workshare Professional installed, the document can be opened in Microsoft 
Word and changes made as required. The document can then be emailed back to the sender.

When a reviewer has Workshare Professional installed, the document is opened in Microsoft Word and the 
Workshare Panel (displayed down the left side of the Microsoft Word window) includes options to assist in the 
review and management of the document.

The document received for review is referred to as the “Review Copy”. From here, you have several choices – to 
remove the “Review Copy” status, to return the document to the sender with any changes or to produce a report 
of the content risk in the document.

You also have options available in the Workshare tab as follows:
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Returning a Reviewed Document

Once you have completed a review of the document and made all the required changes, you can return the 
document to the sender.

To return a reviewed document:

1. Click Return in the Workshare Panel or in the Workshare tab, Review group. The Return to Sender 
page is displayed in the Workshare Panel. 

2. Select whether to send the response to the sender only (Reply to sender only) or to all recipients of the 
initial email (Reply to all).

3. In the Your Email Comments area, add any comments you want to be included in the email returning 
the document.

4. Click Create Email. An email message window is displayed with the sender’s email details in the To
field and the modified document as an attachment.

5. Click Send in the email message window to return the document to the sender.
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Removing the Review Copy Status

You may want to remove the “Review Copy” status from the review document. In effect, you are saving the 
document as a new document and it is no longer part of a Workshare Professional collaboration. Workshare 
Professional removes the intelligent tag thus breaking the association between the document and the review 
cycle. You can open the document as a fresh document and all Workshare Professional functionality will be 
available from the Workshare Panel.

To remove the “Review Copy” status:

1. Click Click here in the Document Sender area of the Workshare Panel or click Remove Sender in the 
Workshare tab, Review group. The following message is displayed:

2. Click Yes. A standard Save As dialog is displayed.

3. Specify the name and location of the new file and click Save.

4. Close the review document.

When you re-open the review document, the Home page is displayed in the Workshare Panel. It is as if the 
document is a “Master” document with all Workshare Professional functionality available. For example, you can 
send the document for review, compare it with another document and so on. 

Displaying Content Risk

You may want to display a report of the content risk in the review document.

To display a content risk report:

Click Content Risk in the Workshare Panel. The Content Risk page is displayed in the Workshare Panel. Refer to 
Overview – Managing Content Risk in Documents for further information.



MANAGING RESPONSES

41

Chapter 5. Managing Responses
This chapter describes how to import responses and manage the changes proposed by reviewers. It includes the 
following sections:

 Overview, below, describes how Workshare Professional recognizes response documents and 
introduces methods of importing.

 Importing Responses, below, describes how to import response documents, using the automatic or 
the manual importing procedure.

 Reviewing Responses, page 48, describes how to view all the changes proposed to your document 
from all the reviewers.

 Managing Changes, page 58, describes how to work through the changes proposed by reviewers and 
handle them one by one. You can select to accept a change, reject it or mark it for future attention.

Overview - Managing Responses 
When a document is sent for review, Workshare Professional tags the document for identification purposes. 
When the reviewer returns the document, Workshare Professional identifies the tag and recognizes the 
document as a response to the document initially sent for review. Therefore, when you receive a response email 
from a reviewer, you do not need to remember the location of the original document in the DMS or even its origin 
or purpose. You just open the attachment and Workshare Professional recognizes the document as a response. 
The response is imported into the original document, which is opened in Microsoft Word with the Workshare 
Panel displayed. Once a response document has been imported, you can review the changes proposed by the 
reviewer and apply or reject them as required. This is where Workshare Professional truly leverages the 
functionality of Microsoft Word, the DMS and the email application.

Importing Responses
In Workshare Professional, import means to associate a response with the original document so that the 
proposed changes can be reviewed and accepted into the original document if required. Importing a response 
involves a comparison. When Workshare Professional recognizes a response, it compares the response 
document against the original document, creating a Redline document that presents the changes between the 
two documents.

When you receive a response from a reviewer by email, you may want to save the attached file and deal with it 
later or you may want to open the attached file immediately by double-clicking it within the email. Workshare 
Professional provides for both these scenarios using the following methods of importing:

 Automatic Importing: When you first open a response document, you can select to add the document 
as a response to the original document. Refer to Automatic Importing.

 Manual Importing: If you do not import the response document immediately but save it to your DMS, 
SharePoint or locally, you can import it later using the manual import procedure. Refer to Manual 
Importing.
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Automatic Importing

The automatic import procedure is triggered simply by opening a response document attachment. Workshare 
Professional reads the tag in the document and recognizes that it is an amended version of a document that 
exists in your DMS.

When you open a response document returned by a reviewer as an email attachment, the Modified Copy dialog
is displayed:

Notes:
This dialog is only displayed if the Display review options for incorporating response documents 
parameter (Review > Administration category) in the Workshare Configuration Manager is selected.

If you are working with a document not saved in your DMS, or that does not have previous versions, there 
may be a dropdown list of previous drafts of the same document that were sent for review.
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You can select to manage the changes, which enables you to review the changes you made and accept or reject 
them as required. Alternatively, you can select to compare the modified response against the original document. 
Finally, you can select to open the response document in Microsoft Word only. You can perform all of these 
steps or just one.

Click… In order to…

Open Modified Copy Open the response document in Microsoft Word. The response document is 
opened in Microsoft Word with a Modified Response status (the Workshare 
Panel displays the “Modified Response” page). You can see the response 
document and then go on to Manage Changes by importing the changes of the 
response document into the original document, Compare the response document 
against the original or another document or view the Content Risk in the 
response document. You can also return the document to Review Copy status 
(the Workshare Panel displays the “Review Copy” page).

Compare Documents Compare the response document against the original document using Workshare 
Compare. The comparison (Redline) document is displayed in the Workshare 
Compare window. Refer to Workshare Compare Main Window for further 
information.

Open Original and 
Manage Changes

Automatically import the changes into the original document. Workshare 
Professional performs a comparison between the response document and the 
version of the document that was sent for review and identifies all changes. 
Workshare Professional automatically recognizes the version of the response 
because of the tag inserted when the document was sent for review. When the 
import is complete, and the original document is open, the Manage Changes 
page is displayed in the Workshare Panel and you can now view the changes 
proposed in the response document and select to incorporate the changes into 
the original document as required. Refer to Reviewing Responses. If the original 
document is not open, it is first opened and the Manage Changes page is 
displayed in the Workshare Panel.

Note: If Workshare Professional cannot open the original document (for 
example, it is open and locked by another user), the response is not imported. 
You can import the response manually. You can also open the response 
document in Microsoft Word.

Note: The checkbox at the bottom of the Modified Copy dialog changes according to your selection. For 
example, if you selected Open Modified Copy, the checkbox would say: Always Open Modified Copy. By 
selecting the checkbox, you ensure that future automatic imports of response documents are dealt with in the 
same way. For example, if you selected to Open Original and Manage Changes then next time you opened a 
response document, Workshare Professional would automatically import the changes without showing the 
Modified Copy dialog.
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Automatic Importing and SharePoint

When you have sent a local document for review by uploading it to a SharePoint site and a reviewer has made 
changes to the document in SharePoint, then you can automatically import the changes back into your local 
document.

When you open your local document, the following message is displayed:

Click Yes and the following dialog is displayed:
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Click… In order to…

Open Shared Workspace Document Open the modified document from SharePoint in Microsoft Word to 
review as required. 

Import Responses and Manage 
Changes

Automatically import the changes into the local document. 
Workshare Professional performs a comparison between the 
changed document in SharePoint and the local document that was 
sent for review and identifies all changes. The Manage Changes page 
is displayed in the Workshare Panel and you can now view the 
changes proposed in the modified document in SharePoint and select 
to incorporate the changes into the original document as required. 
Refer to Reviewing Responses.

Manual Importing

The manual import procedure can be used to import a response document that has been saved in your DMS, 
SharePoint or locally. For example, when you save an attachment rather than open it or when you save a 
response document to your DMS or SharePoint rather than importing it immediately.

To import a response manually: 

1. With your original document open in Microsoft Word, click Manage Changes, (Review group) in the 
Workshare tab or click Manage Changes in the Home page of the Workshare Panel.
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The Manage Changes page is displayed as follows:

When other changes have already been imported 
into the document

When other changes have not yet been imported 
into the document

Note: The options outlined in red are only available when working with SharePoint.
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2. Click Import a document. The Import a Document page is displayed as follows:

3. Click Browse and select the response document that you want to import from your DMS, SharePoint or 
locally. The Import a Document page is displayed as follows: 

Note: The Import a Document page may look slightly different if you work with a DMS.
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4. In the text field in the Name Response area, enter the name of the person who sent the response you 
are going to import.

5. When working with a DMS, select the version of the original document into which you want to import 
the response from the dropdown list in the Sent Version area. You can only select a version that has 
been sent for review. Any versions not sent for review are not included in the dropdown list. If there is 
only one possible version, there is no dropdown list in the Sent Version area.

6. Click Finish. Workshare Professional imports the response by performing a comparison between the 
selected version of the original document and the response document. When the import is complete, 
the Manage Changes page is displayed in the Workshare Panel and you can now view the response 
document and review the changes. Refer to Reviewing Responses.

Reviewing Responses
Once you have imported responses, you can view all the changes proposed to your document. Workshare 
Professional enables you to quickly and easily see all the pertinent facts, such as which reviewer proposed the 
change, the precise location of the change as well as the details of the change itself. You can navigate smoothly 
between changes and select to apply changes to your original document as required.
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To review responses: 

In the Workshare tab, click Manage Changes (Review group) or click Manage Changes in the Home page of 
the Workshare Panel. The Manage Changes page is displayed as follows:

Note: The options outlined in red are only available when working with SharePoint.

The Manage Changes page displays a summary of the changes proposed to the document.
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The Actions area of the page enables you to do the following:

 Display and manage proposed changes according to who proposed them.

 Display and manage proposed changes according to their position in the document.

 Display and manage proposed changes according to their status, for example, applied, flagged.

 Import changes to the document.

 Get updates from SharePoint

 Remove the Review Copy document from SharePoint

Selecting one of the Edit changes... options lists all the proposed changes in the Manage Changes page. The 
sample screen shown below shows changes displayed according to the reviewer that proposed the changes 
(Edit changes by Person). For a detailed description of how changes can be displayed in the Manage Changes 
page, refer to Displaying Changes.

Selecting a change in the Manage Changes page highlights the selected change in both the original document 
(displayed in the upper right area) and in the Redline document (displayed in the lower right area). Three action 

buttons – apply, reject and follow up – are displayed below the change in the Manage Changes 
page.

Notes:
If it takes some time for Workshare Professional to find the change, for example, in very long documents, a 
progress bar indicates the progress of the find process.

If Workshare Professional cannot find the location of the change in the original document, a message is 
displayed requesting that you locate the change manually.
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The Redline document is the result of comparing the imported response against the original document. The 
relevant Redline document is displayed according to the change selected.

You can continue to navigate between changes and apply them or reject them as required. Refer to Managing 
Changes.

Displaying Changes

When working with a DMS, changes in the Manage Changes page are displayed according to the version to 
which they relate. This means all changes to version 1 of the document are displayed under Changes proposed 
to Version 1, all changes to version 2 under Changes proposed to Version 2 and so on. Under each version, 
you can display the changes in three different ways – by person (reviewer), by section according to the order in 
the document in which they occur and by status, such as applied or rejected.

When not working with a DMS, no version information is displayed. You can also display the changes by person, 
section and status.

The different ways of displaying proposed changes in the Manage Changes page are described in the following 
sections.

Person

Clicking Edit changes by Person lists all the changes according to the name of the reviewer who made them. 
(The name is the name of the person who sent the response or the name you entered when importing the 
response.) Under each reviewer’s name, the changes are displayed in the order they appear in the document.

Note: You can also select Order by: Person from the dropdown list at the top of the Manage Changes page, 
once changes are displayed.
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Click the arrow to the left of a reviewer’s name or select Show Changes from the dropdown menu (displayed 
when clicking the arrow to the right of a reviewer’s name) to display/hide the changes made by that person 
below their name.

Note: In Person view and Section view, inserted bulleted and numbered lists are shown separately in the list 
of changes.



MANAGING RESPONSES

53

Click the arrow to the right of a reviewer’s name to reveal the following dropdown menu:

The options are as follows:

Option Description

Show Changes Displays the changes made by the reviewer below their name.

Accept/Reject All Changes 
using Workshare

Displays the changes made by the reviewer below their name and selects all 
the changes. This is indicated by a selected checkbox to the left of each 
change. You can then apply or reject all or some of the changes. Refer to 
Applying Multiple Changes.

This option is only displayed if the Enable ‘Workshare Accept/Reject All 
Changes’ parameter (Review > Administration category) in the Workshare 
Configuration Manager is selected.

Merge Changes as Track 
Changes

Enables you to merge all the changes from the response document into the 
original document as tracked changes using Microsoft’s Word Merge 
functionality. Refer to Applying All as Track Changes.

This option is only displayed if the Enable ‘Merge Changes as Track 
Changes’ parameter (Review > Administration category) in the Workshare 
Configuration Manager is selected.

Hide Applied Changes Hides the changes that have been applied. When the changes are displayed 
below the reviewer’s name, the applied changes are not shown. The number 
of changes that are hidden is shown in parentheses after the reviewer’s 
name.

Manage Format Changes Enables you to manage changes to the formatting of a document.

Document Review Report Enables you to generate a report of the changes proposed by the reviewer. 
Refer to Review Report.

View Email Opens the email sent by the reviewer when submitting their response.

Remove Email Link Removes the link to the email sent by the reviewer when submitting their 
response.

Rename Enables you to modify the name of the reviewer. 

Delete Enables you to delete the reviewer and their proposed changes from the 
Manage Changes page. This action cannot be undone and you would have to 
import the response again if you wanted to see the reviewer’s changes. 
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Section

Clicking Edit changes by Section lists all the changes according to the following criteria:

 The version of the document sent for review.

 The draft of the document sent for review, meaning the date and time the document was sent.

 The order the proposed changes appear in the document.

Note: You can also select Order by: Section from the dropdown list at the top of the Manage Changes page, 
once changes are displayed.

The name of the reviewer who proposed the change is shown above the change.
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Note: In Person view and Section view, inserted bulleted and numbered lists are shown separately in the list 
of changes.

Click the arrow to the right of a reviewer’s name to reveal the following dropdown menu:

The options are as follows:

Option Description

Show Changes Displays the changes proposed to this version and this draft in the order 
they occur in the document.

Hide Applied Changes Hides the changes that have been applied. When the changes are 
displayed below the reviewer’s name, the applied changes are not 
shown. The number of changes that are hidden is shown in parentheses 
after the reviewer’s name.

Manage Format Changes Enables you to manage changes to the formatting of a document.

Document Review Report Enables you to generate a report of the changes proposed by the 
reviewer. Refer to Review Report.

Status

Clicking Edit changes by Status lists all the changes according to their status, as follows:

 Unread: Changes that have not yet been read.

 Read: Changes that have been read but no action has yet been taken.

 Flagged: Changes that have been flagged for follow up.

 Applied: Changes that have been applied in the original document.

 Rejected: Changes that have been rejected, meaning they are not wanted in the original document.

 Merged: Changes in a response document that have been merged as track changes into the original 
document using Microsoft Word’s Merge functionality

 Not Found: Changes that Workshare Professional was unable to locate. For example, where you have 
selected to apply all changes, those changes that could be applied are marked as applied, and those 
that could not are marked as not found. You can then click through them manually and apply them 
individually.
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Note: You can also select Order by: Status from the dropdown list at the top of the Manage Changes page, 
once changes are displayed.

Click the arrow to the left of a status to display the changes with that status below. The name of the reviewer 
who proposed the change is shown above the change.

Tip! When selecting a change in any view, the name of the reviewer and the date and time of submission are 

shown above the Redline document .
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Redline Document

The Redline document, displayed in the lower right area, is a copy of the original document with a reviewer’s 
changes marked. The Redline document is the result of a comparison between the original document and an 
imported response. It has a gray/blue background color and cannot be edited. Depending on the change selected 
in the Manage Changes page, the relevant Redline document is shown in the lower right area.

Changes in the Redline document are represented by different colors, as follows:

Inserted text is blue and double underlined

Deleted text is red and struck through

The toolbar displayed above the Redline document includes the following buttons:

/ 
Navigates to the previous/next change and highlights the entire change in both the 
Redline document and the original document..

Enables you to print a report of the changes proposed to a selected version and 
draft. Refer to Review Report.

/ Hides/displays the Redline document.

The name of the reviewer and the date and time of submission are shown above the Redline document.

Original Document

The original document is updated with changes as they are accepted. At any time you may edit and format the 
original document exactly as you would any ordinary Microsoft Word document. For example, even after you 
have accepted a change into the original document, you can still edit or delete it manually. You can also copy 
text from the Redline document into the original document.

Copying Text from the Redline Document

You can select whole blocks of text in the Redline document and move it into the original document using 
copy/paste functionality.

To copy and paste:

1. Select the text in the Redline document that you want to copy into the original document.

2. Copy the selection to the clipboard by pressing Ctrl and C on your keyboard or right-clicking and
selecting Copy.

3. Position the cursor in the original document where you want the text to be inserted.

4. Copy the selection from the clipboard by pressing Ctrl and V on your keyboard or right-clicking and
selecting Paste. The text is copied to the original document.

Any mark-up in the text (introduced as part of the comparison process) is stripped out. Changes that are either 
deletions or the sources of moved text are not copied across. 
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Managing Changes
After sending a document for review and then receiving responses back from the reviewers, it is useful to work 
through the changes proposed by reviewers and handle them one by one. You can select to accept a change, 
reject it or mark it for future attention. A handy icon is added to the left of the change in the Manage Changes 
page and in the Redline document to indicate that you have dealt with the change. This is useful to avoid missing 
changes.

At any time, you can continue to work on your original document using standard Microsoft Word functionality 
making your own changes without reference to changes proposed by others.

Applying Changes Automatically

As you review the changes proposed by reviewers, you may decide you would like to implement the change in 
the original document.

To apply a change:

1. Select the change in the Manage Changes page. The selected change is highlighted in both the original 
document and in the Redline document and the following action buttons are displayed below the 
change in the Manage Changes page.

If the Display location arrows when navigating changes (requires restart of Word) parameter
(Review > Administration category) in the Workshare Configuration Manager is selected), an arrow 
points from the change selected in the Workshare Panel to the change in the original document. If this 
parameter is not selected, a popup balloon is displayed over the change in the original document as 
follows:

2. Click apply in the Manage Changes page or in the popup balloon. The change is implemented in 

the original document, for example, new text is inserted. The change is marked with a green tick 
both in the Manage Changes page and in the Redline document. The action buttons below the change 
are now displayed as follows:

Note: If you want to reverse your action and remove the change from the original document, click Undo.
The change is no longer marked as applied.

If you are not sure whether you want to apply the change, you can click follow up instead of apply. 

This marks the selected change as requiring attention at a later time, indicated by a red flag both in the 
Manage Changes page and in the Redline document. The change is not applied in the original document at this 
stage.
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Multiple Changes Found

Workshare Professional may detect several locations where a change could be applied. For example, if you have 
more than one occurrence of a certain phrase or paragraph then a change could possibly be applied in two 

places. If so, when you select the change in the Manage Changes page, a next possible location button is 
displayed. You must decide in which location you want to apply the change.

To select a change position:

1. Click next possible location to scroll to the next potential position.

2. Continue to click next possible location until you find the position where you would like to apply 
the change.

3. Click apply.

Applying Changes Manually

Sometimes Workshare Professional cannot find the location of the change. For example, the change may 
suggest that a line of text is deleted and you have already deleted or modified this text in the original document. 
Also, if the paragraph or section that includes the change has been edited significantly since the document was 
sent out for review.

If Workshare Professional cannot find the location of a selected change, the apply button is not enabled and 
a popup balloon is displayed next to the change in the Manage Changes page requesting that you locate the 
change manually in the original document. For example:

To apply the change, simply position the cursor at the required point in the original document. For example, if the 
change proposes to insert a line of text, simply position the cursor in the original document at the point where 

you would like the text inserted. The apply button is then enabled. Click apply and the change is 
implemented in the original document.
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Rejecting Changes

As you review the changes proposed by reviewers, you may decide you do not want to implement the change in 
the original document. You can therefore reject the change, clearly indicating that you do not want to give the 
change further attention.

To reject a change: 

Select the change in the Manage Changes page and click reject. The change is marked with a red cross 
both in the Manage Changes page and in the Redline document.

Note: If you want to reverse your action, click Undo. The change is no longer marked as rejected.

If you are not sure whether you want to reject the change, you can click follow up instead of reject. 

This marks the selected change as requiring attention at a later time, indicated by a red flag both in the 
Manage Changes page and in the Redline document. The change is not applied in the original document at this 
stage.

Applying Multiple Changes

If required, you can apply or reject several changes at the same time.

To work with multiple changes:

1. Display changes by Person in the Manage Changes page.

2. Click the arrow to the right of a reviewer’s name whose changes you want to apply to reveal the 
Actions dropdown menu and select Accept/Reject All Changes using Workshare. The following 
message is displayed.

Note: This option is only available in the dropdown menu if the Enable ‘Workshare Accept/Reject 
All Changes’ parameter (Review > Administration category) in the Workshare Configuration 
Manager is selected.
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3. Click Yes to continue. The changes made by the reviewer are displayed below their name and all the 
changes are selected. This is indicated by a selected checkbox to the left of each change.

4. Deselect some changes if required.

5. Click one of the following buttons:

Applies the selected changes in the original document.

The selected changes are not applied in the original document and are marked as 
rejected.

The selected changes are undone. For example, if a change had been applied, the apply 
action would be undone.
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The selected changes are applied or rejected or undone according to your selection. A report on the number of 
changes and the action taken is displayed.

If Workshare Professional cannot carry out the action on a specific change for any reason, it marks the change 
with a question mark. For example, there may have been more than one place that the change could have been 
applied.

Applying All as Track Changes

If required you can merge all the changes from a response document into the original document as track changes 
using Microsoft Word’s merge functionality. The changes Microsoft Word detects between the documents are 
listed in the Track Changes section of the Manage Changes page of the Workshare Panel. This option may be 
useful if you feel more familiar with Microsoft Word’s track changes functionality.

By applying all as track changes: 

 The Microsoft Word discovered track changes will not appear in Workshare Professional reports.

 If you then accept or reject the track changes, Workshare Professional will be unable to undo these 
changes at a later date.

 Workshare Professional no longer keeps track of the Microsoft Word discovered track changes.

To apply all as track changes:

1. Display changes by Person in the Manage Changes page.

2. Click the arrow to the right of a reviewer’s name whose changes you want to apply to reveal the 
Actions dropdown menu and select Merge Changes as Track Changes. The following message 
explaining the consequences of merging the changes is displayed.
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Note: This option is only available in the dropdown menu if the Enable ‘Merge Changes as Track 
Changes’ parameter (Review > Administration category) in the Workshare Configuration Manager 
is selected.

3. Click Yes to continue. 
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4. If you had already rejected or flagged suggested changes to the document, the following message is 
displayed.

5. Click Yes to continue. Any previous actions performed on the changes will be ignored and all changes 
will be listed as track changes. Microsoft Word detects the changes between the response document 
and the original document and lists them as track changes in the Track Changes section of the Manage 
Changes page of the Workshare Panel.
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Under the reviewers name whose changes you have merged, the changes are listed under the heading 
Merged but you can no longer review them from here using Workshare Professional.

You can now review the changes from the Track Changes section of the Manage Changes page either 
individually or collectively. You should remember though that when a change is applied or rejected from here, 
Workshare Professional cannot undo the action and there is no longer a record of the change.
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Chapter 6. Comparing Documents from within 
Microsoft Word
This chapter describes how to compare documents using Workshare Compare from within Microsoft Word. It 
includes the following sections:

 Overview, below, introduces the comparison functionality of Workshare Compare.

 Performing a Comparison, page 67, describes how to compare a document against an earlier version 
of the document or against a different document, and describes the Redline document – the result of 
the comparison.

 Working with the Redline Document, page 70, describes the tools available to you when working 
with the compared (Redline) document after a comparison

For information about comparing documents using Workshare Compare, refer to Overview - Comparing 
Documents Using Workshare Compare.

Overview – Comparing Documents from Within 
Microsoft Word
Workshare Compare enables you to compare two documents within Microsoft Word and instantly see any 
differences between them. You can compare a document against an earlier or later version of the same 
document or against a different document. Documents can be stored in your DMS or CRM, in SharePoint, locally 
or on your network. You can compare any of the following formats:

 DOC

 DOCX

 PDF

 RTF

 TXT

Comparison results are displayed in a Redline document within Microsoft Word with changes clearly marked. 
For example, deleted text is red and struck through and added text is blue and double underlined. You can 
compare all content including images, tables and embedded Microsoft Excel tables. In one view, you can see 
both the original document and the comparison document.

PDF Comparison

Workshare Compare can compare both regular text-based PDF files and image-based PDF files that originate 
from scanned documents. Workshare Compare compares regular PDFs by converting them to RTF before 
performing a comparison. With image-based PDF files, Workshare Compare will first apply OCR (Optical 
Character Recognition) processing to translate the images of typewritten text into editable text and then produce 
an RTF file.
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Note: Workshare Compare can perform OCR on the following languages: English, Danish, Dutch, Finnish, 
French, German, Italian, Norwegian, Polish, Portuguese, Spanish, Swedish and Russian.

Performing a Comparison
You can compare your original document against a previous version of the document or against another 
document entirely. You can also compare any two versions of a document. For example, there may be ten 
versions of a document in your DMS. You can open version 3 and compare it against version 5.

Note: You cannot compare secure PDFs, meaning PDF files with security settings configured.

To compare documents: 

1. Click Compare in the Workshare tab, Compare group or click Compare in the Home page of the 
Workshare Panel. The Compare page is displayed as follows:

Note: The Workshare Panel displays slightly differently depending on whether you are working with a
document saved in your DMS/CRM.
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2. Select the document against which you want to compare the current document in one of the following 
ways:

 Select a version of the document from the dropdown list. When the document has previous 
versions, the dropdown list is a list of other versions of the document. When the document has no 
versions but has previously been sent for review, the list is a list of previously sent out versions of 
the document. These “versions” are actually revisions, which are created when the document is 
sent for review if the document has changed since the last time it was sent.

 Click Browse and select a document from your DMS/CRM or locally.

Note: When Workshare is integrated with your DMS/CRM, for example NetDocuments, the Open from 
NetDocuments dialog is displayed. Clicking Cancel will enable you to select a comparison document 
locally. 

The Compare page is displayed as follows:

Tip! If you want to change the selected document, click the Remove link and select a different 
document.
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3. To show the comparison in Microsoft Word, deselect the Open in Compare checkbox. If this checkbox 
is selected, the comparison will be displayed in the Workshare Compare window. Refer to Overview -
Comparing Documents Using Workshare Compare for information about comparing documents using 
Workshare Compare.

4. If required, select a rendering set from the dropdown list in the Comparison Options area to determine 
how the comparison document is displayed. For example, deleted text could be shown in red with a 
strikethrough. Click Edit Rendering Set if you want to modify rendering sets. For further information 
about rendering sets, refer to Introducing Rendering Sets.

5. Click Compare. Workshare Compare performs the comparison. A progress bar indicates the progress of 
the compare process.

When the comparison is complete, the results of the comparison are displayed in a comparison (Redline) 
document in the lower right area. The original document remains open in the upper right area.

The Redline document clearly displays the changes between your original document and the selected document. 
Changes are marked according to the rendering set applied to the comparison. For example, deleted text is red 
and struck through and added text is blue and double underlined.

Note: When comparing a PDF file, the display may vary according to the type of PDF. The type of PDF means 
the software used to create the PDF file. For example, Adobe, Amyuni, CutePDF, novaPDF, and so on.

Moving between changes in the Redline document using the arrow keys scrolls to the change and highlights it in 
both the Redline document and the original document.
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You can continue working in the original document as required. At any time, you can again compare the original 
document with a previous version or another document by clicking Maximize in the Workshare Panel and 
repeating the procedure described above. 

Click Maximize and then Home in the Workshare Panel to close the Redline document and return to the Home 
page of the Workshare Panel.

Working with the Redline Document
After a comparison, you can navigate between the changes in the Redline document, switch the original and 
modified documents, import the changes into the original document, save the Redline document, print it or email 
it using the tools available in the toolbar located above the Redline document and the options provided in the 
Workshare Panel. These options are described in the following pages.

Navigating Between Changes

After performing a comparison, you can review the Redline document (the result of the comparison) and 
consider the changes between the two documents. You can move between changes in the Redline document by 
jumping from change to change.

Click in the toolbar above the Redline document to move to the previous change and highlight the entire 
change in the Redline document and in the original document.

Click in the toolbar above the Redline document to move to the next change and highlight the entire change 
in the Redline document and in the original document.

Edit the Rendering Set

You can edit the way the changes are presented in the Redline document by editing the rendering set applied to 
the comparison.

Click in the toolbar above the Redline document. For further information about rendering sets, refer to 
Introducing Rendering Sets.

Swapping the Source Documents

You can re-run a comparison exchanging the original document for the modified document and the modified 
document for the original document. For example, if Document A was the original document and Document B 
was the document you selected to compare Document A against, Workshare Compare compares Document A to 
Document B and presents the changes made to Document A.
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Click in the toolbar above the Redline document to swap the original and modified documents so that 
Document B is now the original document and Document A is the document selected to compare Document B 
against. Workshare Compare automatically re-runs the comparison, comparing Document B to Document A, and 
presents the changes made to Document B.

Importing Changes into the Original Document

You can import the changes detailed in the Redline document into the original document.

Click in the toolbar above the Redline document. The changes detailed in the Redline document are 
imported into the original document. The original document and the Manage Changes page of the Workshare 
Panel are displayed. You can then select to incorporate the changes into the original document as required. Refer 
to Overview - Managing Responses for further information.

Printing Redline Documents

You can print the Redline document at any time.

To print a Redline document: 

1. Click Print in the Workshare Panel or click in the toolbar above the Redline 
document. The Print dialog is displayed.

2. Select from the standard print options in the usual way.
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3. If you are printing to a black and white printer, select the Print Redline in black and white checkbox, 
as colored text may not appear clearly when printing in black and white.

4. If you only want to print pages of the Redline document that include changes, select the Only print 
pages with changes checkbox.

5. Click OK.

Saving Redline Documents

You can save the Redline document as an RTF or Microsoft Word file to your DMS/CRM, SharePoint or locally. 
The following procedure describes how to save to iManage 8 as an example.

To save a Redline document: 

1. Click Save in the Workshare Panel. The Save comparison document dialog is displayed.

Note: If you are not working with a DMS/CRM or SharePoint, the LocalStore Save As dialog is 
displayed.

Tip! If you are working with a DMS/CRM or SharePoint but both documents compared are local 
documents, then you can press the Shift key while clicking Save and the LocalStore Save As dialog is 
displayed.

2. From the dropdown list, select how you want to save the document from the following:

 Save a New Document

 Attach/Relate to Original Document (Only available when using the IManage or DOCS Open 
integration and the original document is from IManage or DOCS Open)

 Attach/Relate to Modified Document (Only available when using the IManage or DOCS Open 
integration and the modified document is from IManage or DOCS Open)
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Note: The modified document is the current document open in Microsoft Word; the original document 
is the document selected to compare against the current document.

3. Click OK. The iManage Save As dialog is displayed.

Note: If you press the Shift key while clicking OK, the LocalStore Save As dialog is displayed and you 
can save the Redline document locally.

Note: If you click Cancel in this dialog, a message is displayed asking if you would like to save the 
Redline document locally.

The Document Information area provides information about the currently open Redline document, if it 
is already saved. This information includes the DMS document number, the version number and a 
description. If the Redline document is a new document these fields are empty.

4. In the Options area, select the way in which you want to save the Redline document from the 
following:

New Document To save the Redline document as a completely new document. If the Redline 
document has not been saved before and you selected Save a New 
Document in the Save Comparison dialog, this is the only option enabled.

Replace Original This option is not enabled.

New Version To save the Redline document as a new version. This option is only enabled if 
the Redline document has been saved before and you selected Save a New 
Document in the Save Comparison dialog.
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Related Document (IManage DMS only) To save the Redline document as a related document 
(related to the original or modified document). This option is only enabled if 
you selected Attach/Relate to Original/Modified Document in the Save 
Comparison dialog.

New SubVersion (Hummingbird DMS only) To save the Redline document as a new sub-
version. This option is only enabled if the Redline document has been saved 
before and you selected Save a New Document in the Save Comparison
dialog.

Attachment (Hummingbird DMS only) To save the Redline document as an attachment to 
the original or modified document. This option is only enabled if you are 
attaching a Redline document to the original or modified document, meaning 
you selected Attach/Relate to Original/Modified Document in the Save 
Comparison dialog.

5. (IManage DMS only) From the Logged in Servers dropdown list, select which server you would like to 
use. This list is a list of previously logged in servers. If you want to log in to a different server, click 
Servers.

6. From the Save As Type dropdown list, select the format for the saved file from the following:

Word Document (*.doc) Saves the Redline document as a Microsoft Word file. The source 
documents are not saved.

Rich Text Format (*.rtf) Saves the Redline document as an RTF file. The source documents are 
not saved.

7. Click OK. In IManage 8, the following dialog is displayed:

8. Complete the fields as required and click OK. The Redline document is saved to the specified location.
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Sending Compared Documents by Email

You can send the Redline document (in Microsoft Word format or as a PDF) as an email attachment.

To send a Redline document by email: 

1. Click Send in the Workshare Panel. The Send Comparison page is displayed as follows:

2. Select the format in which you want to send the comparison from the following:

 Word Document: The comparison will be sent as a Microsoft Word file.

 PDF (.pdf): The comparison will be sent as a PDF file. 

 PDF/A (.pdf): The comparison will be sent as a PDF/A file. 
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3. If you selected PDF in step 2, you can expand the PDF security configuration section to set PDF 
security options.

4. Select one or more of the security options as required:

 Prevent printing: Prevents recipients from printing the PDF document.

 Prevent editing of text: Prevents recipients with Adobe Distiller from editing the PDF document.

 Prohibit copying of text and/or graphics: Prevents recipients from copying graphics or text 
directly from the PDF document.

 Prevent comments being added: Prevents recipients with Adobe Distiller from adding comments 
to the PDF document.

5. If you selected PDF or PDF/A in step 2, you can expand the Metadata cleaning section and click 
Cleaning options to specify what hidden data to remove before converting it to PDF.

6. Select hidden data elements as required. For a full description of all the hidden data elements, refer to 
Cleaning Hidden Data, for further information.

7. Click OK.

8. If you selected PDF in step 2, you can expand the Password protection section to protect the PDF.

9. If required, set a password to protect the PDF by entering the password twice in the relevant fields. 
When a password is specified, the recipient can only open the PDF after entering this password.

10. Enter the name for the Redline document in the File Name field. By default the Redline document is 
called Comparison of [name of modified document] with [name of original document].
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11. Click Create Email. An email message window is displayed with the comparison in the specified format 
as an attachment. (If the PDF file type was selected, a progress dialog indicates the progress of the 
conversion to PDF.)

12. Enter the recipient(s) name and any other text you want to include and click Send. The file is sent to the 
specified recipients.

Note: Depending on the configuration of Workshare, an email protection dialog may be displayed 
before the document is sent. Refer to Overview – Protecting Email Attachments for further information.
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Chapter 7. Comparing Documents Using 
Workshare Compare
This chapter describes Workshare Compare, a standalone application that enables you to compare two 
documents. It includes the following sections:

 Overview, below, introduces the Workshare Compare application.

 Performing Comparisons, page 80, describes how to compare a document against an earlier version of 
the document or against a different document using Workshare Compare.

 Workshare Compare Main Window, page 88, describes the Workshare Compare environment and 
provides an overview of the functionality available.

 Working with Redline Documents, page 106, describes the tools available to you when working with 
the compared (Redline) document after a comparison.

 Alert and Compare - Generating Redlines in Outlook, page 127, describes how to generate a Redline 
from within Microsoft Outlook.

 Comparing an Attachment, page 129, describes how to compare attachments in Workshare Compare.

For information about comparing documents using Workshare Compare from within Microsoft Word, refer to 
Overview – Comparing Documents from Within Microsoft Word.

Note: This chapter describes how to perform comparisons using the Ribbon interface of Workshare Compare. 
If you are more comfortable with the Classic interface, click Classic View in the View Ribbon.

Overview - Comparing Documents Using Workshare 
Compare
The Workshare Compare application compares documents – the original document and the modified document –
and produces a comparison (Redline) document, enabling you to instantly see any differences between them. In 
one view, you can see both the source documents and the resulting Redline document. You can compare an 
original document against several different modified documents and see the Redline document for each 
comparison in a different tab. Documents can be stored in your DMS or CRM, locally or on your network.

You can compare any of the following file formats:

DOC DOCX PDF RTF TXT

Workshare Compare’s powerful engine accurately and reliably displays document changes and eliminates the 
need to check the changes manually. All content is compared including images, tables and embedded Microsoft 
Excel tables. You can review the Redline document by navigating between the changes. To make the review 
easier, you can customize how the changes are highlighted within the document. A statistical summary at the 
end of the Redline document enables you to precisely match the document changes.
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There are several types of comparison available, as follows:

 Standard: Workshare Compare performs a regular comparison.

 Fast: When comparing a .DOC file against another .DOC file, Workshare Compare performs a binary 
comparison which is faster than a standard comparison because it is comparison at the binary level.

When comparing a .DOCX file against another .DOCX file, Workshare Compare performs a faster 
comparison by converting the documents to DOC followed by comparison at the binary level.

Notes:
The Fast option is only available for DOC files if the Enable fast comparison for DOC files parameter
(Comparison > Administration category) in the Workshare Configuration Manager is selected.

The Fast option is only available for DOCX files if the Enable fast comparison for DOCX files
parameter (Comparison > Administration category) in the Workshare Configuration Manager is 
selected.

 Text Only: Workshare Compare performs a text-only comparison, comparing only the text in a 
document and not the formatting or styles.

 Compare without OCR: Workshare Compare performs without first performing OCR. With image-based 
PDF files, Workshare Compare will first apply OCR (Optical Character Recognition) processing to 
translate the images of typewritten text into editable text in order to compare. If you do NOT want 
Workshare Compare to perform OCR, select this option.

PDF Comparison

Workshare Compare can compare both regular text-based PDF files and image-based PDF files that originate 
from scanned documents. Workshare Compare compares regular PDFs by converting them to RTF before 
performing a comparison. With image-based PDF files, Workshare Compare will first apply OCR (Optical 
Character Recognition) processing to translate the images of typewritten text into editable text and produce an 
RTF file.

PDF files that originate from scanned documents may include:

 PDF files generated from files that have been scanned: OCR (Optical Character Recognition) has already 
been used to translate images of typewritten text into editable text. Workshare Compare supports the 
comparison of such PDF files.

 PDF files that have been created directly from the scanning: Where OCR has not been used and PDF 
files contain pure images of text. Workshare Compare applies OCR to the PDF files before performing 
comparisons.

Notes:
If you compare scanned PDF files without applying OCR, it may result in a blank Redline document.

Workshare Compare can perform OCR on the following languages: English, Danish, Dutch, Finnish, French, 
German, Italian, Norwegian, Polish, Portuguese, Spanish, Swedish and Russian.
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Performing Comparisons
You can launch Workshare Compare both from within Microsoft Word and from your desktop.

You can compare your original document against a previous version of the document or against another 
document entirely. You can also compare any two versions of a document. For example, there may be ten 
versions of a document in your DMS. You can open version 3 and compare it against version 5. You can also 
compare a document against multiple versions. For example, you can open version 3 and compare it against 
version 5, version 7 and version 10.

Note: You cannot compare secure PDFs, meaning PDF files with security settings configured.

You can also use Workshare Compare to compare an email attachment with another document on your local file 
system, SharePoint or DMS. Refer to Comparing an Attachment.

Launching Workshare Compare from Microsoft Word

In this scenario, you first open your original document in Microsoft Word.

To compare documents:

1. Click Compare in the Workshare tab, Compare group or click Compare in the Home page of the 
Workshare Panel. The Compare page is displayed as follows:
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2. Select the document against which you want to compare the open original document in one of the 
following ways:

 Select a version of the document from the dropdown list. When the document has previous 
versions, the dropdown list is a list of other versions of the document. When the document has no 
versions but has previously been sent for review, the list is a list of previously sent out versions of 
the document. These “versions” are actually revisions, which are created when the document is 
sent for review if the document has changed since the last time it was sent.

 Click Browse and select a document from your DMS/CRM, SharePoint or locally.

Note: When Workshare is integrated with your DMS/CRM, for example NetDocuments, the Open from 
NetDocuments dialog is displayed. Clicking Cancel will enable you to select a comparison document 
locally. 

The Compare page is displayed as follows:

Tip! If you want to change the selected document, click the Remove link and select a different 
document.

3. If required, select a rendering set from the dropdown list in the Comparison Option area to determine 
how the comparison document is displayed. For example, deleted text could be shown in red with a 
strikethrough. For further information about rendering sets, refer to Introducing Rendering Sets.
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4. Select the Open in Compare checkbox. Deselecting this checkbox will display the comparison within 
Microsoft Word. Refer to Overview – Comparing Documents from Within Microsoft Word for more 
information.

5. Click Compare. Workshare Compare performs the comparison. A progress bar indicates the progress of 
the compare process.

When the comparison is complete, the results of the comparison are displayed in the Workshare Compare 
window. For a full description of the Workshare Compare interface, refer to Workshare Compare Main Window.

Launching Workshare Compare from your Desktop

In this scenario, you launch Workshare Compare as a standalone application from your desktop or the Start 
menu. You then select the documents you want to compare. Launching Workshare Compare in this way enables 
you to perform one-to-many comparisons - comparing a single original document against multiple modified 
documents.

To compare documents: 

1. Click the Workshare Compare shortcut on your desktop or from the Start menu, select Programs > 
Workshare > Workshare Compare. The Compare Documents dialog is displayed:

Tip! You can also right-click a document you want to compare in Windows Explorer or in your DMS 
(Autonomy iManage/Open Text/Worldox) and select Compare with Workshare. You cannot launch 
Workshare Compare from NetDocuments or SharePoint in this way.
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2. Select the original document you want to compare by clicking the Open button to the right of the 
Original Document field.

3. Navigate to the document location in your local file system, SharePoint or DMS/CRM and click Open. 
The selected document is displayed in the Original Document field.

Tip: You can also enter text directly into the text box. Workshare Compare will predict locations as you 
type. This is possible for locations accessible from the local machine but not for locations in a DMS.

4. Select the document you want to compare with the original document (DOC/X or PDF file) by clicking 

the Open button to the right of the Modified Document field.

5. Navigate to the document location in your local file system, SharePoint or DMS/CRM and click Open. 
The selected document is displayed in the Modified Document field.

Tip! If you want to compare a recently used file, click the dropdown in the Original Document and 
Modified Document fields and select the documents you want to compare. These lists contain the 
last 10 documents you have used.

Tip! To swap the original and modified documents, click . This button is only available if you are 
comparing two documents rather than comparing multiple documents against an original document.

6. If you want to compare the original document against another document, click . An additional 
Modified Document field is added as follows:

7. Select the document you want to compare with the original document by clicking the Open
button to the right of the second Modified Document field.

8. Navigate to the document location in your local file system, SharePoint or DMS/CRM and click Open. 
The selected document is displayed in the second Modified Document field.

9. Repeat steps 6-8 to add further documents as required.
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10. From the Rendering Set dropdown list, select the rendering set you want to use. Rendering sets 
contain a set of parameters that define how changes are displayed in the Redline (compared) 
document. You can select from the standard rendering sets provided with Workshare Compare or you 
can create and customize your own rendering sets (described in Introducing Rendering Sets).

Note: Clicking to the right of the Rendering Set field displays the Rendering Sets Manager
where you can create, modify and delete rendering sets. For a full description refer to Introducing 
Rendering Sets.

11. From the Comparison Option dropdown list, select the type of comparison you want to perform from 
the following:

 Standard: Workshare Compare performs a regular comparison.

 Fast: When comparing a .DOC file against another .DOC file, Workshare Compare performs a binary 
comparison which is faster than a standard comparison because it is comparison at the binary level.

When comparing a .DOCX file against another .DOCX file, Workshare Compare performs a faster 
comparison by converting the documents to DOC followed by comparison at the binary level.

Notes:
The Fast option is only available for DOC files if the Enable fast comparison for DOC files parameter
(Comparison > Administration category) in the Workshare Configuration Manager is selected.

The Fast option is only available for DOCX files if the Enable fast comparison for DOCX files
parameter (Comparison > Administration category) in the Workshare Configuration Manager is 
selected.

 Text Only: Workshare Compare performs a text-only comparison, comparing only the text in a 
document and not the formatting or styles.

 Compare without OCR: Workshare Compare performs without first performing OCR. With image-
based PDF files, Workshare Compare will first apply OCR (Optical Character Recognition) processing 
to translate the images of typewritten text into editable text in order to compare. If you do NOT 
want Workshare Compare to perform OCR, select this option.
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12. Click OK. The comparison process is launched and a Progress dialog is displayed.

The Progress dialog indicates the progress of the comparison.

Tip: Progress is also indicated by the shading in the Task Bar icon for Workshare Compare 

When the comparison is complete, the Redline (compared) document is displayed in the Workshare Compare 
window. If the original document has been compared against multiple documents, each Redline document is 
displayed in a different tab. For a full description of the Workshare Compare interface, refer to Workshare 
Compare Main Window.

Note: When comparing a PDF file, the display may vary according to the type of PDF. The type of PDF means 
the software used to create the PDF file. For example, Adobe, Amyuni, CutePDF, novaPDF, and so on.

If Workshare Compare cannot complete the comparison, it will do one of two things:

 If enabled, auto retry mode is invoked. See Auto Retry Mode.

 If auto retry mode is not enabled (or if Workshare Compare cannot complete the comparison in auto 
retry mode) failsafe mode is invoked. See Failsafe Mode.

Auto Retry Mode

If Workshare Compare is unable to complete the comparison, and auto retry mode is enabled, then Workshare 
Compare attempts to perform the comparison using reduced settings. For example, Workshare Compare may 
attempt to compare the documents without comparing field codes or without comparing footnotes. Workshare 
Compare repeatedly attempts to perform the comparison disabling settings one at a time until the comparison is 
successful.

Note: Auto retry mode is enabled in the Comparison Options category of the Rendering Sets Manager. Refer 
to Comparison Options.

Once the comparison is successful, a message is displayed informing you that the comparison has been 
performed using reduced settings.

Note: The comparison may take longer than usual because Workshare Compare is attempting to compare 
using different settings.
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Click OK and scroll to the Redline Options Summary, which is displayed at the beginning or end of the Redline 
document according to your settings in the Redline Options category of the Rendering Sets Manager.

The Redline Options Summary indicates which settings Workshare Compare disabled in order to perform the 
comparison. 

Redline Options Summary

Option: Status:

Redline Statistics at End of Document ON

Include Redline Comparison Summary OFF

Show Line Numbering OFF

Show Change Numbers OFF

Show Change Bars on Left ON

Show Hidden Text OFF

Detect List Numbering Changes ON

Compare Headers/Footers ON

Compare Footnotes SET OFF

Display Compare Footers OFF

Ignore Embedded Objects/Images OFF

Compare at Character Level OFF

Compare Numbers at Character Level OFF

Show Moved Deletions OFF

Show Changes to Spaces OFF

Show Paragraph Changes OFF

Ignore Case Changes OFF

Ignore Textboxes SET ON

Ignore Field Codes OFF

Ignore Tables OFF

Note: Even if you have not selected the Include Redline Options Summary parameter in the Redline 
Options category of the Rendering Sets Manager, when Workshare Compare performs an auto retry, the 
Redline Options Summary is always displayed after the comparison.
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The status indications are as follows:

ON This setting is selected and was applied during the comparison.

OFF This setting is not selected and was not applied during the comparison.

SET ON This setting was not selected but was enabled by Workshare Compare and applied during the 
comparison.

SET OFF This setting was selected but was disabled by Workshare Compare and not applied during the 
comparison.

If Workshare Compare cannot complete the comparison even using reduced settings, failsafe mode is invoked.

Failsafe Mode

If Workshare Compare is unable to complete the comparison and auto retry mode is disabled, or if Workshare 
Compare cannot complete even a reduced comparison in auto retry mode, then failsafe mode is invoked. Failsafe 
mode means that Workshare Compare performs a text-only comparison, comparing only the text in a document 
and not the formatting or styles.   

Manually Invoke Failsafe Mode 

You can manually invoke failsafe mode so that a text only comparison is performed. You may want to do this if, 
after a full comparison, your Redline document was not fully shown in Workshare Compare for any reason. 
Additionally, you may want to do this if you are more interested to see text changes rather than formatting and 
style changes.

Before running the comparison, select Text Only from the Comparison Option dropdown list in the Compare 
Documents dialog and then click OK to run the compare.
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Workshare Compare Main Window
The Workshare Compare main window enables you to view Redline documents - the results of a comparison 
between an original document and a modified document. You can view (in one work area) both source 
documents, the Redline document and a summary of the changes between the two source documents.

Note: This section describes the Ribbon interface of Workshare Compare. If you are more comfortable with 
the Classic interface, click Classic View in the View Ribbon. Switching between views requires a restart of 
Workshare Compare.

The Ribbon changes according to the selected tab. In the above example, the Home tab is selected. When you 
select to run multiple comparisons, each resulting Redline document is displayed in an individual tab.
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Moving and Placing Windows

The Source Documents window and the Change Summary window can easily be moved to different positions in 
the Workshare Compare main window according to individual preference.

Left click the title bar of the Source Documents window or Change Summary window and the drag the window 
to your preferred position. The selected window will float over the workspace.

To dock a window:

Left-click the title bar of a floating window and keep the mouse button pressed. Positioning arrows appear at the 
top, bottom, left and right of the Workshare Compare main window, as well as in the center.

Move the mouse pointer over the required positioning arrow and release the mouse button. The window is 
docked in the selected location. For example, dragging the Change Summary window over the left positioning 
arrow will dock the Change Summary window down the left side of the Workshare Compare main window.

To hide a window:

Click in the top right corner of the Source Documents window or the Change Summary window.

Use the options in the Show/Hide group on the Home or View tab.
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To auto-hide a window:

Click in the top right corner of the Source Documents window or the Change Summary window. The selected 
window is hidden with just a tab remaining. For example, if the Change Summary window was displayed on the 

left side of the Workshare Compare main window and you click , the Change Summary window is hidden 
with just a tab displayed on the left side. By hovering over this tab, the Change Summary window is displayed 
again and you can work in it as required. Once you click elsewhere, for example in the Redline document, then 
the Change Summary window is automatically hidden again.

To turn off auto-hide, click .
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Quick Access Toolbar

The Quick Access Toolbar provides one-click access to functionality available in the Home, Review and View 
Ribbons. By default, the New, Open, Save and Save As buttons are included in the Quick Access Toolbar. By 
clicking the arrow to the right of the Quick Access Toolbar, you can customize the Quick Access Toolbar as 
follows:

Select/deselect the New, Open, Save or Save As options to 
display/hide these options in the Quick Access Toolbar.

Select More Commands to add additional options to the Quick 
Access Toolbar.

Select Show Below the Ribbon to display the Quick Access 
Toolbar below the main toolbar.

Select Minimize the Ribbon to hide the details of the Ribbon until 
you click the Home, Review or View tabs.

Logo Menu

Clicking the Workshare Compare logo displays a menu with the following options:

Option Description

New Opens the Document Selection dialog enabling you to perform a new 
document comparison. Refer to Performing Comparisons.

Open Enables you to open a saved document comparison. Comparisons are 
saved as Workshare DeltaFiles (.WDF).

Save Enables you to save the current document comparison. Refer to Saving 
Redline Documents.

Save As Includes the following sub-options:

Save As Comparison 
document

Enables you to save a Redline document as a WDF, DOC, DOCX, TXT, 
RTF, HTM or PDF file. Refer to Saving Redline Documents.

Save As Track Change
document

Enables you to save a Redline document as a DOCX document with the 
changes shown as track changes. Refer to Saving Redline as Track 
Change Document.
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Option Description

Manage Changes Enables you to import the modified document into the original document 
and then accept or reject the changes proposed by the modified 
document as required. Refer to Overview - Managing Responses for 
further information.

Print Enables you to print the Redline document and includes the following 
sub-options:

Print Original Enables you to print the original source document. Refer to Printing 
Redline Documents.

Print Modified Enables you to print the modified source document. Refer to Printing 
Redline Documents.

Print Comparison Enables you to print the Redline document. Refer to Printing Redline 
Documents.

Print Preview Enables you to preview the print output and includes the following sub-
options:

Preview Original Enables you to preview the original source document.

Preview Modified Enables you to preview the modified source document.

Preview Comparison Enables you to preview the Redline document.

Email Includes the following sub-options:

Send as Comparison 
document

Enables you to send the current documents (the original, the modified 
and the Redline) as email attachments. Refer to Sending Compared 
Documents by Email.

Send as Track Change
document

Enables you to send the Redline document as an RTF document with 
the changes shown as track changes. Refer to Sending Compared 
Documents by Email.

Configuration Manager Opens the Workshare Configuration Manager where, if you have 
permission, you can configure system parameters. Refer to Introducing 
the Workshare Configuration Manager for further information.

Properties Enables you to specify general information about the document 
comparison, such as title and author. The Document Properties dialog
includes no properties information from the original or modified 
documents.

About Workshare Compare Displays version information about Workshare Compare.

Close Closes the currently displayed Redline document.

Clicking the Exit button on the bottom right of the Logo menu closes the Workshare Compare application. You 
are prompted to save any open Redline documents.
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Redline Tabs

When the original document has been compared against multiple modified documents, each resulting Redline 
document is displayed in a different tab. Select the tab header to display the comparison in the Workshare 
Compare window. You can also display the tabs side by side by clicking and dragging the tab header across the 
Workshare Compare window.

Redline Document

The Redline document shows the results of the comparison between the original document and the modified 
document. Changes are marked according to the rendering set applied to the comparison. For example, deleted 
text could be red and struck through and added text could be blue and underlined.

You can navigate between the changes in the Redline document and edit the Redline document to take account 
of changes, if required. You can also save and print the Redline document as well as send it by email. All of these 
options are described in Working with Redline Documents.

Redline Document Right-Click Menu

Right-clicking text or changes in the Redline document displays a popup menu, providing rapid access to some 
of the more commonly used tools.

Option Description

Copy Copies selected text to the clipboard.

Select All Selects all the content of the Redline document.

Find Opens the Find dialog enabling you to search for specified text or keywords in the 
Redline document. 

Find Next When you have specified text or a keyword in the Find dialog, navigates to the next 
occurrence of the specified search text or keyword in the Redline document. 

Edit Redline Opens the Redline document in Microsoft Word as an RTF file. You can then edit the 
Redline document as required. Refer to Editing Redline Documents.

Convert to Track 
Changes

Enables you to implement changes shown in the Redline document using track 
changes functionality. Refer to Converting to Track Changes.

Zoom Enables you to change the display of the Redline document from 20% to 200% of its 
original size. 

Link to Move When text has been moved to another position, navigates and highlights the text in its 
new or previous position in the Redline document. 

When right-clicking text in its new position, clicking Link to Move highlights the text 
in its previous position.

When right-clicking text in its original position, clicking Link to Move highlights the 
text in its new position.

You must right-click a move-type change for this option to be available.
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Option Description

Link to Change Jumps to the Redline Summary (at the end of the Redline document) highlighting the 
selected change.

The Include Redline Summary option must be selected in the applied rendering set. 
Refer to Redline Options.

You must right-click a change for this option to be available. 

Redline Comparison Summary

At the beginning or end of the Redline document, you can see a summary of the comparison and a list of the 
changes found. 

In order for the Redline document to include this summary, ensure that Include Redline Comparison Summary
is selected in the Redline Options category of the Rendering Sets Manager. Refer to Redline Options.
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Home Tab

The Home Ribbon enables you to print Redline documents, open saved Redline documents, as well as initiate 
new comparisons.

The options are described in the following table.

Group Option Description

Actions New Opens the Document Selection dialog enabling you to perform a new 
document comparison. Refer to Performing Comparisons.

Open Enables you to open a saved document comparison. Comparisons 
are saved as Workshare DeltaFiles (.WDF).

PDF Convert to PDF: Enables you to convert the Redline document to 
PDF or PDF/A. 

Convert to PDF and Email: Enables you to convert the Redline 
document to PDF or PDF/A and send as an email attachment. 

Refer to Converting Redline to PDF.

Print Enables you to print the Redline document.

Print Original: Enables you to print the original document. 

Print Modified: Enables you to print the modified document. 

Print Comparison: Enables you to print the Redline document. 

Refer to Printing Redline Documents.

Clipboard Copy Copies selected text to the clipboard.

Select All Selects all the content of the original or modified document.

Search Find Opens the Find dialog enabling you to search for specified text or 
keywords in the original or modified document.

Comparison Comparison Mode Enables you to select a comparison mode from the dropdown list 
and Workshare Compare automatically re-runs the comparison in 
the selected mode – Standard, Text Only, Fast or Compare 
without OCR. For more information about the types of comparison, 
refer to Overview - Comparing Documents Using Workshare 
Compare.

Swap Swaps the original and modified documents. Refer to Swapping the 
Source Documents.

Review Manage Changes Enables you to import the modified document into the original 
document and then accept or reject the changes proposed by the 
modified document as required. Refer to Overview - Managing 
Responses for further information.
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Group Option Description

Show/Hide Change Summary Displays/hides the Change Summary window. Refer to Change 
Summary Window.

Comparison 
Documents

Enables you to select what to display in the Workshare Compare 
main window.

All Documents: Displays the source documents and the Redline 
document. 

Original: Displays the original document in the Source Documents 
window. 

Modified: Displays the modified document in the Source 
Documents window.

Redline Only: Hides the Source Documents window and displays 
the Redline document only. 

Refer to Source Documents Window.

Rendering
Sets

Select Enables you to select a different rendering set from the dropdown 
list and Workshare Compare automatically re-runs the comparison 
applying the selected rendering set. Refer to Introducing Rendering 
Sets.

Edit Opens the Rendering Sets Manager where you can apply different 
rendering sets to a comparison and, if you have permission, you can 
add, edit and delete rendering sets. Refer to Introducing Rendering 
Sets.

Info Help Provides access to online help.

About: Displays version and copyright information about Workshare 
Compare. 

Keyboard Shortcuts: Displays a list of keyboard shortcuts available 
in Workshare Compare.

License: Displays information about your Workshare Compare 
license. 

Help: Provides access to online help. 
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Review Tab

The Review Ribbon enables you to review and manage the changes as well as email a Redline document.

The options are described in the following table.

Group Option Description

Send Email Send as Comparison document: Enables you to send the current 
documents (the original, the modified and the Redline) as email 
attachments. 

Send as Track Changes document: Enables you to send the 
Redline document as an RTF document with the changes shown as 
track changes. 

Refer to Sending Compared Documents by Email.

Review Manage Changes Enables you to import the modified document into the original 
document and then accept or reject the changes proposed by the 
modified document as required. Refer to Overview - Managing 
Responses for further information.

Edit Redline Opens the Redline document in Microsoft Word as an RTF file. You 
can then edit the Redline document as required. Refer to Editing 
Redline Documents.

Convert to Track 
Change document

Enables you to implement changes shown in the Redline document 
using track changes functionality. Refer to Converting to Track 
Changes.

Navigation Previous Navigates to the previous change and highlights the entire change 
in the Redline document. Refer to Navigating Between Changes.

Next Navigates to the next change and highlights the entire change in 
the Redline document. Refer to Navigating Between Changes.

First Navigates to the first change and highlights the entire change in 
the Redline document. Refer to Navigating Between Changes.

Last Navigates to the last change and highlights the entire change in 
the Redline document. Refer to Navigating Between Changes.

Specific Enables you to navigate to a specific change number. The entire 
change is highlighted in the Redline document. Refer to Navigating 
to a Specific Change Number.
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View Tab

The View Ribbon enables you to display the source documents and a summary of the changes as well as edit 
rendering sets.

The options are described in the following table.

Group Option Description

Rendering
Sets

Select Enables you to select a different rendering set from the dropdown 
list and Workshare Compare automatically re-runs the comparison 
applying the selected rendering set. Refer to Introducing Rendering 
Sets.

Edit Opens the Rendering Sets Manager where you can apply different 
rendering sets to a comparison and, if you have permission, you can 
add, edit and delete rendering sets. Refer to Introducing Rendering 
Sets.

Comparison Swap Swaps the original and modified documents. Refer to Swapping the 
Source Documents.

Show/Hide Change Summary Displays/hides the Change Summary window. Refer to Change 
Summary Window.

Comparison 
Documents

Enables you to select what to display in the Workshare Compare 
main window.

All Documents: Displays the source documents and the Redline 
document. 

Original: Displays the original document in the Source Documents 
window. 

Modified: Displays the modified document in the Source Documents 
window.

Redline Only: Hides the Source Documents window and displays 
the Redline document only. 

Refer to Source Documents Window.

Zoom Zoom Enables you to change the display of the Redline, original or modified 
document from 20% to 200% of its original size.

Interface Classic View Switches to the Classic interface of Workshare Compare where 
options are displayed either within menus or on a toolbar.

Windows Close All Closes all open Redline documents.
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Change Summary Window

From the Home Ribbon or View Ribbon, you can select to display the Change Summary window.

Changes tab, Category View Changes tab, List View

Changes tab, Status View Search tab
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Selecting a change in the Change Summary window highlights the change in the Redline document and displays 
the position of the change in both the source documents.

You can hide/display the Change Summary window by clicking Change Summary in the View Ribbon.

Tip! The Change Summary window is by default positioned down the left side of the Workshare Compare 
environment. It can be moved as required. Refer to Moving and Placing Windows.

You can right-click a change and select a status for that change. Refer to Reviewing Changes.

Changes Tab Category View

The Changes tab, Category View of the Change Summary window displays all the changes between the original 
document and the modified document according to the type of change. The changes can be grouped into any of 
the following categories:

 Numbering Changes: Any changes to numbering lists identified in a document.

 Whitespace Changes: Changes that only involve whitespace – ie deletion/insertion of spaces or tabs, 
or a space changing to a tab or 3 spaces changing to tabs.

 Capitalization Changes: Any changes to the capitalization of a word.

 Punctuation Changes: Any changes to a punctuation mark.
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 Spelling Corrections: Changes where a single word replacement includes the deletion of a word that is 
not a dictionary word and the insertion of a dictionary word in its place. The replacement word must 
also be a spell check suggestion for the replaced word – for instance replacing ‘recieve’ with ‘receive’.

 Word Variations: Changes which involve changing the form a word ie replacing ‘confirms’ with 
‘confirmed’ – the two words (original and replacement) must come from the same stem word and just 
have different endings. This relies on a dictionary as well – refer to document above on instructions on 
how this can be customized.

 Matching Changes: Changes that are repeated and identical.

 Suggested Changes: Changes that a reviewer could have neglected to make. For example, there are 
400 instances of “ACME INC” in the original document but the reviewer has only changed 399 of these 
to “Workshare Inc”. The Missed Changes category will indicate that there is 1 change that might have 
been missed.

 Style Changes: Style changes in a document.

 Font Changes: Changes made to font type, font style, font colour, underline style, underline color and 
font effects.

 Footnote Changes: Any changes in the footnote of a document.

 Endnote Changes: Any changes in the endnote of a document.

 Header Changes: Any changes in the header of a document.

 Footer Changes: Any changes in the footer of a document.

 Placeholder Changes: The change summary shows items for blocks of placeholder text that are found 
to be matching between the original and modified documents. While these are not changes between 
the two documents as such, they highlight areas where the editing of the document may be 
incomplete. Typical blocks of placeholder text might be ‘[Client Name]’, ‘[Company Address]’ etc.

 Boilerplate Changes: Changes that occur inside blocks of boilerplate text in a special ‘Boilerplate 
Changes’ section. These changes merit special attention as in general boilerplate text should not be 
modified. Note that the change is only marked as a boilerplate change if it is found inside an occurrence 
of one of the boilerplate text items in the original document.

 Uncategorized Changes: Changes that do not fall into any of the above groups.



COMPARING DOCUMENTS USING WORKSHARE COMPARE

102

Changes Tab List View

The Changes tab, List View of the Change Summary window displays all the changes between the original 
document and the modified document in the order that they occur.

The following information is shown for each change in List View of the Change Summary window:

# The number of the change in the document. A change may have two numbers when it 
includes two actions. For example, a deletion and an addition.

Page, Line The page number and the line number in the original document where the change occurs.

Change Text Details of the change. 
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Changes Tab Status View

The Changes tab, Status View of the Change Summary window displays all the changes between the original 
document and the modified document according to their status – Agreed, Disagreed, Flagged and Not Reviewed.
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Search Tab

The Search tab enables you to search for changes in the Redline document that include a specific keyword or 
text. Refer to Searching for Changes.
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Source Documents Window

From the Home Ribbon or View Ribbon, you can select to display the Source Documents window. You can select 
(from the Comparison Documents option) to display the original document, the modified document or both 
documents in the Source Documents window..

The Source Documents window can display the original document and the modified document. You can scroll 
through both documents as required. Selecting a point in one source document automatically scrolls the other 
source document as well as the Redline document to the same point. The source documents are read-only and 
cannot be modified in any way. The name of the source document is shown above the document.

Tip! The Source Documents window is by default positioned across the top of the Workshare Compare 
environment. It can be moved as required. Refer to Moving and Placing Windows.

Right-clicking text in the original document or the modified document displays a popup menu, providing rapid 
access to some of the more commonly used tools.

Option Description

Copy Copies selected text to the clipboard.

Select All Selects all the content of the original or modified document.

Find Opens the Find dialog enabling you to search for specified text or keywords in the 
original or modified document.

Find Next When you have specified text or a keyword in the Find dialog, navigates to the next 
occurrence of the specified search text or keyword in the original or modified 
document.

Convert to Track
Changes

Enables you to implement changes shown in the Redline document using track 
changes functionality. Refer to Converting to Track Changes.

Zoom Enables you to change the display of the original or modified document from 20% to 
200% of its original size. 
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Working with Redline Documents
This section describes the tools available to you when working with the compared (Redline) document after a 
comparison.

Navigating Changes

After performing a comparison, you can review the Redline document (the result of the comparison) and 
consider the changes between the original and modified documents. You can move between changes in the 
Redline document by jumping from change to change or searching for a specific change using change numbers 
or keywords.

Navigating Between Changes

Selecting a change in the Change Summary window highlights the change in the Redline document and displays 
the position of the change in both of the source documents.

Click Previous in the Review Ribbon to move to the previous change and highlight the entire change in the 
Redline document. Click First to move to the first change in the Redline document.

Click Next in the Review Ribbon to move to the next change and highlight the entire change in the Redline 
document. Click Last to move to the last change in the Redline document.
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Navigating to a Specific Change Number

Changes are allocated numbers, which are displayed next to the change in the Change Summary window. A 
change may have two numbers when it includes two actions, for example, a deletion and an addition. You can 
move to a specific change number in the Redline document.

To navigate to a specific change number:

1. Click Specific in the Review Ribbon. The following dialog is displayed:

2. In the Change Number field, enter the number of the change you want to display in the Redline 
document.

3. Click Go To. The entire change is highlighted in the Redline document.

4. Repeat steps 2 and 3 to navigate to further changes as required.

5. Click Close to close the dialog.

Tip! To maximize this feature, apply a rendering set with the Show Change Numbering parameter selected 
in the Redline Rendering category, Change Numbering section. Refer to Change Numbering. This shows all 

the change numbers against each change in the Redline document, for example, .
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Searching for Changes

You can search for changes in the Redline document that include a specified keyword or text. Workshare 
Compare can search only the changes for the specified text or it can search the text of the original or modified 
documents.

To search for a change:

1. In the Change Summary window, select the Search tab or click Find in the Home Ribbon.

2. In the text box, enter the search criteria – the word or words for which you want to search.

3. If the case is not important, select the Ignore Case checkbox.

4. Select where you want to search from the dropdown list. The options are as follows:

 Search changed text only: Searches through all text in the Redline document that has been 
changed.

 Search text near a change: Searches through all text in the Redline document within a close 
proximity to a change.

 Search Original Document text: Searches through all text in the Original Document.

 Search Modified Document text: Searches through all text in the Modified Document.

 Search all Redline text: Searches through all text in the Redline document.
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5. Click Search. A list of changes that include the specified word or words is displayed in the lower text 
area.

Selecting a change in the search results highlights the change in the Redline document and displays the position 
of the change in both the source documents.

Reviewing Changes

You can go through the changes in the Redline document and mark them to indicate whether you agree with the 
change. This is useful if someone else will implement the changes to your document and you want to indicate 
which ones you agree with and which ones you want to ignore. Once you have reviewed the changes, you can 
save the Redline as a WDF file and send it to the person who will implement the changes.

To review changes:

1. In the Change Summary window, right-click a change. The following menu is displayed:
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2. Select the required status for the change.

 Agree: You agree with the proposed change. A green tick is displayed next to the change in the 
Change Summary window.

 Disagree: You do not agree with the proposed change. A red cross is displayed next to the change 
in the Change Summary window.

 Flag: You want to highlight the change – perhaps for future consideration or to check sources. A 
flag is displayed next to the change in the Change Summary window.

 Mark as Read: You want to indicate that you have reviewed the change but do not want to give it a 
status.

3. If you want to change a status, select Reset from the right-click menu and the status is removed from 
the change.

Note: To reset a changed marked as read, select Mark as Unread from the right-click menu.

When you have completed your review, save the Redline document as a WDF file.

Note: If you review the changes and modify the status of a change, for example, to “Flag” or “Agree”, these 
status changes are only saved when you save the Redline as a WDF file. If you save the Redline in another 
format, the status changes will be lost. 

Swapping the Source Documents

You can re-run a comparison exchanging the original document for the modified document and the modified 
document for the original document. For example, if you selected Document A as the original document and 
Document B as the modified document, Workshare Compare compares Document A to Document B and 
presents the changes made to Document A. You can then swap the original and modified documents so that 
Document B is now the original document and Document A is the modified document. Workshare Compare 
automatically re-runs the comparison, comparing Document B to Document A, and presents the changes made 
to Document B.

To swap the source documents:

Click Swap in the Home Ribbon or View Ribbon to swap the source documents. Workshare Compare 
automatically runs a new comparison, using the modified document as the original document and the original 
document as the modified document. The new Redline document is displayed in the same tab replacing the first 
comparison.

Editing Redline Documents

In order to edit the Redline document, you can open it in Microsoft Word and use all standard Microsoft Word 
functionality to edit the document as required. 

To edit the Redline document:

1. Click Edit Redline in the Review Ribbon or right-click in the Redline document and select Edit Redline.
The Redline document is opened in Microsoft Word as a DOC/DOCX file with the default name 
Redline.doc/docx. All the changes are displayed.
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2. Edit the Redline document as required.

3. Click Save to save the document. By default, Redline.doc/docx is saved in a temporary folder. 

If you re-compare the original and modified documents, any changes made to the Redline document are lost. In 
order to save any changes made to the Redline document, you must save it.

Changing the Comparison

You can re-run a comparison using a different comparison mode or applying a different rendering set or changing 
specific comparison options.

Changing the Comparison Mode

You can re-run a comparison using a different comparison mode (or type) if required.

To re-run a comparison using a different mode:

From the Comparison Mode dropdown list in the Home Ribbon, select the required mode from the following:

 Standard: Workshare Compare performs a regular comparison.

 Fast: When comparing a .DOC file against another .DOC file, Workshare Compare performs a binary 
comparison which is faster than a standard comparison because it is comparison at the binary level.

When comparing a .DOCX file against another .DOCX file, Workshare Compare performs a faster 
comparison by converting the documents to DOC followed by comparison at the binary level.

Notes:
The Fast option is only available for DOC files if the Enable fast comparison for DOC files parameter
(Comparison > Administration category) in the Workshare Configuration Manager is selected.

The Fast option is only available for DOCX files if the Enable fast comparison for DOCX files
parameter (Comparison > Administration category) in the Workshare Configuration Manager is 
selected.

 Text Only: Workshare Compare performs a text-only comparison, comparing only the text in a 
document and not the formatting or styles.

 Compare without OCR: Workshare Compare performs without first performing OCR. With image-based 
PDF files, Workshare Compare will first apply OCR (Optical Character Recognition) processing to 
translate the images of typewritten text into editable text in order to compare. If you do NOT want 
Workshare Compare to perform OCR, select this option.

Workshare Compare re-runs the comparison using the selected mode and displays the resulting Redline 
document in the Workshare Compare main window.
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Applying a Different Rendering Set

You can re-run a comparison using a different rendering set.

To re-run a comparison with a different rendering set:

1. Click Select in the Home or View Ribbon. A list of the currently defined rendering sets is displayed.

2. Select the rendering set to apply.

Workshare Compare re-runs the comparison using the selected rendering set and displays the resulting Redline 
document in the Workshare Compare main window.
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Changing the Comparison Options

You can re-run a comparison changing specific comparison options.

To re-run a comparison with different options:

1. Click Edit in the Home or View Ribbon. The Rendering Sets Manager is displayed.

2. Edit the rendering set parameters as required. For example, select the Ignore Tables checkbox. 
Rendering set parameters are described in Rendering Set Parameters.

3. Do one of the following:

 Click Apply. Workshare Compare re-runs the comparison using the selected parameters and 
displays the resulting Redline document in the Workshare Compare main window. Click OK to close 
the Rendering Sets Manager. Any changes you made to the rendering set parameters are lost.
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 Click OK. The following dialog is displayed:

Enter the name of an existing rendering set to overwrite a rendering set or enter a new name to 
create a new rendering set. Do not use the following characters when naming rendering sets: <, >, 
:, \, “, /, \\ or |. Click Yes. Workshare Compare re-runs the comparison using the revised options
and saves the revised options as the specified rendering set. Click No. Workshare Compare re-runs
the comparison using the revised options and saves the revised options as a temporary rendering 
set called “Custom rendering set”. 

Note: The “Custom rendering set” will be selected in the Rendering Set dropdown list the next time the 
Rendering Sets Manager is opened. However, once you navigate away from the “Custom rendering set” and a 
different rendering set is selected and the Rendering Sets Manager is closed, the “Custom rendering set” is 
lost.

Converting to Track Changes

If required you can implement the changes shown in the Redline document using Microsoft Word’s track 
changes functionality. The Redline document can be opened in Microsoft Word and the insertions and deletions 
shown in the Redline document are converted into track changes which can then be reviewed and implemented 
as required.

Note: The Converting to Track Changes functionality is only enabled, if the Enable ‘Convert to Track Change 
document’ parameter (Comparison > User Interface category) in the Workshare Configuration Manager is 
selected.

To convert to track changes:

1. Click Convert to Track Change document in the Review Ribbon or right-click in the Redline document 
and select Convert to Track Changes. The Redline document is opened in Microsoft Word as a
DOC/DOCX file with the default name TrackChange_Redline.doc/docx. All the changes are displayed as 
track changes.

2. Review the track changes and implement them as required.

3. Save the document. By default, TrackChange_Redline.doc/docx is saved in a temporary folder. You can 
also use Save As to save the modified Redline document as a Microsoft Word file (or other format) and 
in a different location, as required.
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Importing Changes into the Original Document

You can import the changes detailed in the Redline document into the original document.

Click Manage Changes in the Home or Review Ribbon or select Manage Changes from the Logo menu. The 
changes detailed in the Redline document are imported into the original document. The original document and 
the Manage Changes page of the Workshare Panel are displayed. You can then select to incorporate the changes 
into the original document as required. Refer to Overview - Managing Responses for further information.

Sending Compared Documents by Email

Workshare Compare integrates with your email system. You can send the Redline document as well as the 
original and modified documents as email attachments. You can also send the Redline document as a Microsoft 
Word file that shows the changes as track changes. This is useful if the recipient does not have Workshare 
Compare.

To send Redline documents by email:

1. Click Email then Send as Comparison document in the Review Ribbon or select Email then Send as 
Comparison document from the Logo menu. The Email Comparison Documents dialog is displayed.

2. Select the files to send by selecting one of the following options:

 Individual documents included in this comparison

Selecting this option displays a list of the documents included in the comparison in the lower pane. 
Select the checkboxes to the left of the documents you want to send.
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Note: The original and modified documents are sent in Microsoft Word format and the Redline 
document is sent by default as a PDF. Click in the Document Format field of the Redline document to 
change the default format, for example, to RTF.

 Workshare Compare’s internal file format (DeltaFile)

Selecting this option sends the compared documents as a DeltaFile. A DeltaFile contains the Redline 
document and a reference to the original and modified documents in the DMS. A DeltaFile can only 
be opened in Workshare Compare. The file extension for a DeltaFile is WDF.

Tip! Click in the Document Name field to change the name of the Redline document.

3. Click OK. An email message window is displayed with the selected files as attachments.

4. Enter the recipient(s) name and any other text you want to include and click Send.
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To send Redline documents with changes as track changes:

1. Click Email then Send as Track Changes document in the Review Ribbon or select Email then Send
as Track Changes document from the Logo menu. The Redline document is saved as a Microsoft 
Word document with the changes indicated by track changes and an email message window is 
displayed with the Microsoft Word file as an attachment.

2. Enter the recipient(s) name and any other text you want to include and click Send.

When the recipient opens the file in Microsoft Word, the changes are displayed as track changes.
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Printing Redline Documents

You can print the Redline document as well as either of the source documents.

To print the comparison documents:

1. In the Home Ribbon or the from the Logo menu, click Print and then Print Original, Print Modified or 
Print Comparison. The Print dialog is displayed.

2. Select from the standard print options in the usual way.

The following two options are only available when selecting Print Comparison.

3. If you selected Print Comparison, and you are printing to a black and white printer, select the Print 
Redline in black and white checkbox, as color text may not appear clearly when printing in black and 
white.

4. If you selected Print Comparison, and you only want to print pages of the Redline document that 
include changes, select the Only print pages with changes checkbox.

5. Click OK.

Note: You can preview the printed version of the Redline, original or modified document using the Print
Preview options in the Logo menu.
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Converting Redline to PDF

You can convert the Redline document to PDF and save it locally or in your DMS or you can convert to PDF and 
email.

To convert a Redline document to PDF:

1. In the Home Ribbon, click PDF and then Convert to PDF. The Convert to PDF dialog is displayed.

Note: This dialog displays slightly differently depending on whether you are working with a document 
saved in your DMS/CRM.

2. Select whether you want to convert the Redline to PDF or PDF/A.
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3. If required, click Configure PDF security to set PDF security options as well as metadata cleaning 
options. The following dialog is displayed.

4. If you selected PDF, you can select one or more of the security options as required:

 Prevent printing: Prevents recipients from printing the PDF document.

 Prevent editing of text: Prevents recipients with Adobe Distiller from editing the PDF document.

 Prevent the copying of text and/or graphics: Prevents recipients from copying graphics or text 
directly from the PDF document.

 Prevent comments being added: Prevents recipients with Adobe Distiller from adding comments 
to the PDF document.



COMPARING DOCUMENTS USING WORKSHARE COMPARE

121

5. If you selected PDF or PDF/A, click Cleaning Options to specify what metadata to remove before 
converting the Redline to PDF.

6. Select metadata elements as required. For a full description of all the metadata elements, refer to 
Cleaning Hidden Data, for further information.

7. Click OK.

8. If you selected PDF, you can set a password to protect the PDF by entering the password twice in the 
Password protection area. When a password is specified, the recipient can only open the PDF after 
entering this password.

9. Click Apply.

10. In the Convert to PDF dialog, when working with a DMS, select whether to save the PDF as a new 
document or as a related document or locally.

11. If you want to create a PDF of part of the Redline document only, select the Pages radio button and 
specify a page range. 

Note: You can also PDF individual pages by specifying the pages (separated by commas) in the Pages
field.

12. If required, click Preview to view the document as a PDF.

13. Select the Open PDF once created checkbox, and the PDF is opened once it has been created.
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14. Select the Email PDF as an attachment checkbox, and the PDF is attached to a new email message 
once it has been created.

15. Click Create. The Save as dialog is displayed:

16. Specify the name and location for the PDF file and click Save. The Redline document is converted to 
PDF.
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Converting Redline to PDF and Sending by Email

You can convert the Redline document to PDF and send it by email.

To convert a Redline to PDF and send by email:

1. In the Home Ribbon, click PDF and then Convert to PDF and Email. The Convert to PDF dialog is 
displayed.

2. Follow the procedure to convert a Redline document to PDF as described in steps 2 to 13 of the 
Converting Redline to PDF section.

After specifying a save location and clicking Save, an email message window is displayed with a PDF 
of the Redline document as an attachment.

3. Enter the recipient(s) name and any other text you want to include and click Send. The PDF document 
is sent to the specified recipients.
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Saving Redline Documents

You can save the comparison as a Workshare Compare DeltaFile (.WDF), which contains all three documents 
(original, modified and Redline). You can also save just the Redline document as a DOC/DOCX, RTF, HTM, TXT or 
PDF file or you can save the Redline document as a track change document.

You can save the Redline document to your DMS/CRM, SharePoint or locally. The following procedure describes 
how to save to NetDocuments as an example.

To save the Redline document:

1. Click Save in the Quick Access Toolbar or select Save from the Logo menu. The Save to NetDocuments
dialog is displayed.

Note: If you are not working with a DMS or SharePoint, the LocalStore Save As dialog is displayed or 
if you click Cancel in this dialog, a message is displayed asking if you would like to save the Redline 
document locally.

Tip! If you are working with a DMS or SharePoint but both documents compared are local documents, 
then you can press the Shift key while clicking Save and the LocalStore Save As dialog is displayed.

2. Browse to the location where you want to save the comparison and modify the name of the comparison 
as required.
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3. From the Save As Type dropdown list, select the format for the saved file from the following:

Workshare DeltaFile (*.wdf) Saves both the Redline document and the source documents as a 
Workshare DeltaFile. This file can only be opened in Workshare 
Compare.

Word Document 
(*.doc/*.docx)

Saves the Redline document as a Microsoft Word file. The source 
documents are not saved.

Text Only (*.txt) Saves the Redline document as a text file. The source documents are 
not saved.

Rich Text Format (*.rtf) Saves the Redline document as an RTF file. The source documents 
are not saved.

HTML Document (*.htm) Saves the Redline document as a HTML document. The source 
documents are not saved.

Adobe Acrobat File (*.pdf) Saves the Redline document as a PDF file. The source documents are 
not saved.

Adobe Acrobat PDF/A File 
(*.pdf)

Saves the Redline document as a PDF/A file. The source documents 
are not saved.

4. Click Save.

Saving Redline as Track Change Document

You can also save the Redline document as a Microsoft Word file that shows the changes as track changes.

To save Redline documents with changes as track changes:

1. From the Logo menu, click Save As then Save As Track Change document.

2. In the Save dialog displayed, specify a name and save location for the track change document and click 
Save. The Redline document is saved as a Microsoft Word document with the changes indicated by 
track changes.

When you open the saved file in Microsoft Word, the changes are displayed as track changes.
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Opening Saved Workshare DeltaFiles

When a comparison has been saved as Workshare DeltaFile, you can open it from Workshare Compare.

To open a saved comparison:

1. Click Open in the Home Ribbon or select Open from the Logo menu. An Open dialog is displayed.

Note: Clicking Open when you work with a DMS/CRM or SharePoint accesses the DMS/CRM or 
SharePoint. To open from a local or network drive, hold the Shift key down when clicking Open or click
Cancel in the DMS/CRM or SharePoint open dialog.

2. Navigate to the location where the comparison is saved and select the WDF file you want to open.

3. Click Open. The selected comparison is opened in Workshare Compare. The source documents and the 
Redline document are displayed.
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Alert and Compare - Generating Redlines from Outlook
Alert and Compare is the ability of Workshare Compare to automatically detect that a received attachment is a 
changed version of an original document sent previously. 

When a user sends a document to a recipient and the recipient edits the document and sends it back to the user, 
Workshare Compare can automatically detect that the received attachment is a changed version of the original 
document. The user can then launch a comparison of the two documents from Microsoft Outlook and view the 
Redline document in Workshare Compare. 

An email is flagged by displaying “Attachment(s) Modified” in the Categories column and a green bar across the 
top of the email in the Reading Pane. You can quickly see that the email includes an attachment that you have 
previously sent out and that has now been modified.
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When you open an email that has been flagged, the green bar is shown across the top of the message window.

To view a comparison between the document you sent out and the document attached to this email, click the 
arrow to expand the Workshare view section at the bottom of the email window.

The list shows the attachment(s) that are modified versions of a document you have previously sent out and also 
shows if the name of the original document has been changed.

Double-click an attachment. Workshare Compare is launched and a comparison is run using the document you 
sent out previously as the original document and the attachment to the open email as the modified document. All 
changes can be seen in the Redline document and the Change Summary window.
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Comparing an Attachment 
When you receive an email with a Microsoft Word attachment, Workshare Compare enables you to compare the 
attachment with any document on your local file system, SharePoint or DMS. This feature can be used to 
compare the attached file with a previous version or another document on your computer.

To compare an attachment from Microsoft Outlook:

Click the Attachments dropdown list that appears in the Workshare tab and select the attachment you want to 
compare.

The Document Selection dialog is displayed with the selected attachment in the Original Document field. Select 
the files to compare it against as described in Performing Comparisons.



MANAGING CONTENT RISK IN DOCUMENTS

130

Chapter 8. Managing Content Risk in 
Documents
This chapter describes how to view the content risk in documents as well as remove selected content risk from 
a document. It includes the following sections:

 Overview, below, introduces the ways in which Workshare Protect enables you to protect documents 
by viewing and removing sensitive content risk.

 Displaying Content Risk in Microsoft Word, page 130, describes how to discover all content risk in a 
Microsoft Word document.

 Displaying Content Risk in Microsoft Excel and PowerPoint, page 132, describes how to discover all 
content risk in a Microsoft Excel or PowerPoint document.

 Cleaning Hidden Data, page 133, describes how to remove selected types of hidden data from a 
document and from multiple documents.

 Manual Redaction, page 142, describes how to manually redact selected words or other content.

Overview – Managing Content Risk in Documents
Workshare Protect provides comprehensive content risk protection enabling the discovery and removal of hidden 
sensitive data as well visible sensitive data. Hidden sensitive data may include information such as track 
changes, author’s name, server names, keywords, routing slips and authoring trails. 

Workshare Protect enables the discovery of content risk in the following ways:

 Content Risk Reports: Workshare Protect integrates with Microsoft Office providing an option to 
display a comprehensive report of all the content risk in a document while it is open in Microsoft Word, 
Excel and PowerPoint. Content risk is displayed according to its risk level (high, medium, low).

 Email Protection: Workshare Protect prevents users from accidentally emailing confidential information 
by alerting users before the email is sent when an email or its attachment breaches security policies. 
Refer to Overview – Protecting Email Attachments.

In addition, Workshare Protect provides manual redaction functionality which enables you to redact selected 
words or sentences or other content as required.

Displaying Content Risk in Microsoft Word
Workshare Protect integrates with Microsoft Word to provide an option to discover and view content risk in a 
document. You can also display a comprehensive report of all the content risk in a document.

To discover content risk in your Microsoft Word document: 

1. Open your document in Microsoft Word and click Content Risk, (Protect group) in the Workshare tab
or click Content Risk in the Home page of the Workshare Panel.
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Note: You can also click Content Risk from other pages in the Workshare Panel.

Workshare Protect checks the document for content risk. This process may take a few moments if your 
document is large or if it contains large amounts of content risk. Once the discovery process is 
complete, the Content Risk page of the Workshare Panel is displayed showing a summary of the 
content risk found.

The content risk found is divided into high risk, medium risk and low risk.

2. To display details of the content risk found, click to the left of the content risk type.

3. To remove hidden data from the document, use the Remove button. Refer to Cleaning Hidden Data, for 
more details.

Note: You can click Report to create a risk report that provides a full account of the different types of content 
risk in a document.
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Displaying Content Risk in Microsoft Excel and 
PowerPoint
Workshare Protect integrates with Microsoft Excel and PowerPoint to provide an option to discover and view 
content risk in a document. The content risk is displayed in a comprehensive report.

To discover content risk in your Microsoft Excel or PowerPoint document: 

1. Open your document in Microsoft Excel or PowerPoint and click Content Risk, (Protect group) in the 
Workshare tab, or click Content Risk in the Home page of the Workshare Panel.

Workshare Protect checks the document for content risk. This process may take a few moments if your 
document is large or if it contains large amounts of content risk. Once the discovery process is 
complete, the Document Risk Report is displayed showing the details of the content risk found:

The content risk found is divided into high risk, medium risk and low risk.

2. To print the report, click Print.

3. To remove the hidden data from the Microsoft Excel or PowerPoint document, click Remove. Refer to 
Cleaning Hidden Data for further information.
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Cleaning Hidden Data
In Microsoft Office documents, once you have discovered the content risk in a document, you can remove 
selected types of hidden data as required. If you want to remove hidden data from PDF files or from multiple 
Microsoft Office documents, you can use the Workshare Batch Clean tool. Refer to Batch Cleaning.

To remove hidden data: 

1. In Microsoft Word, click Remove in the Content Risk page. In Microsoft Excel or PowerPoint, click 
Remove in the Document Risk Report. The Advanced Options dialog is displayed.

A complete list of hidden data that can be removed, reset or converted is listed in the dialog. For a full 
description of the different options, refer to Cleaning Options.

2. Select the hidden data you want to remove by selecting the checkboxes to the left of the hidden data 
options.

3. After making your selection, click OK. The selected hidden data is removed from the document.
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Workshare Protect may take a few moments to clean you document depending on the size of the document and 
the amount of hidden data to be removed. The Content Risk page/Document Risk Report is updated after the 
document has been cleaned to show any remaining content risk. After cleaning, the document with hidden data 
removed is still stored in memory only. If you want to keep the cleaned document, you now have to save the 
document.

Batch Cleaning

If you want to remove the same types of hidden data from several documents, you can use the Workshare Batch 
Clean tool to clean multiple documents (up to 256) simultaneously.

To clean multiple documents:

1. From the Start menu, select Programs, Workshare, and then Workshare Batch Clean. The Batch 
Clean dialog is displayed.

Note: To view more document types, select All Office files from the Files of type dropdown list. If 
unsupported file types are selected for batch cleaning, they will be ignored.

2. Select the documents you want to clean. Press Ctrl or the Shift key to select multiple documents.

3. Click Open. The Batch Clean dialog is displayed.
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Tip! An alternative to steps 1, 2 and 3 is to select the documents in Windows Explorer, then right-click 
and select Send To then Batch Clean.

A complete list of hidden data that can be removed, reset or converted is listed in the dialog. For a full 
description of the different options, refer to Cleaning Options.

4. Select the hidden data you want to remove by selecting the checkboxes to the left of the hidden data 
options. All the selected files will be cleaned using the same options.

Tip! Select the Toggle on/off checkbox to select/deselect all the hidden data options.
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5. Select one of the following save options:

 Overwrite files after cleaning: Selecting this option will save the cleaned files over the original 
files, overwriting the existing version.

 Save files to new location after cleaning: Selecting this option will save the cleaned files to a 
different location, leaving the original files in their original location and in an uncleaned state. Click 
the browse button and select the new save location.

6. Click Clean. The selected files are cleaned according to your selection. Once the process is complete, a 
report is displayed indicating which files were cleaned successfully.

7. Click Finish.
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Batch Cleaning Using a Command Line

Batch cleaning can be performed using the command line.

To batch clean using the command line:

1. From the Start menu, select Run.

2. Enter cmd in the Open field and click OK.

3. Enter the clean command required. Samples are given below:

 To clean hidden data from the entire hard disk:

bc-console.exe “c:\” /s /all

 To clean all hidden data from a single document:

bc-console.exe “<filepath>” /all

where <filepath> is the full path to the document to clean.

 To exclude specific data from the cleaning (here comments and track changes are excluded):

Bc-console.exe “<filepath>” /all /exclude:comments /exclude:trackchanges

 To clean only specified data from the document (here comments and track changes are the data to 
clean):

Bc-console.exe “<filepath>” /include:comments /include:trackchanges

For a complete list of options, type the following command:

Bc-console.exe/
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The options are described in the following table:

Option Description

/All All hidden data is removed from the specified documents.

To leave specified types of hidden data in a document, the /All
command can be used in conjunction with the /Exclude command.

The /All command cannot be used in conjunction with the /Include
command.

/S Hidden data is removed from sub-folders of the specified folder.

/WriteToFolder:[folder] The cleaned file is saved to a specified location.

If this command is not included the original file is overwritten with the 
cleaned file.

Cleaned files saved using the /WriteToFolder command will have a 
flat file structure. If files have the same names, they will be appended 
with a number.

/Exclude:[optionname] Excludes specified types of hidden data from being removed. The 
/Exclude command is used in conjunction with the /All command.

The valid types of hidden data that can be excluded are detailed in the 
optionnames list.

/Include:[optionname] Specifies which types of hidden data are to be removed. The /Include
command is used instead of the /All command.

The /Include command cannot be used with the /All command or 
the /Exclude command.

The valid types of hidden data that can be specified are detailed in the 
optionnames list.

optionnames The valid types of hidden data that can be used with the /Exclude and 
/Include commands.

Footnotes, DocumentStatistics, BuiltInProperties, Headers, Footers, 
SmartTags, Template, Authors, CustomProperties, DocumentVariables, 
Fields, Macros, RoutingSlip, SpeakerNotes, Links, Reviewers, 
TrackChanges, Comments, SmallText, WhiteText, HiddenText, 
HiddenSlides, AutoVersion, Versions
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Cleaning Options

The different hidden data cleaning options that are selected when cleaning an individual document or when 
batch cleaning several documents are explained below:

Option Description

Accept changes and turn 
off Track Changes (Word 
and Excel)

Microsoft Word and Excel. Accepts all revisions made to the document. The 
revisions are therefore no longer displayed as revisions but rather as text in 
the document. Track changes is also turned off so that further revisions are 
not tracked.

Convert attached template 
to Normal (Word)

Microsoft Word only. Converts the attached template to normal.dot. 
Automatic style updating is disabled before the template is removed. 
Therefore the formatting and styles in your document will not be affected by 
removing the attached template.

To view the attached template: Click the File menu/Office Button, select 
Options/Word Options and then select Add-Ins. From the Manage dropdown 
list, select Word Add-ins and click Go.

Convert field codes to text
(Office)

Microsoft Word, Excel and PowerPoint. Converts any field codes that exist in 
a Microsoft Word document to text, for example, hyperlinks, table of 
contents, index. In Microsoft Excel and PowerPoint, hyperlinks are converted 
to text.

Note: For Microsoft Excel and PowerPoint, hyperlinks are the only field 
codes that exist.

This prevents the field codes from being updated after you have distributed 
the document. It also prevents errors for fields that reference built-in or 
custom properties that have been removed.

Note: You may want to remove some field codes but not others. For 
example, you may want to clean ‘Include text’ field codes, but retain the 
Table of Contents and Page Numbers. To do this you can specify the field 
codes you want to keep in the Protection > Exclude Metadata category
of the Workshare Configuration Manager, and then clean field codes as 
normal. See Workshare Configuration Options for more details.

To view field codes: Click the File menu/Office Button, select Options/Word 
Options and then select Advanced. Select the Show field codes instead of 
their values checkbox in the Show document content area.

Delete attachments (PDF) PDF. Removes attachments to a PDF file.

PDF attachments are separate files attached to a PDF. They are of two types:

 Attached to the PDF generally

 Linked to a specific point in a PDF file

Selecting this option will only remove the first type of attachment. 
Attachments linked to a specific point in a PDF file are treated as markups and 
will only be removed if the Delete markups parameter is selected.
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Option Description

Delete bookmarks (PDF) PDF. If selected, removes any bookmarks in a PDF file.

Delete built-in properties
(Office)

Microsoft Word, Excel and PowerPoint. Removes all summary properties -
author, category, comments, company, keywords, manager, title, subject, and 
hyperlink base; and custom properties – text, date and number.

To view built-in properties: In MS Office 2010/2013, click the File menu, select 
Info and then select Advanced Properties from the Properties dropdown list
in the right panel. In the Properties dialog, select the Summary and Contents
tabs. In MS Office 2007, click the Office Button, select Prepare and then 
select Properties. In the Document Information Panel, select Advanced 
Properties from the Document Properties dropdown list. In the Properties
dialog, select the Summary and Contents tabs.

Delete comments (Office) Microsoft Word, Excel and PowerPoint. Removes any comments embedded in 
the document.

To display comments: In MS Office 2010/2013, click the Review tab and from 
the Show Markup dropdown list (Tracking group), select Balloons then 
Show Only Comments and Formatting in Balloons. In MS Office 2007, click 
the Review tab and from the Balloons dropdown list (Tracking group), select 
Show Only Comments and Formatting in Balloons.

Delete custom properties
(Office)

Microsoft Word, Excel and PowerPoint. Removes any custom properties that
have been added to the document.

To view document properties: In MS Office 2010/2013, click the File menu, 
select Info and then select Advanced Properties from the Properties
dropdown list in the right panel. In the Properties dialog, select the Custom
tab. In MS Office 2007, click the Office Button, select Prepare and then select 
Properties. In the Document Information Panel, select Advanced Properties
from the Document Properties dropdown list. In the Properties dialog, select 
the Custom tab.

Delete document variables 
(Word)

Microsoft Word only. Deletes all document variables.

Document variables are values stored in Microsoft Word documents that are 
used by either field codes or macros. These variables may contain confidential 
information like company names or file locations. Even if field codes and 
macros are removed, the variables used may remain in the document.

Variables can be viewed in Microsoft Word in the Visual Basic Editor.

Delete hidden text (Word) Microsoft Word only. Removes all text that has been formatted as hidden.

To view hidden text: Click the File menu/Office Button, select Options/Word 
Options and then select Display. Select the Hidden Text checkbox.

Delete markups (PDF) PDF. If selected, removes any markup in a PDF file.

Markup is a tool used to make comments and annotations to PDF documents.
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Option Description

Delete properties (PDF) PDF. If selected, removes properties in a PDF file.

Standard properties are details about a file that help identify it, including its 
title, subject, author, manager, company, category, keywords, comments, and 
hyperlink base.

Note: Removing properties from a PDF/A file will disable its PDF/A status.

Delete routing slip (Word 
and Excel 2003)

Microsoft Word and Excel. Removes all entries from a routing slip, as well as 
the message subject and text. This can prevent email addresses of colleagues 
from being unknowingly distributed. This also deletes any envelope 
information, such as recipients, subject, and introduction, which are used 
when sending to a mail recipient.

Routing slips are not supported in MS Office 2007.

To view routing slip entries: From the File menu, select Send To and then 
Routing Recipient. To view envelope information: From the File menu, select 
Send To and then Mail Recipient.

Delete Smart Tags (Word) Microsoft Word only. Removes smart tags from Microsoft Word documents.

Smart tags are added to your documents as you create them if the option is 
enabled. These tags are linked to particular text in a document, such as a 
name, and allow you to perform certain actions by selecting the link 
associated with the text. Depending on the smart tag functions you use, they 
may embed extra hidden information in your document.

Smart tags only exist in Microsoft Office XP to 2010.

To manage smart tags: In MS Word 2010, right-click a word, select 
Additional Actions and then Options. In MS Word 2007, click the Office 
Button, select Word Options and then select Proofing. Click the AutoCorrect 
Options button and select the Smart Tags tab.

Delete text smaller than 
5pt (Word)

Microsoft Word only. Removes all text that has been formatted with a font 
size less that 5pt (i.e. 4pt and less). Small text can also be detected in 
Microsoft Excel but it is not cleaned.

To view small text: Click the View tab, select Zoom and specify a percentage 
greater than 100%.

Delete text with same 
color as background 
(Word)

Microsoft Word only. Removes all text that has been formatted with the same 
font color as that of the background.

To view such text: Click the Page Layout tab and select a color from the Page 
Color dropdown list (Page Background group).

Delete versions (Word 
2003)

Microsoft Word only. Removes any previous versions of the document that 
you may have saved. Previous versions can be useful while you are 
developing a document, but often they can contain confidential information 
that you have removed from the main document.

Document versions are not supported in MS Office 2007.

To view versions: From the File menu, select Versions.
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Option Description

Turn off versioning (Word 
2003)

Microsoft Word only. Turns off the flag to automatically save a new version of 
the document every time the document is closed. This applies to local file 
systems only. Versions can still be saved manually by saving a file with a 
different name.

Versioning is not supported in MS Office 2007.

Delete footers (Excel and 
PowerPoint)

Microsoft Excel and PowerPoint. Removes any footers included in the sheet or 
slide.

To view headers and footers: Click the Insert tab and select Header & Footer
(Text group).

Delete headers (Excel and 
PowerPoint)

Microsoft Excel and PowerPoint. Removes any headers included in the sheet 
or slide.

To view headers and footers: Click the Insert tab and select Header & Footer
(Text group).

Delete links (Excel) Microsoft Excel only. Converts external links in Microsoft Excel files to text. 
The following are examples of external links:

Link to a cell in another Microsoft Excel document.

Named link to a named reference in another Microsoft Excel document.

Link to another document.

OLE link that inserts another document as an icon.

OLE link that inserts another document as text.

Delete hidden slides 
(PowerPoint)

Microsoft PowerPoint only. Removes hidden slides from Microsoft PowerPoint 
files. Hidden slides are not required for a slide show (they are not 
automatically displayed during a slide show) but they may contain confidential 
information.

Delete Speaker Notes
(PowerPoint)

Microsoft PowerPoint only. Deletes all text that appears on the Notes Page in 
a Microsoft PowerPoint presentation. This is usually used by speakers to 
remind them of points during a presentation. You may want to remove 
speaker notes before distributing a presentation, as they are not usually 
intended for others to read.

Manual Redaction
Redacting text is to black out the text so that it is no longer discernible. Workshare Protect provides the 
functionality to redact/black out selected content in Microsoft Word (DOC and DOCX) documents.

The functionality is available from a right-click menu and also from the Workshare tab.

Redacting text actually replaces the text with “pipes” (||||||) on a black background. Once you make 
redactions in your document and save it, the redacted text cannot be restored (apart from the immediate 
possibilities of the Undo action).

To redact selected text:

1. Select the word, sentence or other data that you want to black out.
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2. Right-click the selection and select Redact Text or click Redact in the Workshare tab (Protect group). 
The following message is displayed:

3. Click Yes to save a copy of the document or No to continue in the current document. The selected text 
is blacked out.
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Chapter 9. Protecting Email Attachments
This chapter describes the Workshare Protect functionality with regard to identifying content risk in emails and 
their attachments. It includes the following sections:

 Overview – Protecting Email Attachments, below, introduces how Workshare Protect protects 
emails.

 Interactive Protect, page 148, describes how to use Interactive Protect to secure your emails.

 Using the Protect Profile Dialog, page 147, describes how to send secure emails using the Workshare 
Protect Profile dialog.

 Using the Email Security Dialog, page 158, describes how to send secure emails using the Workshare 
Protect Email Security dialog.

 Sending Large Files, page 176, describes how to use the Secure File Transfer functionality to upload 
large attachments to Workshare Online and send recipients links to the files in Workshare.

Overview – Protecting Email Attachments
Workshare Protect is able to process the emails you send to ensure security in the following ways:

 Remove metadata from attachments

 Convert attachments to PDF or PDF/A

 Send attachments to a secure location and send recipients a link to that location

 Compress multiple attachments into a single zip file

Whether Workshare Protect processes your emails is determined by the Apply Workshare Protect parameter 
in the Workshare Configuration Manager (Protection > Administration category). Your administrator may have 
selected that Workshare Protect processes emails to external recipients only, emails to internal recipients only, 
all emails or no emails.

When Workshare Protect is “on”, the user experience when sending emails will vary depending on which option 
your Administrator has selected for the After an email with attachments is sent show parameter in the 
Workshare Configuration Manager (Protection > Administration category).
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When sending emails, you may experience one of the following three options:

 Interactive Protect panel

 Protect Profile dialog

 Email Security dialog

Interactive Protect Panel

The Interactive Protect panel is displayed when Interactive Protect has been selected for the After an email 
with attachments is sent show parameter in the Workshare Configuration Manager (Protection > 
Administration category). 

Interactive Protect is described on page 147.
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Protect Profile Dialog

The Protect Profile dialog may be displayed in different ways depending on the option selected for the After an 
email with attachments is sent show parameter in the Workshare Configuration Manager (Protection > 
Administration category). 

 Protect Profile dialog using desktop profiles: The Protect Profile dialog is displayed after clicking 
Send. It provides a list of profiles available locally from which you can select to apply to your email 
(shown above).

 Protect Profile dialog using server profiles: The Protect Profile dialog is displayed after clicking Send. 
It provides a list of profiles available on Workshare Protect Server from which you can select to apply to 
your email.

The Protect Profile dialog is described on page 155.
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Email Security Dialog

The Email Security dialog may be displayed in different circumstances depending on the option selected for the 
After an email with attachments is sent show parameter in the Workshare Configuration Manager 
(Protection > Administration category). 

 Email Security dialog while discovering risk: The Email Security dialog is always displayed. It is 
displayed immediately after clicking Send while Workshare Protect checks the email against the default 
profile. The options are enabled once the check is complete.

 Email Security dialog for all mail: The Email Security dialog is always displayed. It is displayed after 
clicking Send once Workshare Protect has checked the email against the default profile.

 Email Security dialog for internal mail only: The Email Security dialog is displayed when an email has 
internal recipients. It is displayed after clicking Send once Workshare Protect has checked the email
against the default profile. For email to external recipients only, the Email Security dialog is not 
displayed. This is only relevant when Apply Workshare Protect is selected for Internal Email.

 Email Security dialog for external mail only: The Email Security dialog is displayed when an email has 
external recipients. It is displayed after clicking Send once Workshare Protect has checked the email
against the default profile. For email to internal recipients only, the Email Security dialog is not 
displayed. This is only relevant when Apply Workshare Protect is selected for External Email.

 No dialog (process actions transparently): The Email Security dialog is not displayed. Workshare 
Protect processes the email and applies the default profile without any user intervention.

The Email Security dialog is described on page 158.
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Interactive Protect
The Interactive Protect panel offers you options to control your documents and secure attachments before 
sending your email. 

 Remove Metadata: Enables you to clean metadata from your attachments. 

 Convert to PDF: Enables you to convert all the attachments to PDF or PDF/A.

 Compress Files: Enables you to compress all attachments together into one zip file.

 Secure File Transfer: Enables you to send your documents to a secure location send recipients a link 
to that location. 

To work with Interactive Protect:

Open Outlook and create a new email. Attach one or more files. Immediately Workshare Protect reports on the 
metadata found in a notification across the top of your email.
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If the Interactive Protect panel doesn’t open automatically, click the warning or click Protect Files in the 
Message tab. The Interactive Protect panel is displayed on the right side of your email window.

Using the options in the panel, you can clean metadata from the attachments, convert them to PDF, compress 
them in a zip file – all before sending the email. You can preview exactly what the processed attachments will 
appear like to the recipients BEFORE sending the email. Additionally, you can send the attachments to a secure 
location in Workshare and send only a link to that location to the recipients.

After selecting the required options, you must click Apply and then you can write your email while the changes 
are being applied before finally clicking Send once you are confident that what you are sending is secure and 
safe.

Note: If you create an email with an attachment, clean with Interactive Protect and then close the email, you 
are not prompted to save the email BUT the email is saved to your drafts folder.
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Cleaning Metadata Using Interactive Protect
In the Interactive Protect panel, you can leave the Remove metadata checkbox selected (this is selected by 
default) and click Apply. All metadata is removed from all the attachments.

To select specific metadata to remove from each attachment, you can expand the Clean files section.

You can expand each attachment and adjust the metadata to remove for each one by selecting/deselecting the 
checkboxes.

Note: To view a detailed report of the metadata found in an attachment, click View risk report.

Click Apply and the selected metadata is removed from each attachment.

You can write your email while the attachments are being cleaned and then preview the files by opening the 
cleaned attachments. Finally click Send once you are confident that what you are sending is secure and safe.
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Secure File Transfer Using Interactive Protect
In the Interactive Protect panel, you can select the Replace all attachments with a link checkbox selected and 
click Apply. The attachments are uploaded to Workshare Online and are replaced in the email with a link to their 
secure location. 

To change the permissions set for the attachments in Workshare or to set an expiry date, you can select the 
Replace all attachments with a link checkbox and expand the Send files securely section.

 Deselect any of the following permissions for the attachments as required:

 Recipients must login to access files: When selected, the recipient must be a Workshare user 
and must log into Workshare Online in order to access the files.

 Recipients can download files: When selected, recipients can download the files.

 Recipients can invite others to this folder: When selected, recipients can share the folder where 
the attachments are stored.

 If required, select an expiry date for the files. After this date, recipients will no longer be able to access 
the files.

 Select the Get return receipt checkbox if you want to receive an email once the recipients have
accessed the files.
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Click Apply and enter your Workshare login credentials in the Workshare Account Details dialog. Click Log In.
The attachments are uploaded into a single folder in Workshare (named with a date and time stamp) and the 
attachments are replaced in the email with a link.

You can write your email while the attachments are being processed and then preview the files in Workshare by 
clicking the link. The files are uploaded into a single folder in your Sent Items folder in Workshare and in the 
Recipients Inbox folder.

Finally in your email, click Send once you are confident that what you are sending is secure and safe.
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Converting Attachments to PDF Using Interactive Protect
In the Interactive Protect panel, you can select the Convert all checkbox in the Convert to PDF section and click 
Apply and all attachments are converted to PDF.

To select specific PDF conversion settings for the attachments, you can select the Convert all checkbox and 
expand the Convert to PDF section.

 Select whether to convert the attachments to PDF or PDF/A.

 Select all or some of the following security options:

 Print: Prevents recipients from printing PDF files.

 Edit Text: Prevents recipients with Adobe Distiller from editing PDF files.

 Copy text and/or graphics: Prevents recipients from copying graphics or text directly from PDF 
files.

 Add comments: Prevents recipients with Adobe Distiller from adding comments to PDF files.

Note: These options are not available if you selected PDF/A.
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 If required, set a password to protect the PDF files by entering the password twice. When a password 
is specified, recipients can only open the PDF files after entering this password.

Note: This option is not available if you selected PDF/A.

Click Apply and the selected PDF settings are applied to all attachments.

You can write your email while the attachments are being converted and then preview the files by opening the 
converted attachments. Finally click Send once you are confident that what you are sending is secure and safe.

Compressing Attachments Using Interactive Protect
In the Interactive Protect panel, you can select the Compress all checkbox in the Compress all to zip section 
and click Apply and all attachments are converted to PDF.

To set a password for the zip file, you can select the Compress all checkbox and expand the Compress all to 
zip section.

If required, set a password to protect the zip file by entering the password twice. When a password is specified, 
recipients can only open the zip file after entering this password.

Click Apply and all the attachments are compressed into a single zip file called Attachments.zip.

You can write your email while the attachments are being compressed and then preview the files by opening the 
zip attachment. Finally click Send once you are confident that what you are sending is secure and safe.
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Password Protected Files and Interactive Protect
When you attach a password-protected file, Workshare cannot clean or convert the file unless you enter the 
password. Warnings are shown in your email window as follows:

In order to proceed and clean the attachment or convert it to PDF, you must enter the open/modify password.

Click the icon. The Password required dialog is displayed.

Enter the Open or Modify passwords (or both) and click OK.

You will now be able to expand the attachment in the Interactive Protect panel and select which metadata to 
remove or whether to convert the attachment to PDF.

Note: You can send password-protected attachments securely and compress them without the need to enter 
the open/modify password.
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Using the Protect Profile Dialog
The Protect Profile dialog provides a simple UI that enables you to select what profile to apply to your emails.

A profile is a collection of policies that include a set of instructions to Workshare Protect as to what metadata to 
remove from an email attachment, whether to convert the attachment to PDF and whether to upload the 
attachment to Workshare Online and send a link instead.

Metadata settings and PDF instructions are specified per file type – Microsoft Word documents, Excel 
spreadsheets and PowerPoint presentations as well as PDF files. So for example, a profile could specify that 
comments and hidden text should be removed from Microsoft Word attachments and the document should be 
converted to PDF and only hidden worksheets should be removed from Microsoft Excel attachments and they 
should not be converted to PDF.

Your administrator defines profiles. Your administrator may have adopted a task-based approach or recipient-
based approach when creating profiles:

 Task-based profiles: For example, you are working on a legal document and sending it to colleagues to 
receive input. You email it and select the “Working Draft” profile which will remove metadata but keep 
track changes and comments. After receiving input and implementing changes, you email it and select 
the “Final Draft” profile which will remove metadata and remove track changes and comments. Once 
you are happy with the document, you email it and select the “Final” profile which will remove 
metadata, track changes and comments and convert the document to PDF.

 Recipient-based profiles: For example, your company has a policy that whatever documents you send 
to opposing counsel, the metadata must be removed and the document must be converted to PDF. You 
therefore have a profile called “opposing counsel” which removes metadata and converts to PDF. You 
also have a profile called “Personal” which does nothing.

These are just examples of the types of profiles that might be defined. If you have any questions or requirements 
regarding the profiles, contact your administrator.
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To send an email:

1. Create a new email, attach the required document(s) and click Send. The Protect Profile dialog is 
displayed.

2. Select the profile you want to apply to your attachments and click Send. The following default profiles 
are provided with Workshare Protect:

 Default: Attachments are processed according to the settings in the Workshare Configuration 
Manager.

 Clean: All metadata is cleaned from Microsoft Word, Excel, PowerPoint and PDF attachments.

 Clean & PDF: All metadata is cleaned from Microsoft Word, Excel, PowerPoint and PDF 
attachments and Microsoft Word, Excel and PowerPoint attachments are also converted to PDF.

 Clean & Secure File Transfer: All metadata is cleaned from Microsoft Word, Excel, PowerPoint 
and PDF attachments and then the attachments are uploaded to Workshare Online and recipients 
are sent a link to the attachments. Refer to Secure File Transfer Profiles, page 158.

 Secure File Transfer: Attachments are uploaded to Workshare Online and recipients are sent a link 
to the attachments. Refer to Secure File Transfer Profiles, page 158.

If you want to send your email without Workshare Protect processing the attachments, click the arrow on the 
Send button and select Send without processing. 

If you want to access the Email Security dialog and specify personal settings or individual settings for each 
attachment, click the Advanced Options link. The Email Security dialog is displayed with options matching the 
profile selected. Refer to the next section for a description of the Email Security dialog.



PROTECTING EMAIL ATTACHMENTS

158

Note: Your administrator may not have enabled the Secure File Transfer profiles or the Send without 
processing option or the Advanced Options link.

Secure File Transfer Profiles

You can upload almost any file to Workshare Online and send any recipient a link to where the document is 
stored in Workshare. All recipients will be able to view the document in Workshare in a browser and those 
recipients who have a Workshare account will also be able to collaborate on the documents by adding 
comments in real-time and uploading versions.

To securely transfer files:

1. Create a new email, enter the recipient email addresses and attach the required document(s).

2. Click Send. The Protect Profile dialog is displayed.



PROTECTING EMAIL ATTACHMENTS

159

3. Select Secure File Transfer or Clean & Secure File Transfer (if you want to remove metadata from 
the attachments before uploading them to Workshare).

Note: Click Advanced Options if you want to configure specific user access to the documents in 
Workshare. Refer to Advanced Options, page 161.

4. Click Send. The Workshare Account Details dialog is displayed.

Note: If you are already logged into Workshare, the attached files are uploaded to a folder in 
Workshare. The name of the folder is whatever is entered into the Subject field of the email followed 
by the date and time.



PROTECTING EMAIL ATTACHMENTS

160

 If you already have an account with Workshare, in the Log In tab, enter your Workshare login email
and password and click Log In. The attached files are uploaded to a folder in Workshare.

 If you are new to Workshare, complete the Create an account tab by entering an email address 
and password to use as your Workshare login.

Click Create Account. A message indicating that you must validate your new account is displayed. 
Click OK. The email is sent but the recipient will not be able to access the attachment until you have 
validated your account. Open the validation email and click the link in that email to validate your 
account. 
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The attached files are uploaded to a folder in Workshare. The name of the folder is whatever is entered 
into the Subject field of the email followed by the date and time. This folder appears in your Sent Items
folder in My Files and Folders in Workshare. The recipient receives an email notifying them that files 
have been uploaded to Workshare and providing a link to the files.

Receiving Links

Recipients of emails sent using the Secure File Transfer profiles receive an email with details of the name of the 
file and a link to click to access the file in Workshare Online. The means of access and options available to the 
recipient will vary depending on whether the recipient is a Workshare user and the settings specified by the 
sender. Scenarios include:

 When a recipient is a Workshare user, clicking the link displays the location in Workshare where the file 
(or files) is stored. The file or files are stored in a folder with a name that matches the subject of the
email. This folder appears in the recipient’s Inbox folder in My Files and Folders in Workshare. The 
recipient can add comments to the file, upload versions and make changes to the folder where the file is 
stored. 

 If the sender has specified that the recipient need not be a Workshare user, clicking the link displays the 
location in Workshare where the file (or files) is stored. The recipient can view the file and download it.

 If the sender has specified that the recipient must be logged in to Workshare, clicking the link displays 
the Workshare login and the recipient must first log in to Workshare in order to view the location in 
Workshare where the file (or files) is stored and download it.

 If the sender has specified an expiry date then the link will only work until the expiry date. Once the 
date has passed, the recipient will not be able to access the file.

Advanced Options

You can set advanced access rights to documents that you store in Workshare to control recipient access. 
Clicking Advanced Options in the Protect Profile dialog enables you to configure specific user access to the 
documents you are uploading to Workshare.

To configure advanced options:

1. Create a new email, enter the recipient email addresses and attach the required document(s).

2. Click Send. The Protect Profile dialog is displayed.

3. Select Secure File Transfer or Clean & Secure File Transfer and click Advanced Options. The 
Advanced Email Security Options dialog is displayed.
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4. Select the Secure File Transfer (SFT) tab.

5. If your administrator has given you the rights to access the Advanced Options, you can configure the 
following parameters:

Apply Action When selected the selected profile (Secure File Transfer or Clean & Secure 
File Transfer) is applied to the email. When not selected, the email is sent 
without a profile being applied.

Users must login to 
access folder

When selected, the recipient must be a Workshare user and must log into 
Workshare in order to access the file. When not selected, the recipient can 
access Workshare without being a registered user to view and download the 
file only.

Recipients may 
invite others to this 
folder

When selected, recipients can forward the link to other recipients who will be 
able to access the file. Unless Users must login to access folder is selected, 
this option is always selected.

Expire access to 
files on:

You can specify an expiry date for the file. After this date, the recipient will no 
longer be able to access the file.

Get return receipt When selected, you will receive an email once the recipient has accessed the 
file.

Download files When selected, recipients can download the file.

Note: The default settings of these parameters are set in the Workshare Policy Designer.

6. You specify these settings for the files selected on the left side. So you can select multiple files and set 
the same settings for all or you can select an individual file and specify setting individually.

7. Click Send. The attached files are uploaded to a folder in Workshare. The name of the folder is whatever 
is entered into the Subject field of the email followed by the date and time.
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Using the Email Security Dialog
When you send an email using the Email Security dialog configuration, Workshare Protect checks any 
attachments to see if they breach any security policies defined in the default profile. A security policy defines the 
conditions that must exist in order for Workshare Protect to detect content risk and the actions that should be 
taken when the conditions are met (i.e. content risk is found).

When deciding which policy to apply, Workshare Protect checks each recipient. If an external recipient is found, 
external policy settings are applied. Only if all recipients are internal, are internal policy settings applied. For 
example, an attached document could contain hidden data that should not be sent to external parties but is 
suitable for distribution internally.

The options available to you depend on the security policies in place in your organization and the action specified 
for a policy breach. The different actions are as follows:

 Block Action: This action blocks your attempts to send the email until the offending information is 
removed. See Resolving Blocked Emails for more information.

 Alert Action: This action alerts you to content risk contained within your email, although you are still 
able to send the email. See Reviewing Alerts for more information.

 Clean Action/Lightspeed Clean Action/PDF Clean: This action cleans the attachments before sending 
the email. See Cleaning Hidden Data from Attachments for more information.

 PDF Action: This action converts attached documents to PDF before sending the email. See Converting 
Attachments to PDF for more information.

Note: Using the Apply Workshare Protect parameter in the Workshare Configuration Manager (Protection
> Administration category), Workshare Protect can be configured to NOT check attachments of emails sent 
internally or externally (or both) to see if they breach any security policies. If you have queries about your 
email security settings, refer to your administrator.

Password-Protected Documents

When an attachment is encrypted (password-protected), Workshare Protect requires the password in order to 
check the document. Password-protection here refers to the file encryption functionality available in MS Word 
where the user can set a password that must be entered in order to open or modify the document.

Note: This functionality is available by clicking the File menu/Office button, selecting Save As and from the 
Save As dialog, clicking Tools and then selecting General Options.
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When sending an email with an attachment that requires a password in order to be opened or modified, a 
Password dialog is displayed. For example,

Enter the password required to open the document in the Open Password or Modify Password field and click 
OK, or you can click Skip and Workshare Protect will not check the document.

When an attachment is a protected document, Workshare Protect also requires the password in order to check 
the document. Protected document refers to the “Protect Document” functionality available in MS Word where 
the user can restrict specific users from editing specific sections of the document. The protection settings are 
protected by a password. 

Note: This functionality is available from the Review tab (Protect group) – click Restrict Editing (MS Word 
2010/2013) or click Protect Document (MS Word 2007).

When sending an email with an attachment that is a protected document, a Password dialog is displayed. For 
example,

Enter the password required to open the document in the Document Protection Password field and click OK, or 
you can click Skip and Workshare Protect will not check the document.
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Send and Protect

Your administrator may have configured Workshare Protect to include a Send and Protect button in your 
message window. If so, you can click this button instead of clicking Send and the Email Security dialog will 
always be displayed – regardless of policy settings. You can then select to clean attachments or convert 
attachments to PDF as required.

Sending Emails

The following procedure describes how to send emails using the Email Security dialog.

To send an email:

Create a new email, attach the required document(s) and click Send. The Email Security dialog is displayed.

Note: If the Email Security dialog while discovering risk option has been selected (When sending an 
email with attachments show parameter, Protection > Administration category), the Email Security dialog 
is displayed immediately while Workshare Protect checks the email against the default profile. The options are 
enabled once the check is complete (see example screen below). When this option is not selected, a progress 
bar is first displayed and the Email Security dialog is only displayed once the check is complete.

This dialog alerts you to any breaches of security policies in the default profile triggered by your email or its 
attachments. If your administrator has given you permissions, you can modify the settings for each attachment. 
Refer to Quick Tour of the Email Security Dialog for further information about the options available.
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If the Email Security dialog while discovering risk option has been selected and you click Send before 
Workshare Protect has finished checking the email, the email is sent and the attachment(s) is processed 
according the settings in the default profile. This mean that the actual metadata that is cleaned and the settings 
used for converting to PDF are taken from the default profile.

Click Send and Workshare Protect processes the email as specified.

Quick Tour of the Email Security Dialog

The Email Security dialog includes several tabs. The number of tabs may vary according to the policies triggered 
but there will always be a Summary tab and a Policies tab.

Tip! Click View Risk Report if you want to print a risk report detailing the content risk discovered in the 
attached document(s). The risk report enables you to evaluate the content risk contained in the selected 
attachments.

Select File Area

The Select File area is the same in every tab. It includes a list of the email attachments that have triggered a 
policy.

For each item, you can see the risk level and the 
actions to be applied to the item. You can select 
individual attachments or select the entire list by 
selecting the Select All checkbox. When a Clean 
or PDF action is to be applied, you can double-
click an item in the list to preview what it will look 
like once the actions have been applied. For 
example, if an attachment in DOC format will have 
the PDF action applied, double-clicking this DOC 
attachment will enable you to preview it as a PDF.
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Summary Tab

The Apply Action area of the Summary tab provides one-click checkboxes to change details of the Clean and 
PDF actions as well as a list of triggered policies which provides links to the policies that triggered the actions.

Under Metadata Removal, selecting Remove 
Comments or Remove Track Changes cleans 
comments or track changes from the selected 
attachment. Selecting one of the Skip Cleaning
options means the selected attachment is not 
cleaned at all. Click View Options to display all 
options in the Office Metadata/PDF Metadata
tabs.

Under Workshare Secure PDF, selecting Convert 
to PDF means the selected attachment is converted 
into PDF. Click View Options to display all options in 
the Convert to PDF tab.

Under Triggered Policies, there is a list of policies
triggered by the email and its attachments. Click the 
name of a policy to see more information about the 
policy in the Policies tab.

Note: The availability of checkboxes and options may appear differently depending on your organization’s 
security policies included in the default profile. Any options that are disabled have been locked. Refer to your 
system administrator if you need to override these settings.

Policies Tab

The View Policies area on the right side of the Policies tab provides detailed information about the policies 
breached by the email and it attachments.

In the Policies tab, you can discover more 
information about what caused a breach of policy. 
Click More/Less to display/hide details of each 
policy as required.
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Other Tabs

The Office Metadata tab is included in the Email Security dialog when a Clean or Lightspeed Clean action is 
triggered for an Office file. Refer to Cleaning Hidden Data from Attachments, page 171, for more information.

The PDF Metadata tab is included in the Email Security dialog when a PDF Clean action is triggered for a PDF 
file. Refer to Cleaning Hidden Data from Attachments, page 171, for more information.

The Convert to PDF tab is included in the Email Security dialog when a PDF action is triggered. Refer to
Converting Attachments to PDF, page 174, for more information.

The ZIP Options tab is included in the Email Security dialog when a Zip action is triggered.

The Secure File Transfer (SFT) tab is included in the Email Security dialog when a Secure File Transfer profile is 
selected in the Protect Profile dialog. Refer to Secure File Transfer Profiles, page 158.
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Resolving Blocked Emails

Every time you send an email with an attachment, Workshare Protect checks the attachment to see if it 
breaches any security policies in the default profile.

Your system administrator can define policies that block any attempt to send emails containing certain 
pre-defined policy triggers. An attempt to send an email or attachment that contains one of these policy triggers 
results in the email being blocked. If an email is blocked, the conditions that caused it to be blocked (content, 
attachment, or recipients) must be removed before the email can be sent.

When you send an email that triggers a Block action, Workshare Protect notifies you that your email has been 
blocked.

To resolve blocked emails:

1. Click the name of the policy in the Triggered Policies list or select the Policies tab to view what 
content has triggered the email policy.

2. Click the Close button to close the Email Security dialog.

3. Make the appropriate changes to the email and/or document(s) by removing or modifying the content, 
attachments or recipients that caused your email to be blocked.

4. If making changes to attachments, re-attach the corrected documents.

5. Click Send. If you have made all the relevant changes, you should now be able to send the email 
successfully.
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Reviewing Alerts

Every time you send an email with an attachment, Workshare Protect checks the attachment to see if it 
breaches any security policies in the default profile.

Your system administrator can define policies that contain certain pre-defined policy triggers that alert you to 
content risk in emails and documents when they are sent by email. The Alert action provides information about 
content or attachments that might violate policy, but does not require that the content be removed before 
sending the email.

When you send an email that triggers an Alert action, Workshare Protect notifies you that your email and/or 
attachment(s) contain content risk. 

To find out more about what triggered a policy, click the name of the policy in the Triggered Policies list or 
select the Policies tab. The Policies tab is displayed showing the policies triggered on the right side. Click 
More/Less to display/hide details of each policy as required. If required, you can make changes to your email or 
the attached documents to take account of the content risk discovered.

When you are ready to send the email, click Send.
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Cleaning Hidden Data from Attachments

Every time you send an email with an attachment, Workshare Protect checks the attachment to see if it 
breaches any security policies in the default profile.

Your system administrator can define policies that contain certain pre-defined policy triggers that oblige you to 
clean hidden data from attached documents when they are sent by email. The Clean, Lightspeed Clean and 
PDF Clean actions remove hidden data, such as track changes, hidden text, comments, markup and more, from 
attachments.

Lightspeed cleaning is much faster than regular cleaning because it maintains the original structure of the 
document but redacts hidden data which might contain sensitive information. Thus regular cleaning actually 
removes the hidden data element from the document whereas Lightspeed cleaning leaves the element but 
redacts it. With Lightspeed cleaning, formatting track changes which pose no risk are left intact. For a detailed 
description of what is cleaned using each method of cleaning, refer to Appendix B: Clean and Lightspeed Clean.

When you send an email that triggers a Clean, Lightspeed Clean or PDF Clean action, Workshare Protect 
notifies you that your email and/or attachment(s) will be cleaned.

Note: For more information on the types of hidden data contained within Microsoft Office documents, see 
Overview – Managing Content Risk in Documents.

If your administrator has enabled you to override the clean hidden data settings and you do not want to clean the 
attachment(s), you can select the Skip Cleaning checkbox (or either of the Skip Office Metadata Cleaning or 
Skip PDF Metadata Cleaning checkboxes individually) in the Apply Action area.
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To clean hidden data:

1. Select the attachment in the Select File list to specify individual options for a single attachment or 
select the Select All checkbox to select all attachments. Any settings will then be applied to all 
attachments.

2. Click View Options in the Metadata Removal area or select the Office Metadata tab. The Office 
Metadata tab displays the different hidden data cleaning options for Microsoft Office attachments.
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3. Click View Options in the Metadata Removal area or select the PDF Metadata tab to display the 
different hidden data cleaning options for PDF attachments.

Note: The availability of these options is dependent on whether your administrator has enabled you to 
override the cleaning options in the policy settings. Refer to your system administrator if you need to 
override these settings and they are disabled.

4. Select the hidden data that you want to remove by selecting or deselecting the relevant checkboxes.

5. Repeat for additional attachments if required.

6. Click Send to send the email.

Workshare Protect cleans the hidden data from the attached document(s) according to your settings before 
sending the email.



PROTECTING EMAIL ATTACHMENTS

174

Converting Attachments to PDF

Every time you send an email with an attachment, Workshare Protect checks the attachment to see if it 
breaches any security policies in the default profile.

Your system administrator can define policies that contain certain pre-defined policy triggers that force you to 
convert documents to PDF when they are sent by email. This prevents the document from being edited, ensuring 
that its formatting remains intact. Additional security features enable you to prevent recipients from printing, 
editing, copying from or adding comments to the PDF attachment.

When you send an email that triggers a PDF action, Workshare Protect notifies you that your attachment(s) will 
be converted to PDF.

If your administrator has enabled you to override the PDF settings and you do not want to PDF the 
attachment(s), you can deselect the Convert to PDF checkbox in the Apply Action area.
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To convert attachments to PDF:

1. Select the attachment in the Select File list and click View Options in the Workshare Secure PDF
area or select the Convert to PDF tab. The Convert to PDF tab displays the different PDF security 
settings available.

Note: You can specify individual PDF settings for each attachment or select the Select All button.

2. Select one or more of the following security options:

 Prevent printing to prevent recipients from printing the PDF document.

 Prevent editing of text to prevent recipients with Adobe Distiller from editing the PDF document.

 Prevent the copying of text and/or graphics to prevent recipients from copying graphics or text 
directly from the PDF document.

 Prevent comments being added to prevent recipients with Adobe Distiller from adding comments 
to the PDF document.

Note: Highlighting text and adding a strikethrough in a PDF is not considered editing the text. If you
want to prevent users doing this, select Prevent comments being added as well as Prevent editing
of text.

3. If required, set a password for access to the PDF by entering the password twice in the relevant fields.

4. If required, select the Reconstruct Hyperlinks checkbox to preserve standard URL and bookmark 
hyperlinks.
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Note: Selecting the Reconstruct Hyperlinks option can increase the time it takes to create a PDF 
document. Hyperlinks that are preserved using this option may not correspond exactly to the location 
in the original document.

5. Select the PDF/A checkbox to convert the attachment to PDF/A.

6. Repeat steps 2 to 5 for additional attachments if required.

7. Click Send to send the email.

Workshare Protect converts the attachments to PDF or PDF/A and applies your settings before sending the 
email.

Sending Large Files
When your administrator has set a limit on the size of files you can email (to avoid large files blocking Exchange), 
you can use Secure File Transfer functionality to send a link to the large files.

When you try and add a file with a size over the specified limit, Microsoft Outlook displays a message such as:

In this case, you can use the Add Large Attachment button to access the Secure File Transfer functionality.

To send large files:

1. Open a new email message window.

2. Click Add Large Attachment.

3. Browse to the large file you want to attach and click Open. The attachment displayed in the message 
appears small because it is only a pointer to the large file.
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4. Add the recipient and message details and click Send. The Protect Profile dialog is displayed with only 
the Secure File Transfer profiles available.

5. Select the required Secure File Transfer profile and click Send.

The attached large file is uploaded to a folder in Workshare. The name of the folder is whatever is entered into 
the Subject field of the email followed by the date and time. This folder appears in your Sent Items folder in My 
Files and Folders in Workshare. The recipient receives an email notifying them that file has been uploaded to 
Workshare and providing a link to the file.

Note: The Add Large Attachment button does not work with Interactive Protect; it is disabled.
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Chapter 10. Controlling Documents
This chapter describes how to control your documents by setting restrictions on whether or not they can be 
emailed. It includes the following sections:

 Document Classification, below, introduces the classification levels available in Workshare Protect.

 Setting Classification Levels, page 179, describes how to classify a document.

 Emailing Classified Documents, page 181, describes the effect a classification level has on a 
document when it is emailed.

Document Classification
Workshare Protect enables you to restrict access to sensitive business documents by classifying documents. 
This classification controls the distribution of documents by email - it can prevent documents from being emailed 
either to any user, or to external users or it can alert users to the potentially sensitive nature of the document 
they are attempting to email.

Workshare Protect provides the following default classification levels:

 For Internal Use Only: The document is restricted and can only be distributed internally within your 
organization. Use this status if you are collaborating on a document with colleagues, but the document 
is not yet ready for client review.

 Confidential: The document contains information of a confidential nature and when emailed either 
externally or internally, you are alerted to the fact that the document contains confidential information. 
You can still send the document to any recipient.

Note: When working with the Workshare Protect Profile dialog, you do not receive an alert and you
can send the document to any recipient unless you configure a policy to implement other behavior.

 Highly Confidential: The document contains information of a highly confidential nature and when 
emailed whether externally or internally, it will be blocked.

Note: When working with the Workshare Protect Profile dialog, the email is not blocked and you can 
send the document to any recipient unless you configure a policy to implement other behavior.

 External Restriction: The document is restricted and can only be distributed internally within your 
organization. Use this status if you are collaborating on a document with colleagues, but the document 
is not yet ready for client review.

 Full Restriction: The document is restricted and cannot be distributed via email. Use this status if you 
are working on a document yourself and do not want it distributed.

These classification levels can be password-protected. This ensures that only users who know the password can 
remove or alter a classification status from documents.
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Note: The names and descriptions of the classification levels are defined in the ClassificationList.xml file 
located in the Workshare Protect installation folder. The names of the classification levels can be amended or 
classification levels can be deleted or additional classification levels can be added by editing this file.

In previous versions of Workshare Protect, three restrictions were available: No Restriction (as if no 
classification level is set), External Restriction, and Full Restriction. If you would prefer to work with only 
these three classification levels, you can edit the ClassificationList.xml file accordingly.

Setting Classification Levels
Documents are classified from the Document Classification page of the Workshare Panel. If required, you can 
password-protect a classification level so that only users who know the password can remove or change a 
classification level for a document.

To set a classification level:

1. With your document open in Microsoft Word, Excel or PowerPoint, click Classify (Protect group) in the 
Workshare tab or click Classify in the Home page of the Workshare Panel. The Document Classification 
page is displayed.
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2. Select the classification level you require for the open document from the following:

 For Internal Use Only: The document is restricted and can only be distributed internally within your 
organization. Use this status if you are collaborating on a document with colleagues, but the 
document is not yet ready for client review.

 Confidential: The document contains information of a confidential nature and when emailed either 
externally or internally, you are alerted to the fact that the document contains confidential 
information. You can still send the document to any recipient.

 Highly Confidential: The document contains information of a highly confidential nature and when 
emailed whether externally or internally, it will be blocked.

 External Restriction: The document is restricted and can only be distributed internally within your 
organization. Use this status if you are collaborating on a document with colleagues, but the 
document is not yet ready for client review.

 Full Restriction: The document is restricted and cannot be distributed via email. Use this status if 
you are working on a document yourself and do not want it distributed.

3. If you want to password-protect the classification level, select the Specify a password checkbox in the 
Select Password Protection area. This means that only those who know the password can change 
the classification level of the document.

4. Click Apply. If you selected the Specify a password checkbox, you are prompted for a password.

Tip! If you click the words Specify a password in the Document Classification page, the above dialog 
is displayed immediately before clicking Apply.

5. Enter the password twice to set and confirm the password and click OK.

6. Save the document. The open document is now restricted according to the selected classification level.
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Emailing Classified Documents
When a document is emailed, the classification level is checked and the document is handled according to its 
classification level:

 If the document has a Not Classified classification, it is emailed without any warning.

 If the document has a Confidential classification, you will receive an alert when trying to email it. You 
can still send the email with the attached document by clicking Send.
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 If the document has a For Internal Use or External Restriction classification, it can be freely emailed 
to internal recipients. However, if you try to email it to an external recipient, the following dialog is 
displayed:

The email cannot be sent. Click Close to cancel the email. If you were sending the email to internal and 
external recipients, you should remove the external recipients and resend to internal recipients only.
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 If the document has a Highly Confidential or Full Restriction classification, it cannot be emailed at all. 
If you try to email it, the following dialog is displayed.

The email cannot be sent. Click Close to cancel the email.
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Chapter 11. Converting to PDF
This chapter describes how to convert your documents to PDF using Workshare Protect. It includes the following 
sections:

 Overview, below, introduces the PDF conversion functionality available in Workshare Protect.

 Creating PDFs, page 185, describes how to convert a document to PDF.

 PDF From Anywhere, page 189, describes how to create a PDF from any application.

Overview – Converting to PDF
Workshare Protect creates the most secure PDF files available from any application. You can quickly and easily 
convert open and closed Microsoft Office documents into PDF or PDF/A. You can also enforce PDF creation on 
email attachments leaving your organization. When sending documents for review, you can convert to PDF or 
PDF/A any comparison documents or additional documents included. In all these circumstances, before 
converting to PDF, Workshare Protect offers you the opportunity to remove hidden data from the document and 
set PDF security options. Workshare Protect also provides “PDF Anywhere”. This is the ability to convert a 
document to PDF from any application.

Converting Documents to PDF

Workshare Protect enables you to quickly and easily convert Microsoft Word, Excel and PowerPoint documents 
into PDF (Portable Document Format) or PDF/A. This functionality is available from within an open document or 
when the document is closed. Before Workshare Protect converts the document, you can select to remove 
sensitive hidden data from the document. Refer to Creating PDFs.

PDF and Emails

Workshare Protect provides organizations with the ability to enforce PDF creation on documents leaving the 
organization through policy rules. Your system administrator can create policies that contain certain pre-defined 
policy triggers that force you to convert documents to PDF when they are sent by email. Refer to Converting 
Attachments to PDF.

Additionally, Workshare Protect enables you to quickly and easily convert open Microsoft Word, Excel and 
PowerPoint documents into PDF or PDF/A and send them by email. Before Workshare Protect converts the 
document, you can select to remove sensitive hidden data from the document. Refer to Creating PDFs.

PDF Anywhere

Workshare Protect enables you to create and combine PDF files from any application, for example, an email 
application, a browser or Notepad. You can convert to a new PDF file or you append to an existing PDF file. Refer 
to PDF From Anywhere.
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Creating PDFs
At any time when working on a document in Microsoft Word, Excel or PowerPoint, you can convert the 
document into PDF or PDF/A. This is useful if you want to maintain a file in its current format, as PDF documents 
cannot be edited as easily as Microsoft Word, Excel and PowerPoint documents. This functionality is available 
from within an open document or when the document is closed. 

Open Documents

Workshare Protect automatically saves a document before converting to PDF or PDF/A. Documents can be 
stored locally, in SharePoint or in your DMS.

To convert an open document to PDF or PDF/A:

1. With your document open in Microsoft Word, Excel or PowerPoint, click Convert to PDF (Protect
group) in the Workshare tab or click Convert to PDF in the Home page of the Workshare Panel. The 
Convert to PDF dialog is displayed.

Note: If working with a DMS, the dialog looks slightly different to the one above and you can select 
whether to save the PDF as a new document or related document in your DMS or as a local file.
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2. Select whether to convert to PDF or PDF/A.

3. Click Configure PDF Security to set PDF security options and remove metadata.

4. Select one or more of the following security options:

 Prevent printing: Prevents recipients from printing the PDF document.

 Prevent editing of text: Prevents recipients with Adobe Distiller from editing the PDF document.

 Prevent the copying of text and/or graphics: Prevents recipients from copying graphics or text 
directly from the PDF document.

 Prevent comments being added: Prevents recipients with Adobe Distiller from adding comments 
to the PDF document.

Note: These options are disabled and cannot be selected if you selected PDF/A in step 2.
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5. To specify what hidden data to remove before converting it to PDF, click Cleaning Options.

6. Select hidden data elements as required. For a full description of all the hidden data elements, refer to 
Cleaning Hidden Data for further information.

7. Click OK.

8. If required, set a password to protect the PDF by entering the password twice in the Password 
protection area. When a password is specified, the recipient can only open the PDF after entering this 
password.

Note: If you selected PDF/A in step 2, you cannot set a password and the Password protection area 
is disabled.

9. Click Apply.

10. In the Convert to PDF dialog, if you want to create a PDF of part of the document only, select the Pages 
radio button and specify a page range.

Note: You can also PDF individual pages by specifying the pages (separated by commas) in the Pages
field.
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11. Select the Open PDF once created checkbox if you want the PDF to be opened once it has been 
created.

12. Select the Email PDF as attachment checkbox if you want the PDF to be attached to an email once it 
has been created.

13. If required, click Preview to view the document as a PDF.

14. Click Create. The Save As dialog is displayed:

15. Specify the name and location for the PDF file and click Save. The document is converted to PDF or 
PDF/A. If you selected Open PDF once created, the new PDF is opened. If you selected Email PDF as 
attachment, an email message window is displayed with the PDF as an attachment.

Closed Documents

Workshare Protect can convert closed Microsoft Word, Excel or PowerPoint documents to PDF or PDF/A.

To convert a closed document to PDF or PDF/A:

 Right-click the closed Microsoft Word, Excel or PowerPoint file on your desktop or DMS and select 
Convert to PDF with Workshare from the menu. The Convert to PDF dialog is displayed.

Continue as described in steps 2 to 15 of the Open Documents section.
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PDF From Anywhere
Workshare Protect can convert any document or file to PDF, for example, a page in Internet Explorer, an email 
message or a text file in Notepad. You can create a new PDF from the file or add to an existing PDF.

To convert to PDF from anywhere:

1. Click Print in the application.

2. Select Workshare PDF Publisher as the printer. 

3. Specify other settings as required and click Print. The Output File Name dialog is displayed. 

4. Specify a name for the PDF in the File name field or, if you want to add to an existing PDF, select the 
Concatenate checkbox and browse to and select the existing PDF.

5. Click OK. The open document is converted to PDF and saved as specified or added to an existing PDF.
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Chapter 12. Advanced PDF Functionality
This chapter describes how to convert a PDF file to a Microsoft Word file as well as combine several documents 
into a single PDF using Workshare Professional. It includes the following sections:

 Converting PDF Files to Word Format, below, describes how to convert a PDF document into 
Microsoft Word format.

 PDF Combine, page 192, describes how to combine multiple files into a single PDF.

Converting PDF Files to Word Format
Workshare Professional provides accurate conversion of PDF files to Microsoft Word files (PDF to DOC/DOCX
format) preserving document formatting and page layout. This Workshare Professional functionality is available 
from within Microsoft Word and by right-clicking closed PDF files on your desktop.

Scanned PDF files will not be converted to editable text – the content remains as an image and cannot be edited.

Converting a PDF document into Microsoft Word format is useful if you want to edit the document, as PDF 
documents cannot be edited as easily as Microsoft Word documents.

Note: Workshare cannot convert secure PDFs, meaning PDF files with security settings configured.

To convert a PDF:

1. To convert a PDF document to DOC format:

 Right-click the closed PDF file and select Open in Word with Workshare.

 From Microsoft Word, click the Office Button/File menu and select Open. Browse to the PDF file and 
click Open.
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The Open PDF in Word dialog is displayed.

2. Select a conversion method according to how much of the formatting and layout you want to preserve 
and click OK. The PDF document is converted to Word format and is opened in Microsoft Word.

Notes:
The name in the title bar will still include the PDF extension. However, the document is in DOC/DOCX format.

When converting a PDF file to Word format, the display may vary according to the type of PDF. The type of 
PDF means the software used to create the PDF file. For example, Adobe, Amyuni, CutePDF, novaPDF, and so 
on.

You must save the document.
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PDF Combine
Workshare Professional enables you to combine multiple files into a single PDF or PDF/A file. For example, 
electronic court submissions are required to be submitted as a PDF or PDF/A file. Case information can include 
multiple file formats such as contracts, financial spreadsheets and email conversations.

Workshare Professional supports the combination of the following file types into a single PDF file: DOC, DOCX, 
PPT, PPTX, XLS, XLSX, PDF, RTF, TXT, HTML, MSG.

To combine multiple documents into a single PDF:

1. In an open Office document, click Combine PDF (Review group) in the Workshare tab or in Windows 
Explorer or your DMS, right-click one or more files that you want to combine into a single PDF and 
select Combine files in Workshare. (You do not have to select all the files to combine at this stage but 
can add them later.) The Combine Files dialog is displayed.

2. Add the additional files you want to include in the single PDF using the buttons at the top or by dragging 
and dropping. Click Add Files to select and add a single file and select Add Folder to add multiple files 
from a selected folder.

3. Once you have selected the files to combine, arrange the order using the Move Up and Move Down
buttons. If you want to remove a file from the list, select it and click Remove.
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4. If you only want to include selected pages from a particular document, select the file in the list and click 
Pages Range.

5. Select the Pages radio button and specify the pages to be included into the combined PDF as required.

6. Click OK.

7. Select whether you want to create a PDF file or a PDF/A file from the Create PDF version as dropdown 
list.

8. If you want to set security options for the combined PDF, click Configure PDF Security.
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9. Select one or more of the following security options:

 Prevent printing: Prevents recipients from printing the PDF document.

 Prevent editing of text: Prevents recipients with Adobe Distiller from editing the PDF document.

 Prevent the copying of text and/or graphics: Prevents recipients from copying graphics or text 
directly from the PDF document.

 Prevent comments being added: Prevents recipients with Adobe Distiller from adding comments 
to the PDF document.

Note: These options are disabled and cannot be selected if you selected PDF/A in step 7.

10. To specify what hidden data to remove before converting it to PDF, select the Clean before PDF
checkbox and click Cleaning Options.

11. Select hidden data elements as required. For a full description of all the hidden data elements, refer to 
Cleaning Hidden Data for further information.

12. Click OK.

13. If required, set a password to protect the PDF by entering the password twice in the Password 
protection area. When a password is specified, the recipient can only open the PDF after entering this 
password.

Note: If you selected PDF/A in step 7, you cannot set a password and the Password protection area 
is disabled.
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14. Click Apply.

15. If required, click Preview to view the combined PDF.

16. Click Create PDF. A Save as dialog is displayed.

17. Specify the name and location for the combined PDF file and click Save. The documents are converted 
into a single PDF. The progress of the operation can be seen in the Status column in the Combine files 
in Workshare dialog.

If you want to save your selection without creating a PDF – for example, if you have not completed the selection 
of documents – you can save your work in progress as a Workshare workbook (.WWB) by clicking Save in the 
Combine Files dialog. When you are ready to work on it again, simply right-click the WWB file and select 
Combine files in Workshare or drag new files you want to include over the WWB file. This re-opens the 
Combine Files dialog and you can continue.

Note: For iManage users, in order to save a Workshare workbook, the WWB file type needs to be registered 
as a file type on the Worksite Server.
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Chapter 13. Creating Reports
This chapter describes how to create different reports using the Workshare Professional Report Wizard. It 
includes the following sections:

 Overview, below, introduces report functionality available in Workshare Professional.

 Risk Report, page 197, describes how to create a report showing the different types of content risk in 
your document.

 Audit Report, page 200, describes how to create a report showing when your document was sent for 
review as well as a list of all proposed changes and their status.

 Review Report, page 201, describes how to create a report showing changes proposed to your 
document.

 History Report, page 202, describes how to create a report showing when your document was sent for 
review and when changes were received.

Overview – Creating Reports
Workshare Professional enables you to quickly and easily generate XML, HTML and PDF reports based on your 
Microsoft Office documents. The following reports can be created:

 Risk Report

The Risk Report is a report of the content risk in your document that provides a full account of the 
different types of hidden data in a document as well as the potential content policy violations. The 
report is available in either HTML or XML (Microsoft Office 2003 only) format and it can be printed if 
required.

 Audit Report

The Audit Report is available in either HTML or XML (Microsoft Office 2003 only) format and includes 
the following information:

 When your document was Sent for Review as well as the names and email addresses of the 
recipients.

 When suggested changes were received and incorporated into your document.

 A list of all proposed changes, and their status (applied/rejected/flagged).

 Review Report

The Review Report produces a PDF document that includes Redline (comparison) documents showing 
changes that have been suggested to your document during the review process.

 History Report

The History Report is available in either HTML or XML (Microsoft Office 2003 only) format. It is 
effectively a subset of the Audit Report, displaying when your document was Sent for Review
(including the recipients) as well as when changes were received and incorporated into your document.
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The Report Wizard

The Report Wizard is accessible from the Workshare tab. It provides a quick and easy process to produce the 
different reports. The first page of the Wizard allows you to select what type of report you wish to generate.

Each report has different characteristics and they are described in the following sections.

Risk Report
You can create a Risk Report that provides a full account of the different types of content risk in a document. The 
report can be in XML or HTML format and can be printed if required.

To create a Risk Report:

1. From the Workshare tab, click Reports. The first page of the Report Wizard is displayed.
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2. Select Risk Report from the dropdown list and click Next. The Report Format page of the Wizard is 
displayed:

3. Select the format of the report – HTML or XML.

4. Click Next. The report is generated and a progress page is displayed. Once report generation is 
complete, a confirmation page is displayed as follows:
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5. Click Finish to display the report. An example HTML report is shown below:

Content risk is displayed according to the policy it violates. Under each policy, the content risk is divided into 
color-coded categories – high, medium and low.

You can print the Risk Report by selecting Print from the File menu.

Note: You can also display a Risk Report for a document attached to an email by clicking View Risk Report in 
the Email Security dialog.
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Audit Report
You can produce an Audit Report that includes information about the review cycle of the document. For example, 
how many times it has been sent for review, the number of changes proposed, and so on.

To produce an Audit Report:

1. From the Workshare tab, click Reports. The first page of the Report Wizard is displayed.

2. Select Audit Report from the dropdown list and click Next. The Report Format page of the Wizard is 
displayed:

3. Select the format of the report – HTML or XML – and click Next. The report is generated and a progress 
page is displayed. Once report generation is complete, a confirmation page is displayed.

4. Click Finish to display the report. An example HTML report is shown below:
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Review Report
You can create a Review Report to produce a PDF document that includes Redline (comparison) documents 
showing changes that have been suggested to your document during the review process.

To create a Review Report:

1. From the Workshare tab, click Reports or from the Actions dropdown menu in the Manage Changes 
page of the Workshare Panel, select Print Reports. The first page of the Report Wizard is displayed.

2. Select Review Report from the dropdown list and click Next. The following page of the Wizard is 
displayed:

3. Select which responses (and versions for DMS users) you wish to include in the report. The responses 
are Redline (comparison) documents that show the changes proposed by a reviewer.

4. If required, select the Only display pages with changes checkbox to exclude pages from the 
comparison that do not have any proposed changes.

5. Click Next. The report is generated and a progress page is displayed. Once report generation is 
complete, a confirmation page is displayed.
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6. Click Finish and your report is loaded into your default PDF viewing application (normally Adobe 
Reader). An example is shown below:

History Report
You can produce a History Report that is effectively a subset of the Audit Report, displaying when your 
document was Sent for Review (including the recipients) as well as when changes were received and 
incorporated into your document.

To produce a History Report:

1. From the Workshare tab, click Reports. The first page of the Report Wizard is displayed.

2. Select History Report from the dropdown list and click Next. The Report Format page of the Wizard is 
displayed:

3. Select the format of the report – HTML or XML – and click Next. The report is generated and a progress 
page is displayed. Once report generation is complete, a confirmation page is displayed.
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4. Click Finish to display the report. An example HTML report is shown below:
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Chapter 14. Configuring Workshare
This chapter describes the Workshare Configuration Manager. It includes the following sections:

 Introducing the Workshare Configuration Manager, below, introduces the Workshare configuration 
utility.

 Accessing the Workshare Configuration Manager, below, describes how to access the Workshare 
Configuration Manager.

 Setting Parameters, page 206, describes how to set values for parameters in the Workshare 
Configuration Manager.

Introducing the Workshare Configuration Manager 
The Workshare Configuration Manager is a configuration utility that enables you to configure Workshare and the 
way it behaves as well as modify the configuration of the Client Default profile (via the parameters in the 
Protection category). 

Note: A profile is a collection of policies. A policy is a set of parameters applied by Workshare Protect when 
determining content risk.

Administrator Mode and User Mode

The Workshare Configuration Manager has two modes as follows:

 Administrator Mode: This mode is for administrators to make changes to the default settings on the 
local machine. Settings made are saved in HKEY_LOCAL_MACHINE in the Registry. As a user you will 
only have access to Administrator mode if you have Administrator rights.

 User Mode: This mode is for users to make changes to the Workshare configuration to suit their own 
personal preferences on the local machine. Other users could log in and they would not have the same 
configuration settings. Settings made are personal to the user and saved in HKEY_CURRENT_USER in the 
Registry.

Note: Your system administrator may have restricted the rights of users to modify configuration parameters by 
locking individual parameters so that users cannot override the setting. If you have restricted access rights 
and have special requirements for configuration, please speak to your system administrator.

Accessing the Workshare Configuration Manager
The Workshare Configuration Manager can be accessed from within Microsoft Word or from the Start menu.

To access the Workshare Configuration Manager from Microsoft Word:

 In Microsoft Word, click Options in the Workshare tab, Options group. The Workshare Configuration 
Manager opens in User Mode.



CONFIGURING WORKSHARE

205

To access the Workshare Configuration Manager from the Start menu:

 From the Start menu, select All Programs > Workshare > Workshare Configuration. The 
Workshare Configuration Manager opens in User Mode.

Note: In User Mode, the state of the options reflects the settings in HKEY_CURRENT_USER in the Registry.

The configuration parameters for Workshare are grouped into categories and sub-categories. Click a sub-
category to display the parameters for that sub-category. The different sub-categories and their parameters are 
described in Workshare Configuration Options.

Searching Parameters

If you know the name of a parameter (or part of its name) but not its location, you can search the Workshare 
Configuration Manager using the search box on the top right.

Click the parameter in the results list and the relevant category and sub-category is displayed in the Workshare 
Configuration Manager.
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Setting Parameters
Most parameters in the Workshare Configuration Manager are set by selecting or deselecting a checkbox. There 
are also some that require you to enter a value in a text box.

To specify parameters:

1. In the Workshare Configuration Manager, select a category and then a sub-category.

2. Set a value for a parameter by selecting or deselecting the checkbox, selecting an option from a 
dropdown list or entering a value in a text box.

The icon to the right of a parameter indicates that the parameter value has been changed.

Note: When parameters have been locked by your administrator, the parameter will be disabled and a 
lock symbol will appear to the left of the parameter. You cannot change locked parameters.

3. Continue to select categories and sub-categories and specify parameters as required.

4. Click Apply to save your settings. A confirmation message is displayed once the settings have been 
saved.

5. Click OK and restart all Microsoft Office applications.

Note: The different sub-categories and their parameters are described in Workshare Configuration Options.
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Appendix A. Configuring Rendering Sets
This appendix describes how to configure rendering sets in Workshare Compare and apply them to a 
comparison. It includes the following sections:

 Introducing Rendering Sets, below, introduces Workshare rendering sets and describes how they 
determine the look of a Redline document.

 Accessing the Rendering Sets Manager, page 209, describes how to access the Workshare 
Rendering Sets Manager.

 Customizing Rendering Sets, page 212, describes how to create your own rendering sets as well as 
modify and delete existing rendering sets.

 Rendering Set Parameters, page 214, provides a detailed description of all the parameters included in 
rendering sets.

Introducing Rendering Sets
Workshare Compare uses colors and different formats in the Redline document to enable you to see the changes 
that have been made to the documents.

For example, the following indications can be used:

 Deletions in red with a strikethrough

 Insertions in bright blue with a double underline

 Moved or cut text in green with a strikethrough

 Pasted (copied) text in green with a double underline

 Moved deletions in salmon pink with a strikethrough

The colors and formats adopted depend on the rendering set applied to the comparison. Workshare Compare
includes several different rendering sets that you can apply as required or you can modify these rendering sets or 
create your own rendering set.

Note: It is general practice that your system administrator will have been involved in creating a set of 
standard rendering sets for your company to use and may have restricted the rights of users to create, delete 
or modify their own rendering sets. If you have restricted access rights and have special requirements for 
rendering sets, please speak to your system administrator.



CONFIGURING RENDERING SETS

208

Where are Rendering Sets Stored?

By default, rendering sets are stored in the following locations:

 Machine-wide rendering sets are stored in a shared documents folder at the following location: C: Users 
> Public > Public Documents > Workshare > Rendering.

 Personal rendering sets are stored in C: Users > (user name) > My Documents > Workshare > 
Rendering. This can be changed by an administrator in the Default rendering set location parameter in 
the Workshare Configuration Manager (Comparison > Administration category).

You can store rendering sets at other locations but you must specify the location (or locations) in the Additional 
locations for rendering sets parameter in the Workshare Configuration Manager (Comparison > 
Administration category). Workshare Compare looks in the two default locations (specified above) to create a 
list of the possible rendering sets available and will also look in any additional locations specified in this 
parameter.

Applying Rendering Sets

You apply a rendering set to a comparison before the comparison is run and in Workshare Compare you can also 
apply a rendering set at any time after a comparison has been performed.

To apply a rendering set after the comparison has been run:

 Refer to Applying a Different Rendering Set

 Refer to Changing the Comparison Options
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Accessing the Rendering Sets Manager
The Rendering Sets Manager is accessible from the Workshare Configuration Manager, from Workshare 
Compare and from Microsoft Word.

From the Workshare Configuration Manager

Access the Workshare Configuration Manager and select the Rendering Set Manager tab.

If you have permissions, you can modify and delete existing rendering sets and create new rendering sets. Refer 
to Customizing Rendering Sets.
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Before Running a Comparison

Before running a comparison, click in the Compare Documents dialog or click Edit rendering set in the 
Compare Documents page of the Workshare Panel.

If you have permissions, you can modify and delete existing rendering sets and create new rendering sets. Refer 
to Customizing Rendering Sets.

Additionally, you can edit the rendering set parameters as required and click OK. The Save Rendering Set dialog 
is displayed where you can either:

 Enter the name of an existing rendering set to overwrite a rendering set or enter a new name to create a 
new rendering set. Do not use the following characters when naming rendering sets: <, >, :, \, “, /, \\
or |. Click Yes. The updated rendering set is saved and it is selected in the Compare Documents dialog 
or the Compare Documents page of the Workshare Panel.

 Click No. The revised options are saved as a temporary rendering set called “Custom rendering set” and 
this rendering set is selected in the Compare Documents dialog or the Compare Documents page of the 
Workshare Panel.
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After Running a Comparison

In the Workshare Compare main window, click Edit in the Home ribbon (Rendering Sets group).

If you have permissions, you can modify and delete existing rendering sets and create new rendering sets. Refer 
to Customizing Rendering Sets.

Additionally, you can re-run a comparison changing specific comparison options. Refer to Changing the 
Comparison Options.
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Customizing Rendering Sets
If you have the relevant access rights, you can modify and delete existing rendering sets as well as create new 
rendering sets.

Note: Depending on how Workshare Compare has been distributed through the company, you may or may not 
have access rights to configure rendering sets. If you have any questions about your access rights, please 
speak to your system administrator.

Modifying Existing Rendering Sets

If you have permission, you can modify the settings of an existing rendering set.

To modify an existing rendering set:

1. In the Rendering Sets Manager, select the rendering set you want to modify from the Rendering Set
dropdown list.

2. Configure or modify the parameters for the rendering set as follows:

 Click a category in the left pane to display parameters for that category in the right pane.

 Configure the parameters as required.

Categories and their parameters are described in Rendering Set Parameters.

3. Click Save. The modified settings are saved to the selected rendering set.



CONFIGURING RENDERING SETS

213

Creating New Rendering Sets

If you have permission, you can create a new rendering set. You create a new rendering set based on an existing 
rendering set and then modify it as required.

To create a new rendering set:

1. In the Rendering Sets Manager, select the rendering set on which you want to base your new rendering 
set from the Rendering Set dropdown list.

2. Click Save As. The Save Rendering Set dialog is displayed:

3. Enter a name for the rendering set. Enter the name of an existing rendering set to overwrite a rendering 
set or enter a new name to create a new rendering set. Do not use the following characters when 
naming rendering sets: <, >, :, \, “, /, \\ or |.

4. Click OK. The new rendering set is selected in the Rendering Set dropdown list.

5. Configure or modify the parameters for the rendering set as follows:

 Click a category in the left pane to display parameters for that category in the right pane.

 Configure the parameters as required.

Categories and their parameters are described in Rendering Set Parameters.

6. Click Save. The settings are saved to your new rendering set.

Deleting Rendering Sets

If you have permission, you can delete rendering sets from the Rendering Sets Manager.

To delete a rendering set:

1. In the Rendering Sets Manager, select the rendering set that you want to delete from the Rendering 
Set dropdown list.

2. Click Delete. The selected rendering set is deleted.
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Rendering Set Parameters
The parameters for rendering sets are grouped into the following categories:

 Comparison Options.

 Redline Options

 Redline Rendering

The categories appear in the left pane of the Rendering Sets Manager. Selecting a category displays the 
parameters for that category in the central pane. The right hand pane show a preview of how the Redline 
document will look with the parameters selected.

Comparison Options

The Comparison Options category includes parameters that enable you to customize how the compare is 
performed.

The Comparison Options parameters are described in the following table:

Parameter Description

Allow Auto Retry When selected, if a comparison fails for any reason then Workshare 
Compare automatically attempts to perform a comparison using reduced 
settings. Workshare Compare methodically and automatically disables the 
Comparison Options selected until it is able to perform a comparison.
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Parameter Description

Detect List Numbering
Changes

If selected, changes to automatically generated list numbers for numbered 
paragraphs are detected.

Compare Headers/Footers If selected, the headers and footers in the original and modified documents 
are compared.

Compare Footnotes If selected, the footnotes in the original and modified documents are 
compared.

Compare at Character Level If selected, words that are only slightly different from each other are 
compared. For example, if banana has been changed to bananas -
Workshare Compare shows just an insertion of an s in the Redline 
document, rather than showing a deletion of banana and an insertion of 
bananas. This is intended to catch simple typing mistakes.

Compare Numbers at 
Character Level

As above description, but compares numbers instead of characters.

Ignore Embedded 
Objects/Images

If selected, embedded objects and images are ignored while doing the 
comparison and will not be displayed in the Redline document.

If not selected, the embedded objects and images will appear in the 
Redline (although changes to them are not detected unless the Detect 
changes to Images parameter is selected.)

This option is useful when documents have very large images embedded in 
them which would produce vast amounts of data if written to the Redline 
RTF file and would slow down the comparison process and the loading of 
the Redline document.

Ignore Case Changes If selected, any case changes, for example, upper case to lower case, 
made in the modified document are ignored.

Ignore Text Boxes If selected, any text boxes in the modified document are ignored.

Ignore Field Codes If selected, fields are treated as the same even if their field codes differ. So 
if you have a Date field in the original document and an Author field in the 
same place in the modified document, the Redline document will not show 
a change.

If not selected, field codes are compared and where they have changed, 
the entire original field is shown as deleted and the entire modified field is 
shown as inserted.
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Parameter Description

Compare field contents as 
text

If selected, converts certain field codes to text and then compares. If not 
selected, compares field code only. Fields converted to text will not be 
subject to the Ignore Field Codes parameter if that is also selected.

Note: The following field codes are converted to text: TOC, REF, TOA, 
TA, DATE, TIME, COMMENTS, KEYWORDS, AUTHOR, FILENAME, 
SAVEDATE, CREATEDATE, PAGEREF, INDEX, DOCPROPERTY, TITLE, 
MERGEFIELD, NOTEREF, SHAPE, QUOTE. Other field codes will be dealt 
with according to the Ignore Field Codes parameter setting.

For example, where there is a date field that in the original document 
shows 1 Jan 2012 and in the modified updates to 31 Jan 2012. When this 
parameter is selected, the Redline will show 131 Jan 2012. Where this 
parameter is not selected, no change will be shown.

Ignore Tables If selected, any tables in the modified document are ignored.

Display comments in redline If selected, comments in the original and modified documents are 
compared.

Detect Changes to Images If selected, images in the original and modified documents are compared.

In order for images to be compared, you must ensure that the Ignore 
Embedded Objects/Images parameter is NOT selected.

Ignore auto list against 
manual number list changes

If selected, when an automatically formatted list is being compared against 
a manual list, any changes in the manual list are ignored.

Generally this parameter should NOT be selected. It should only be selected 
in circumstances when one of the documents being compared contains 
automatic list numbering and the other document contains manual list 
numbering.
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Redline Options

The Redline Options category includes parameters that enable you to customize how the Redline document is 
displayed and what information is included with the Redline document.

The Redline Options parameters are described in the following table:

Parameter Description

General Options

Include redline statistics If selected, statistics about the changes between the original and modified 
documents is displayed in the Redline document. You can select to display 
these statistics at the start of the document or at the end of the 
document.

Include Redline Comparison 
Summary

If selected, a summary of all the changes is displayed at the end of the 
Redline document. The changes are hyperlinked to take you directly to the 
change in the Redline document.

Include Redline Option 
Summary

If selected, a summary of the options selected in the current rendering set 
is displayed at the end of the Redline document in the statistics report. 
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Parameter Description

Display Workshare Compare 
Footers

If selected, details about the two documents being compared are 
displayed in the footer of the Redline document.

Black And White Headers If selected, changes detected in the header are rendered in black and 
white. The color scheme set up in the rendering set is maintained for 
changes to all other parts of the document.

Black And White Footers If selected, changes detected in the footer are rendered in black and 
white. The color scheme set up in the rendering set is maintained for 
changes to all other parts of the document.

Show Moved Deletions If selected, text that was deleted from a section of the document and then 
subsequently moved to a new location is indicated.

Show Changes to Spaces If selected, any extra spaces that have been added to or deleted from the 
modified document are indicated. 

Show Paragraph Changes If selected, paragraph markers ( ) of any extra paragraphs that have 
been added to or deleted from the modified document are displayed.

Include file names in Redline 
statistics

If selected, the names of the compared documents are included in the 
Redline statistics.

Change Indicator Options

Show Hidden Text If selected, hidden text is displayed in the Redline document.

Show Line Numbering If selected, the line number is displayed to the left of each line in the 
margin of the Redline document.

Show Change Numbering 
ToolTips

If selected, tool tips are displayed when you position the cursor over 
change numbers.

Show change bars If selected, vertical lines to indicate a change are displayed next to each 
change in the margin of the Redline document. You can select to display 
the lines either in the Left or Right margin.

Show change numbers If selected, the change number is displayed next to each change in the 
margin of the Redline document. You can select to display the number 
either in the Left or Right margin.

Readability See the Readability section below.

Note: The change indicator settings do not show if you open the Redline document in Microsoft Word.
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Readability

The Readability option enables you to set at what point insertions and deletions should no longer be marked 
individually but marked as an entire paragraph deleted followed by an entire paragraph inserted. The deleted 
paragraph is as the paragraph appears in the original document and the inserted paragraph is as the paragraph 
appears in the modified document.

For example, the following paragraph showing numerous deletions and insertions is quite difficult to read:

DeltaView Redline with Table of Contents: (Vendor)When performing a redline where the document contains ancontents issue: An error 

occurs in the number of bullet points when DeltaView does a redline on a document where the table of contents is automatically 
generated Table of Contents, the DeltaView output does not number the sections properly. This happens in DeltaView or if the file format 

is *.wdf. Workaround: Save the redlineWord. Workaround: Save the table of contents in as a new document or email the redline as a

Word document, it formats correctly. We are working with the vendor for a resolutionDOC file and open it in Word before printing.

It would be much easier to read this paragraph if it was presented as the entire paragraph deleted followed by a 
new paragraph inserted, as follows:

DeltaView Redline with Table of Contents: (Vendor)When performing a redline where the document contains an automatically generated 
Table of Contents, the DeltaView output does not number the sections properly. This happens in DeltaView or if the file format is *.wdf. 
Workaround: Save the redline as a new document or email the redline as a Word document, it formats correctly. We are working with the 
vendor for a resolution.

DeltaView Table of contents issue: An error occurs in the number of bullet points when DeltaView does a redline on a document where the 
table of contents is automatically generated in Word. Workaround: Save the table of contents in as a DOC file and open it in Word before 
printing.

Obviously, if there were only a few deletions and insertions in a paragraph, then the first example is easy to read.

With the Readability parameter, you can specify at what point Workshare Compare no longer marks deletions 
and insertions individually but marks the entire paragraph as a deletion followed by the new paragraph as an 
insertion. You specify this by setting a readability percentage by dragging the Paragraph Matched Text 
Threshold slider to your required setting. The percentage selected is shown in a tool tip above the slider.

The meaning of the setting is as follows:

 With readability set at 10%, Workshare Compare will mark insertions and deletions individually unless 
90% of the paragraph has changed. In other words, in most circumstances paragraphs will be displayed 
in the same way as the first example shown previously. Only when more than 90% of the paragraph has 
changed will Workshare Compare display the paragraph as the second example.

 With readability set at 50%, Workshare Compare will mark insertions and deletions individually unless 
50% of the paragraph has changed. In other words, paragraphs will be displayed in the same way as 
the first example shown previously unless more than 50% of the paragraph has changed.

 With readability set at 90%, Workshare Compare will mark insertions and deletions individually unless 
10% of the paragraph has changed. In other words, in most circumstances paragraphs will be displayed 
in the same way as the second example shown previously. Only when less than 10% of the paragraph 
has changed will Workshare Compare display the paragraph as the first example.
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The default setting for readability is 10%.

Workshare Compare looks at each paragraph separately and assesses its readability according to the number of 
changes in the paragraph.

Note: When working with tables, Workshare Compare does not treat the entire table as a paragraph. Each 
paragraph within each cell is treated separately.

Readability only applies to paragraphs that contain both inserted and deleted text because such paragraphs may 
be unclear whereas paragraphs with only insertions or deletions do not have such readability problems.

Redline Rendering

The Redline Rendering category includes parameters that enable you to customize how specific types of 
changes are displayed in the Redline document.
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The Redline Options parameters are presented in the following sections:

Inserted Text Format

The Inserted Text Format section includes parameters that enable you to customize how you would like 
inserted text to appear in the Redline document.

The Inserted Text Format parameters are described in the following table:

Parameter Description

Inserted Text Color The color of inserted text.

Inserted Text Background The color of the background of inserted text.

Inserted Text Format The format of inserted text. Select from Underline, Double Underline, Italic or 
Strikethrough.

Surrounding Characters A keyboard character to go before and after inserted text.

Deleted Text Format

The Deleted Text Format section includes parameters that enable you to customize how you would like deleted 
text to appear in the Redline document.
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The Deleted Text Format parameters are described in the following table:

Parameter Description

Deleted Text Color The color of deleted text.

Deleted Text 
Background

The color of the background of deleted text.

Deleted Text Format The format of deleted text. Select from Underline, Double Underline, Italic or 
Strikethrough.

Surrounding Characters A keyboard character to go before and after deleted text.

Deleted Text 
Replacement Character

The character used to replace deleted text. If the Replace Deletes with Single 
Character checkbox is selected, the deleted text is replaced with a single 
instance of the character specified. If the Replace Deletes with Single 
Character checkbox is not selected, each character in the deleted text is 
replaced with the character specified. For example, if the word compare is 
deleted and the character specified is X, the word appears as XXXXXXX. 

Replace Deleted Text
with a Single Character

If selected, deleted text is replaced with a single character. If you select this 
checkbox, enter the required character in the Replacement Character field. For 
example, if the word compare is deleted and the character specified is X, the 
word appears as X.

Include summary of 
deletions

If selected, a summary of deletions is included with the Redline document.

Moved Text 

The Moved Text section includes parameters that enable you to customize how you would like moved text to 
appear in the Redline document.
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The Moved Text parameters are described in the following table:

Parameter Description

Show Movements If selected, moved text is shown in the Redline document. If you leave this 
checkbox unchecked, then any text that has been moved is displayed the 
same as inserted and deleted text.

Moved Text Color The color of moved text.

Moved Text Background The color of the background of moved text.

Moved Source Text Format The format of the source moved text. Select the format of the text in its 
original position from Underline, Double Underline, Italic or Strikethrough.

Moved Destination Text 
Format

The format of the destination moved text. Select the format of the text in its 
new position from Underline, Double Underline, Italic or Strikethrough.

Move Source Surrounding 
Characters

A keyboard character to go before and after source moved text. Specify the 
characters to surround the text in its original position.

Move Destination 
Surrounding Characters

A keyboard character to go before and after destination moved text. Specify 
the characters to surround the text in its new position.

Change Numbering 

The Change Numbering section includes parameters that enable you to select whether change numbers are 
shown in the Redline document and, if so, how they appear.

The Change Numbering parameters are described in the following table:

Parameter Description

Show Change 
Numbering

If selected, the number of the change is displayed next to each change in the body of 
the Redline document (as superscript). 

Show Change
Numbering before 
Change

If selected, the change number is displayed before the change. If not selected, the 
change number is displayed after the change. It is recommended to position the 
change number before the change as footnotes often appear after text. This reduces 
confusion.

Change Number Text 
Color

The color of change numbers.

Change Number Text 
Format

The format of change numbers. Select from a range of formats, including 
Superscript or Bold.
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Font Changes

The Font Changes section includes parameters that enable you to customize how you would like any font 
changes to appear in the Redline document.

The Font Changes parameters are described in the following table:

Parameter Description

Show Font Changes If selected, font changes are shown in the Redline document.

Font Change Text Color The color of font changes.

Font Change Text 
Background

The color of the background of font changes.

Surrounding Characters A keyboard character to go before and after font changes.

Note: Insertions and deletions override any font changes. For example, if the modified document has new 
inserted text in a different font, it appears as inserted text and not as font change text.

Style Changed Text

The Style Changed Text section includes parameters that enable you to customize how you would like any style 
changes to appear in the Redline document.
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The Style Changed Text parameters are described in the following table:

Parameter Description

Show Paragraph Style 
Changes

If selected, paragraph style changes are shown in the Redline document. 
Paragraph style changes are indicated in words, for example, normal to 
heading two.

Style Changed Label Color The color of text in paragraphs where the paragraph style has changed.

Show Character Style 
Changes

If selected, character style changes are shown in the Redline document.

Style Changed Color The color of character style changes.

Style Changed
Background

The color of the background of character style changes.

Style Changed Format The format of character style changes. Select from Underline, Double 
Underline, Italic or Strikethrough.

Surrounding Characters A keyboard character to go before and after style changed text.

Note: Changes to heading styles are also shown in the statistics report at the end of the Redline document.

Table Changes

The Table Changes section includes parameters that enable you to customize how you would like any format 
changes in tables to appear in the Redline document.
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The Table Changes parameters are described in the following table:

Parameter Description

Table Change Options The way changes in tables are indicated. You can select from the following: 
Changes with surrounding characters, Changes without surrounding 
characters, Whole original and modified tables, Whole modified table 
only or Whole modified table only (unmarked).

Selecting Whole modified table only (unmarked), the modified table is 
shown in the Redline document as a new table with no changes marked. 
Selecting Whole modified table only, the modified table is also shown in 
the Redline document as a new table but it is shown as an insertion.

Table Cell Inserted Color The color of inserted cells.

Table Cell Deleted Color The color of deleted cells.

Table Cell Moved Color The color of moved cells.

Table Cell Merged Color The color of merged cells.

Table Cell Padding Color The color of padded cells.

What are Padded Cells?

Padded cells occur when an insert and delete have occurred within a table, a cell becomes both an insert and a 
delete; therefore it creates a padded cell.

Original Table

Cell 1 Cell 2 Cell 3

Cell 4 Cell 5 Cell 6

Modified Table
Cell 1 Cell 3

Cell A Cell B

Cell 4 Cell 6

Rendered Table
Cell 1 Cell 2 Cell 3

Cell A PADDED CELL Cell B

Cell 4 Cell 5 Cell 6
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Appendix B.Clean and Lightspeed Clean
Lightspeed cleaning is a secure white-out technology that overwrites hidden data to prevent leaks. Lightspeed 
cleaning is much faster than regular cleaning because it does not rely on Microsoft Office for cleaning the 
document and uses exclusive binary reading and writing technology. Lightspeed cleaning maintains the original 
structure of the document but may either remove hidden data or redact it (replace it with spaces). Thus regular 
cleaning actually removes the hidden data element from the document whereas Lightspeed cleaning may have 
different effects. There are some subtle differences in how each technology cleans the document but both 
ensure the document is safe.

The following tables detail the features of Microsoft Word, Excel and PowerPoint documents that are cleaned by 
Workshare Protect when a Clean or a Lightspeed Clean is performed on the document. The tables also briefly 
explain the effect of the clean or Lightspeed clean. The effect of these actions varies according to the format of 
the document:

DOC/XLS/PPT Word 97-2003 Document/Excel 97-2003 Workbook/PowerPoint 97-2003 Presentation

DOCX/XLSX/PPTX Office Open XML Format (no macros)

DOCM/XLSM/PPTM Office Open XML Format (macros allowed)

Microsoft Word Documents

Feature Clean Lightspeed Clean

DOC Format DOCX/DOCM Format DOC Format DOCX/DOCM Format

Track Changes √

Deleted

√

Deleted

√

Deleted, but where track 
change deletes text, the 
text is turned into hidden 
spaces (revealed if turn 
on “show hidden text”)

√

Deleted

Comments √

Deleted

√

Deleted

√

Deleted

√

Deleted

Small Text √

Deleted

√

Deleted

√

Deleted, but turned into 
hidden spaces (revealed 
if turn on “show hidden 

text”)

√

Deleted

Color on Color 
Text (includes 
White Text)

√

Deleted

√

Deleted

√

Deleted, but turned into 
hidden spaces (revealed 
if turn on “show hidden 

text”)

√

Deleted
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Feature Clean Lightspeed Clean

DOC Format DOCX/DOCM Format DOC Format DOCX/DOCM Format

Hidden Text √

Deleted

√

Deleted

√

Deleted, but turned into 
hidden spaces (revealed 
if turn on “show hidden 

text”)

√

Deleted

Versions √

Deleted

NA √

Deleted

NA

Authors √

Deleted

√

Deleted

√

Deleted

√

Deleted

AutoVersion √

Cleared

NA √

Cleared

NA

Custom 
Properties (in 
Custom tab)

√

Deleted

√

Deleted

√

Deleted

√

Deleted

Document 
Variables

√

Deleted

X √

Name and value turned 
into spaces but the 

document variable still 
exists

√

Deleted

Macros √

Deleted

√

Deleted

√

Deleted

√

Deleted

Routing Slip √

Deleted

NA √

Deleted

NA

Reviewers √

Deleted

√

Deleted

√

Deleted

√

Deleted

Footnotes √

Deleted

√

Deleted

√

Turned into hidden 
spaces (revealed if turn 
on “show hidden text”)

√

Deleted

Fields √

Field code is deleted 
and the result turned 

to text

√

Field code is deleted 
and the result turned 

to text

√

Field code turned to 
blank spaces and the 

result left. When update 
performed, result 
becomes empty

√

Field code is deleted and 
the result turned to text
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Feature Clean Lightspeed Clean

DOC Format DOCX/DOCM Format DOC Format DOCX/DOCM Format

Hyperlinks √

Hyperlink removed and 
the result turned to 

text

√

Hyperlink removed and 
the result turned to 

text

√

Hyperlink turned to blank 
spaces and the result 

left. When update 
performed, result is 

error…

√

Hyperlink removed and 
the result turned to text

Document 
Statistics (in 
Statistics tab)

√

Deleted

X √

Deleted “Last Saved By”
and other fields reset.

√

Deleted “Last Saved By”
and other fields reset.

Built-In 
Properties –
Standard 
Properties (in 
Summary and 
Contents tabs)

√

Deleted

√

Deleted

√

Deleted “Title”

√

Deleted

Smart Tags √

Deleted

√

Deleted

√

Deleted

√

Deleted

Template √

Removes reference to 
template and shows 

only “Normal”

√

Removes reference to 
template and shows 

only “Normal”

√

Removes reference to 
template 

√

Removes reference to 
template and shows only 

“Normal”

Headers X √

Checks headers in 
same way as body 

text

X √

Checks headers in same 
way as body text

Footers X √

Checks footers in 
same way as body 

text

X √

Checks footers in same 
way as body text

Endnotes √

Deleted

√

Deleted

√

Deleted text of endnote 
but leaves separator

√

Deleted

Text Within Text 
Box

X X √

Deleted text from textbox

√

Deleted text from textbox
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Feature Clean Lightspeed Clean

DOC Format DOCX/DOCM Format DOC Format DOCX/DOCM Format

SmartArt X X √

Deleted

√

Deleted text from 
SmartArt

Microsoft Excel Workbooks

Feature Clean Lightspeed Clean

XLS Format XLSX/XLSM Format XLS Format XLSX/XLSM Format

Track Changes √ √ √ √

Comments √ √ √

Comment turned to blank 
spaces but placeholder 

remains

√

Small Text X √ X √

Color on Color 
Text (includes 
White Text)

X √ X √

Authors √ √ √ √

Custom 
Properties (in 
Custom tab)

√ √ √ √

Macros X X √ √

Routing Slip √ NA √ NA

Hyperlinks X X √ √

Document 
Statistics (in 
Statistics tab)

√ X √ √

Built-In 
Properties –
Standard 
Properties (in 
Summary and 
Contents tabs)

√ √ √ √
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Feature Clean Lightspeed Clean

XLS Format XLSX/XLSM Format XLS Format XLSX/XLSM Format

Smart Tags X X X X

Headers √ √ √ √

Footers √ √ √ √

Text Within Text 
Box

X X X X

SmartArt NA X NA X

Microsoft PowerPoint Presentations

Feature Clean Lightspeed Clean

PPT Format PPTX/PPTM Format PPT Format PPTX/PPTM Format

Comments √ √ √

Comment turned to blank 
spaces but placeholder 

remains

√

Small Text X X X X

Color on Color 
Text (includes 
White Text)

X X X X

Authors √ √ √ √

Custom 
Properties (in 
Custom tab)

√ √ √ √

Macros X X √ √

Hyperlinks X X √ √

Document 
Statistics (in 
Statistics tab)

X √ √ X

Built-In 
Properties –
Standard 
Properties (in 
Summary and 
Contents tabs)

√ √ √ √
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Feature Clean Lightspeed Clean

PPT Format PPTX/PPTM Format PPT Format PPTX/PPTM Format

Smart Tags X X X X

Template X X X X

Headers X X X √

Footers X X X √

Text Within Text 
Box

X X X X

SmartArt NA X NA X

Speaker Notes √ √ √ √

Hidden Slides √ √ √ √

PDF Files

Workshare Protect does not distinguish between clean and Lightspeed clean when cleaning PDF files and whichever type of 
cleaning is selected, Workshare Protect will clean PDF files in the same way.

Feature PDF PDF/A

Attachments √ √

Bookmarks √ √

Markup √ √

Properties √ √

Cleaning Properties from PDF/A invalidates the PDF/A status


